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And there’s more...
■ The headline speakers at this year’s Photography Show are 
just the tip of the inspiration iceberg! There are hundreds more 
talks, seminars and workshops scheduled throughout the four-
day show, and that’s to say nothing of the thousands of great 
deals that are sure to be available from the hundreds of retailers 
and manufacturers represented. You can find out more in our free, 32-page preview and show guide, or at  
www.thephotographyshow.com. The four-day show takes place at the NEC in Birmingham from 21-24 March 2015. 

Welcome to issue 44 of…

Paul Grogan, Editor
paul.grogan@futurenet.com

■ A year on from its triumphant debut, the second 
edition of The Photography Show is finally here, 
and 2015’s installment promises to be bigger and 
better than ever. Where else can you meet – and  
be inspired by – so many of the world’s leading 
photographers in the space of a single weekend? 
From Martin Parr to Mary Ellen Mark, the line-up 
of speakers on this year’s Super Stage reads like a 
Who’s Who of 20th-century photography. 

And if you can’t make it to the show, or just can’t 
wait, then allow us to bring some of the stars of the 
show to you: Geoff Harris’s poignant interview with 
legendary photojournalist Don McCullin, whose 
Nikon F famously stopped a bullet in Cambodia, is  
a truly compelling read, while Lynsey Addario’s 
harrowing but ultimately moving account of 
the story behind her best shot will leave you 
humbled and inspired in equal measure.

On a lighter – but no less inspiring – note, 
this issue’s Lightbox boasts the world’s very 
best flower and garden images, while our 
fantastic feature on focusing shows you 
how to nail pin-sharp shots every time.

Plus we have our usual mix of creative 
projects in this issue’s Skills Zone, from 
adding some sparkle to family portraits 
to creating a comic book hero. Enjoy!

5 WAys to Get   
even more  

out of n-PHoto

Follow our tweets & 
keep up to date with 
all things #Nikon 

www.twitter.com/nphotomag

Join 170,000 Nikon 
nuts who ‘Like’ us 
on Facebook  

www.facebook.com/nphotomag

Catch up with Nikon 
news, get inspired & 
learn new skills

www.digitalcameraworld.com

2 Facebook…

1 Online…

3 Twitter…

4 Google+
Hang out with us by 
putting N-Photo in 
your Circle 

plus.google.com/+Nphotomagazine

Showcase your shots 
and see work by 
other Nikon users 

www.flickr.com/nphotomag

5 Flickr...

ABout tHe cover
title in Her eyes
Photographer Dimitry roulland
Home france
camera nikon D600
lens nikon 50mm f/1.4
exposure 1/640 sec, f/2, iso160
Description i met nicole for a dance 
photoshoot on a cold and cloudy day in 
Bordeaux. in the middle of the session we 
improvised this portrait next to a bush with 
red flowers. most of the time, i shoot without 
any preparation; i prefer to work more by feel, 
reacting to the subject, lighting and location 
in a very intuitive and instinctive way.  
Website www.dr-photographies.com

http://www.digitalcameraworld.com
http://www.facebook.com/nphotomag
http://www.plus.google.com/+Nphotomagazine
http://www.twitter.com/nphotomag
http://www.flickr.com/nphotomag
http://www.dr-photographies.com
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44 CovEr fEaturE  Break the rules 
Six compositions that break  

the normal ‘rules’ for landscape shots

47 Double up 
Create entertaining portraits  

with nothing more than an old mirror

48 Protect yourself 
Make sure the world knows you own 

your photos: attach your contact details

50 CovEr fEaturE  Stack ’em up 
Why stop at a single filter, when you 

can combine them for brilliant effects?

52 CovEr fEaturE  Have a heart 
Give family photos extra charm  

with specially-shaped catchlights

54 Create a comic book hero 
Use Photoshop’s Smart Filters and 

layers to give photos a comic-book look

56 CovEr fEaturE  Stack for impact 
Shoot a series of images and combine 

them to create a stunning time-stack image

08 CovEr fEaturE  the apprentice
Water, water everywhere… and some 

expert advice in how to photograph it

18  Lightbox 
Inspirational images from the Garden 

Photographer of the Year competition 

38 Subscriptions offers 
Subscribe to N-Photo in print or 

digital form, or pick up a brilliant bundle

64 over to You 
Three photo stories packed with 

brilliant shots, plus all your rants and raves 

86 CovEr fEaturE  the N-Photo Interview 
Legendary photojournalist Don 

McCullin talks about life on the front line 

121 Next issue 
The good stuff doesn’t end with this 

issue – here’s something to look forward to 

122 My Best Shot 
Lynsey Addario recalls capturing  

a harrowing moment in Afghanistan

26 CovEr fEaturE

Focus on focus

76 CovEr fEaturE  Nikon Know-how 
Get more from your RAW files with 

Michael Freeman’s guide to the best way  
to recover missing details in shots

80 Nikon Software 
Discover how Nikon Capture NX-D 

can help you alter your white balance setting 
to remove unwanted colour casts

82 ask rod 
Got a Nikon-related problem? 

Whether it’s a hardware issue or a  
buying dilemma, Rod is here to help.

74

Discover the lenses, settings and professional tricks you  
need to nail pin-sharp shots, whatever your subject

52

18
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THE VIDEOS AND INFORMATION PROVIDED ON THIS DISC ARE 100% INDEPENDENT AND NOT 
ENDORSED OR SPONSORED BY NIKON CORPORATION OR ADOBE SYSTEMS INCORPORATED

expert HANDs-ON vIDeO guIDes

04 Use multiple filters 
to take landscapes 

with the wow factor
03 Add copyright 

information to your 
shots in Lightroom

05 Add charm to family 
portraits with a 

shaped catchlight
06 Give an ordinary 

portrait some 
comic-book kapow!

08 Say goodbye to soft 
shots with Capture 

NX-D’s Unsharp Mask tool
07 Shoot and combine a 

series of images into 
a stunning ‘time stack’

02 Use a mirror to take 
entertainingly 

unusual portraits
01 Try taking landscape 

shots that dare to 
break the rules

 Whenever you see this button, simply 
use this web link… bit.ly/NPhoto44 
to view our online video tutorials
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CovEr fEaturE  
This issue’s Apprentice gets a masterclass in 
photographing waterfalls from Nigel Forster08

98

94 CovEr fEaturE  Nikon D5500 
We go hands-on with Nikon’s latest 

D-SLR and give it a serious testing!

98 CovEr fEaturE  Big test 
Say goodbye to blur with one of these 

ten sturdy tripods to suit all budgets

108 New Gear 
Discover the stellar Nikon D810a, 

and feel the force of the Gloxy Power Blade

111 Pro Picks 
Professional sports photographer  

Tom Miles shows off the tools of his trade

112 CovEr fEaturE  Mini test 
Six cloud-based storage options, with 

prices from FREE, compared and rated

94

98
112

http://www.bit.ly/NPhoto44
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There’s only one thing on everyone’s minds: 
what to see at The Photography Show!

Nigel 
Forster
■ Nigel 
specialises 
in Welsh 

landscapes, and gives  
this issue’s Apprentice  
a masterclass. Page 8

Amy 
Davies
■ A lot of fuss 
has been made 
about the 

D5500’s touchscreen. Amy 
reveals whether it lives up 
to expectations. Page 94

Our contributors Ben Andrews, Enid Astley, Andrew Bailey, Carolyne Barber, Adam Burton, Stefano Coltelli, Chris Gomersall, 
Mark Gray, Mark Hamblin, Sarah-fiona Helme, Ross Hoddinott, Kate Hopewell-Smith, Gillian Hunt, Simon Lees, Kevin MacAulay, 
Mike McNally, Daniel Moll, Vinh Q T Nguyen, Jacky Parker, Matthew Richards, Claude Robidoux, Joby Sessions, Christiane 
Vandroux, Magdalena Wasiczek
Special thanks to… Bath & North-East Somerset Council, International Garden Photographer of the Year

Don 
McCullin
■ He’s a 
legend among 
photo-

journalists – and tells us 
which images he’d like to be 
remembered for. Page 86

Mark 
Pain
■ As part of 
our feature on 
focusing, top 

sports pro Mark shares his 
tips for getting perfectly 
sharp action shots. Page 36

Michael 
Freeman
■ Michael 
explores the 
complex world 

of processing RAW files, and 
reveals how to get the most 
from them. Page 76

George
Cairns
■ Banish 
colour casts 
from your 

images using Nikon Capture 
NX-D – and some help from 
George! Page 80

Lynsey 
Addario
■ Lynsey 
tells the story 
behind her 

harrowing, unforgettable, 
image of US Marines in 
Afghanistan. Page 122

Chief executive Zillah Byng-Maddick 
Non-executive chairman Peter Allen
Chief financial officer Richard Haley 

Tel +44 (0)207 042 4000 (London)
Tel +44 (0)1225 442 244 (Bath)

This issue’s special contributors…

James 
Paterson
■ Breaking 
the rules, but 
completely in 

control, James shows you 
new ways to photograph 
landscapes. Page 44

Miriam McDonald 
Operations Editor | D3100  
miriam.mcdonald@futurenet.com

‘Streetscape’ looks fascinating – I 
can’t wait to get some tips 
from the pros for taking 

terrific street shots, because 
I’m rarely brave enough to do it!

Paul Grogan 
Editor | D800
paul.grogan@futurenet.com

Andrew Leung
Art Editor | D5100
andrew.leung@futurenet.com

It’s got to be Nikon’s stand. With 
its full camera and lens line-up, 
from the biggest D-SLR to the 
dinkiest Coolpix, it’s going to 

be well worth a visit. 

The International Garden 
Photographer of the Year 
garden is the stand for me. 
Take garden macros at the 
NEC? Brilliant idea.

Ali Jennings 
Lab Manager | D800 
ali.jennings@futurenet.com

I’m looking forward to finishing 
my speech… Seriously, though, 
it’s a real privilege to talk at the 
same event as the likes of John 
Wright and Lou Coetzer.

Angela Nicholson
Head of Testing | D7100
angela.nicholson@futurenet.com

I’ll be heading over to the 
Filmmaker Theatre to find  
out some new ways to use my 
camera when I don’t feel like 
shooting stills.

Like Paul I’ll be visiting the Nikon 
stand, but I’m hoping to catch 

one of the free seminars – it’ll 
be nice to watch someone else 
give the lessons for once!

Matt Tuffin 
Staff Writer | D700 
matt.tuffin@futurenet.com
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Chasing 
Waterfalls
For this issue’s Apprentice, reader Enid met up with 
celebrated landscape photographer and tutor Nigel 
Forster, to learn how to capture wispy waterfalls in the 
wilds of South Wales. Here’s how they got on… 
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Waterfalls masterclass

Name enid astley
Camera D7100

■ Originally from Chester and now based in 
Wales, Enid has been a keen photographer 
for as long as she can remember. She used  
to  love looking at the photos in National 
Geographic when she was growing up, and 
took her first pictures on her mum’s 1924 Box 
Brownie. But it was only two years ago that 
she bit the bullet and bought her first D-SLR, 
a Nikon D7100. “I wanted to do more with my 
photography,” she says, “and challenge 
myself to take better shots.” She loves 
experimenting, but what she really wants 
to  master is capturing slow shutter speed 
shots of waterfalls in her adopted home. 

Name Nigel Forster
Cameras D800, D700

■ Nigel got into photography in the early 
1980s, and his first camera was a Nikon F3, 
which he still has. After persuing a career in 
the environmental sector he returned to 
photography in 2009, and went on to set  
up Creative Photography Wales (www.
creativephotographywales.com). Nigel 
teaches landscape photography workshops 
throughout South Wales and beyond, and his 
commercial clients have included Brecon 
Beacons National Park, Visit Wales and even 
10 Downing Street, which commissioned him 
to shoot a series of panoramic backdrops of     
the Brecon Beacons for a NATO Summit.

http://www.creativephotographywales.com
http://www.creativephotographywales.com
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 manual advantage
Another advantage of using manual 
mode, says Nigel, is that once you’ve 
set your exposure you can recompose a 
shot without the changed composition 
affecting your settings. In shutter-
priority mode your camera will adjust 
the aperture based on what’s in the 
frame – so a bright waterfall or sky  
will give a different reading from dark 
rocks, which might result in under-
exposure (see below). In manual  
mode the settings will stay the same  
no matter what you’re pointing at, 
ensuring a correct exposure.

expert insight 
Chart your 
progress

Nigel says… The best way to 
check your exposures is to use the 
histogram view on the rear screen. 
Waterfalls almost always feature 
bright white highlights, so ideally 
you want the histogram to be as 
far to the right as possible, but 
without being cut off, or ‘clipped’, 
as this would result in blown 
highlights with no detail. If the 
histogram is cut off, decrease the 
exposure time to let in less light.

pro’s Killer Kit #01 polariser

Nigel says… Most people are aware that neutral 
density filters enable you to set slower shutter speeds 
than would otherwise be the case, and so blur water  
and clouds, but when it comes to waterfalls a polariser 
is arguably more important, especially if you’re shooting 
from down low, as was the case with Enid’s first Hot 
Shot [opposite]: without a polariser, the bright whites 
of the waterfall were reflected in the water’s surface; 
with a polariser, these distracting reflections were 
eliminated, revealing texture and detail in the riverbed. 

 learn to spot a midtone
To demonstrate the advantages of shooting in manual mode, Nigel asked Enid to take two shots of these 
moss-covered rocks, one in full auto mode using matrix metering, and one in manual mode using spot 
metering. In auto mode the result was overexposed, because Enid’s camera tried to render the scene as  
an ‘average’ midtone. By spot-metering off the perfect midtone of the green moss in manual mode, Enid 
was able to adjust her shutter speed until her exposure level indicator lined up with the ‘0’ on her camera’s 
exposure scale. This rendered the moss as a midtone, the shadows as deep shadows and the highlights as 
bright highlights – a perfect exposure!

matrix metering

spot metering
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Waterfalls masterclass

Was enid ready to take the plunge?
Enid loves experimenting with her settings, but  
a more methodical approach will pay dividends…

teChNiQue assessmeNt

manual labour
Nigel says… Enid 
tends to start out 
with her camera in 
full auto mode, and 
only ventures into 
other shooting 
modes to experiment, without necessarily 
understanding how these work. With waterfalls,  
I almost always shoot in manual mode, as it gives 
me full control over both the aperture and 
shutter speed, and enables me to set my 
exposure and then forget about it (see below). 

spot the 
difference
Nigel says… Enid 
doesn’t really think 
about metering,  
but as waterfalls  
contain both bright 
highlights and deep shadows, it pays to be 
precise. I try to spot-meter from a midtone, as my 
camera will then suggest settings that will 
render this area as an average midtone, and so 
expose the highlights and shadows correctly. 

raW ingredients
Nigel says… Enid 
never shoots RAW, 
but because of the 
wide range of tones 
in a waterfall shot 
it’s vital to capture 
as much tonal 
information as possible. At the very least she 
should shoot RAW + JPEG, so that she can revisit 
the RAW files when she learns how to process 
them (see Nikopedia 1 on page 76 for more).

the pro’s Kit bag
Nikon D800 ■ Nikon D700  
■ Nikon 16-35mm f/4 ■ Nikon 
24-70mm f/2.8 ■ Nikon 70-200mm 
f/4 ■ Nikon 105mm f/2.8 ■ Two 
Manfrotto tripods, one aluminium, 

one carbon fibre, both with grip-action ball head  
■ Full set of Lee ND grads (hard and soft), various 
Lee ND filters, plus square and circular polarisers

For this shot of Sgwyd Gwladys we had to wade into the middle of the river, so 
I was glad I’d bought my wellies! Nigel suggested getting down low with  

a wide-angle zoom to fill the foreground with the pebbles on the riverbed and the 
lines in the moving water. As there was no obvious midtone Nigel suggested 
metering off the whitest part of the waterfall, and then doubling the exposure time 

to ensure the whites of the fall were rendered white and not mid-grey. At f/11 and ISO100 this 
gave me a shutter speed of 1/4 sec, which was still a touch too fast. In the end, half a second 
provided a perfect exposure, and was slow enough to capture the water as soft, wispy trails.   

oUr apprentiCe says…

eXposure 0.3 sec, f/10, ISO100  
leNs Sigma 10-20mm f/4-5.6 EX DC HSM    

Hot 
SHot
#01
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 take your time
“Waterfalls are perfect for 
teaching students how they 
can use shutter speed to blur 
or freeze moving subjects,” 
explains Nigel. “I got Enid  
to set a different speed for 
each shot in this sequence, 
starting at 1/1000 sec and 
incrementally extending  
the duration of the exposure. 
As you can see, a speed of  
1/8 sec or slower is needed  
to capture the water as a  
smooth, continuous blur.”

pro’s Killer Kit #02 miCroFibre leNs Cloth

Nigel says… You’d think that lots  
of rain would be great for waterfall 
photography, but the opposite is often 
the case. The more water there is 
cascading over a fall, the more the 
distinct trails of water tend to merge into 
a featureless curtain of white – and the 
more spray you get billowing out from 
the bottom. In these conditions, a dry 
microfibre cloth is essential for wiping 
water droplets off filters and lenses. If it’s 
really wet you may need to do this just 
before you press the shutter release. 

The idea with this shot [right]  
of Melincourt Falls was to 

capture the power and energy  
of the fall, so Nigel suggested 
cropping in tight on the huge 

boulders at the bottom, and setting a faster 
shutter speed to freeze the motion of the water 
and capture every last droplet. The shot also 
works at a slower shutter speed (see Take your 
Time, below), but I prefer the faster shutter 
speed version: with its stark, almost 
monochromatic tones and simple, graphic 
composition, it really captures what it was like 
to stand at the bottom of the waterfall, amid all 
the noise and the spray.   

oUr apprentiCe says…

1/1000 seC 1/30 seC 1/8 seC 1 seC
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pro portfolio
Water WorlDs
Here, Nigel presents three stunning  waterfall 
images from his own portfolio...

pontneddfechan Falls, brecon 
beacons, south Wales
This shot really captures the power of the water. 
With its reliance on texture and colour, it’s more 
interpretive than your standard waterfall image.

maruia Falls, Nelson National park, 
New Zealand
My favourite waterfall image, made up of eight 
shots stitched together. I like the range of detail, 
from the main falls to the smaller cascades.

buachaille etive Falls,  
glencoe, scotland
A view of the falls with Buachaille Etive Mor  
in the background. These are easily the most 
photographed falls in the UK, and justifiably so. 

 Competing 
highlights
“When composing 
waterfall images it can 
sometimes be hard to 
know whether or not 
to include the sky,” 
says Nigel. “As a rule of 
thumb, if the sky is as 
bright as or brighter 
than the waterfall it’s 
usually better to crop 
it out; if you don’t, it 
will become a 
secondary highlight 
that may compete for 
the viewer’s attention. 
If you’re shooting 
against a clear blue 
sky this is obviously 
less of an issue!”

Hot 
SHot

#02

eXposure 1/1000 sec, f/4.5, ISO3200  
leNs Sigma 18-250mm f/3.5-6.3 DC OS HSM Macro



April 2015 www.digitalcameraworld.com14

hot 
shot
#03

eXposure 2 secs, f/22, ISO100   
leNs Sigma 18-250mm f/3.5-6.3 DC OS HSM Macro 

expert insight  
eDge oF DarkNess

Nigel says… Like competing highlights 
(see page 13), highlights at the edges of 
the frame can be a distraction, leading 
the viewer’s eye out of the frame – this  
is especially true if the highlights are at 
the base of the frame [see right]. Try to 
avoid bright highlights leaking off the 
frame like this, and make the most of 
darker tones along the bottom edge  
to give your image a stronger base.

 Find a balance
“The key with a shot like this is to experiment 
with your positioning and composition, and 
with the relationship between the foreground, 
middle-ground and background elements,” 
explains Nigel. “Sometimes, moving your 
position slightly, or framing a shot a few feet  
to the left or right, or up or down, can make all 
the difference, so it’s worth spending some 
time getting this right. Ideally you want to  
have some separation between the various 
elements in the scene, but not so much that 
there’s lots of dead space.”

Because of the depth of the 
river, and the spray coming off 

the base of the falls, we couldn’t get 
as close as we were hoping to for 
this shot, so Nigel suggested setting 

up slightly further back, and using a longer lens 
to crop in on the waterfall in the distance, the 
fallen tree in the middle-ground and the rocks 
and river in the foreground. A shutter speed of 
two seconds ensured that both the falls and the 
rapids were nicely blurred, and converting to 
mono has made the most of the tones and 
textures in the water and the rocks. I really like 
the contrast between the verticals of the falling 
water, the horizontals of the rocks, and the more 
angular lines of the tree limbs.   

oUr apprentiCe says…
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Waterfalls masterclass

pro’s Killer Kit #03 ND Filters

Nigel says… On a dull, overcast day, you can usually 
set a slow enough shutter speed to blur the trails 
of waterfalls, but if you want to capture movement 
in the rapids below, or if it’s very bright, you might 
not be able to set a slow enough speed, even at your 
lens’s narrowest aperture. The answer is to attach 
a neutral density filter to reduce the amount of 
light reaching the sensor, which enables you to set 
a slower shutter speed (and so let in more light for 
a correct exposure). ND filters come in a variety of 
strengths, from one stop up to 10 stops, and they 
can also be stacked (see page 50). A good starting 
point is a kit with two-, four- and six-stop filters. 

 see in black  
and white
By their nature waterfalls 
are fairly monochromatic 
subjects, especially in 
winter, and with the  
strong contrast between 
highlights and shadows 
they can make great 
candidates for conversion 
to black and white. One 
way to check whether  
or not a scene has the 
potential to work in mono 
is to set your D-SLR’s 
Picture Control to Black 
& White, while ensuring 
that you’re shooting in 
RAW, or RAW + JPEG 
mode. That way you’ll see 
a mono version of the shot 
when you review it on the 
camera’s rear screen, but 
all the colour information 
will be preserved in the 
RAW file. If you only shoot 
in JPEG, the camera will 
actually process the shot 
in mono, and the colour 
will be lost for ever.
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THE APPRENTICEthe apprentiCe

the final assessment…
■ Enid had a keen eye for potential subjects and the basics of composition, both of which  
gave her a real head start when it came to shooting waterfalls. She really just needed help  
with consolidating her knowledge of the relationship between shutter speed and aperture,  
and with the benefits of using filters to eliminate reflections, and to slow things down. 

I was really pleased with this image – it brought together all the skills we’d 
been working on in a single frame. In addition to having to think about the 

usual things like composition and exposure, I also had to expose the shot for long 
enough to blur the swirling water in the middle-ground. At ISO100 and my lens’s 
narrowest aperture the longest I could manage was a second – long enough to 

blur the fall, but not the swirls. Attaching a four-stop neutral density filter enabled me to set  
an exposure time of 20 seconds, which was long enough to capture the movement in the eddy 
perfectly, but without losing definition in the falls. I also really like the way the foreground 
boulders and tree trunk anchor the composition, and lead the viewer’s eye towards the falls.   

oUr apprentiCe says…

 Enid’s Shot of the Day is an excellent example of how different skills  
and a strong composition can combine to create a very striking image.  

A 20-second exposure has enabled her to capture the circular swirls of the eddy 
below the waterfall, while a narrow aperture has helped her to maximise depth 
of field. Using the log as a foreground feature has also worked extremely well, 

as has shooting in portrait format, which has created a strong relationship between the log 
and the waterfall; the highlights in the fall are nicely captured within the frame too. Overall, 
Enid produced a really nice set of images during the day, showing a strong feel for 
composition and a good understanding of her camera’s controls.   

oUr pro’s verdiCt

next month sportiNg ChaNCe!

issUe 45 on sale 
9 april 2015

Next issue’s Apprentice discovers the 
secrets of shooting the peak of the action 
with the help of multi-award-winning 
sports photographer Mark Pain. 

expert insight get iN a spiN

Nigel  says… Waterfalls often feature eddies, 
caused by the water that’s tumbled over the falls 
circulating back towards them in a circular motion. 
If there’s enough white water to make these circular 
currents visible, it’s worth experimenting with the 
length of the exposure to try to capture them – as 
Enid has done to great effect with her Shot of the 
Day (below and facing page). The key is to ensure the 
circular swirls are kept within the frame, otherwise 
they’ll lead the eye towards the edges of the frame 
rather than towards the subject. It’s also important 
to ensure the longer exposure doesn’t turn the 
waterfall itself into a featureless sheet of white.

Name .............................................................................................................................................................. 
Address ......................................................................................................................................................... 
Tel no .............................................................................................................................................................. 
Email .............................................................................................................................................................. 
Camera ......................................................................................................................................................... 
I’d like help shooting ................................................................................................................................

Do you want to take your photography to the next 
level and learn first-hand from a top-flight pro? 
If you’d like a chance of being our next N-Photo 
Apprentice, let us know what you’d like help 
shooting and your full contact details. Email mail@
nphotomag.com, with ‘Apprentice’ as the subject 

returN this Form to… The Apprentice, N-Photo Magazine, Quay House, The Ambury, Bath, BA1 1UA, UK

WoUld yoU liKe to be oUr next apprentiCe?
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eXposure 20 secs, f/29, ISO100    
leNs Sigma 10-20mm f/4-5.6 EX DC HSM  



The winners of the 2014 International Garden Photographer of the Year 
competition have been announced. Here are some of our favourites…



I discovered this stunning location 
purely by accident. I was running a 

group photography workshop, and while 
driving back down Mount Buffalo in Victoria 
we entered thick fog with amazing soft light 
streaming through. I was back in the area a 
few weeks later and was greeted with almost 
identical conditions. I nailed this shot just 
before the fog lifted, using a polariser to take 
the glare out of the stream and foliage.  

www.markgray.com.au

Nikon D800e, Nikon AF-S 14-24mm f/2.8G ED,  
1/4 sec, f/16, ISO100, circular polariser

01 Mystic Forest
  Mark Gray, Australia  

First Place, Trees, Woods & Forests

http://www.markgray.com.au
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These beautiful damselflies 
brighten up our summer with 

their graceful structure, their colours 
and their expressive faces. Early in the 
morning I ventured out and found 
some resting on leaves, still cold and 
less active, which enabled me to coax 
them onto a leaf for this shot.  

www.carolynebarberphotography.co.uk

Nikon D90, Sigma AF 50mm f/2.8 EX DG Macro, 
1/640 sec, f/5.6, ISO400

02 Is She Local?
  Carolyne Barber, UK 

New Shoots award for emerging talent

This cabbage white butterfly was 
flitting from flower to flower, and 

discovered a patch of forget-me-nots.  
I had to lie really flat and wriggle into 
position to get the entire butterfly in 
focus, with the cloud-like out-of-focus 
flowers creating a heavenly feel.  

www.sarahfionahelme.com

Nikon 3Ds, Nikon AF-S 105mm f/2.8G VR Macro, 
1/400 sec, f/4, ISO800

03 Butterfly Heaven
  Sarah-fiona Helme, UK 

Finalist, Wildlife in the Garden

http://www.carolynebarberphotography.co.uk
http://www.sarahfionahelme.com
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This year a large number of 
common frog tadpoles clustered 

in the shallow area of our garden 
pond for several days after hatching. 
They were always wriggling, and 
often surrounded by air bubbles.  
I was intrigued by the patterns, 
colours and texture of the tadpoles, 
and the contrast between the 
tadpoles and the bubbles. I tried to 
photograph the tadpoles when the 
wind was light, to avoid ripples on 
the surface of the water.  

On the hills of Tuscany in 
the early morning, when 

the sun is just starting to rise 
and all you can feel is the breeze 
on your skin, you can find a 
wonderful microscopic world of 
bugs waiting for the sun. While 
I was taking shots of the insects 
I noticed this little snail 
crawling along a spiral twig that 
matched the spirals of its shell, 
trying to find its way down.  

www.stefanocoltelli.com

Nikon D3s, Nikon AF-S 105mm f/2.8G VR Macro, 
1/125 sec, f/8, ISO800

Nikon D600, Nikon AF-S 105mm 
f/2.8G VR Macro with TC-20E III 

teleconverter, 1/100 sec, f/14, ISO400

05 Tadpoles  
and Bubbles

  Andrew Bailey, UK 
Finalist, Wildlife in the Garden

04 Spiral
  Stefano Coltelli, Italy 

Third Place, Macro Art
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I like photographing dry hydrangea 
flowers against a background of 

colourful autumn leaves in a beautiful 
sunset. This photograph was taken in the 
winter, but winter last year was very warm 
and snowless, more of a prolonged autumn. 
The sun shone through the few remaining 
leaves on the trees to create a nice 
background bokeh.  

www.magdawasiczek.pl

Nikon D300, Tamron SP AF 70-200mm f/2.8 Di LD IF 
Macro, 1/100 sec, f/4, ISO250

06 The Ballerinas
  Magdalena Wasiczek, Poland  

First place, The Beauty of Plants and Overall Winner
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To capture the movement in the petals of this 
anemone I combined several duplicate layers 

using masks, adjusting the opacity each time and 
painting away small areas to get the desired effect.  

www.jackyparker.com

Nikon D700, Nikon AF-S 105mm f/2.8G VR Macro,  
1/400 sec, f/3.5, ISO200

08 Breeze
  Jacky Parker, UK 

Third Place, The Beauty of Plants

I exaggerated this image of a cornflower in 
software to nudge it from botany into fantasy. It’s 

named after the American dancer Isadora Duncan – the 
petals remind me of her trademark flowing scarves.  

www.photographybygillianhunt.com

Nikon D800, Nikon 60mm f/2.8 Macro,  
Lens Baby Pro, 1/1250 sec, f/1.4, ISO200

07 Isadora
  Gillian Hunt, UK 

Highly Commended, Macro Art

http://www.photographybygillianhunt.com
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INTerNATIONAL GArdeN  
PHOTOGrAPHer OF THe YeAr
All of the images featured in this issue’s Lightbox 
are from the International Garden Photographer  
of the Year competition 2014. An exhibition of the 
winning pictures is on show at The Royal Botanic 
Gardens, Kew, until 6 April, after which it will tour 
venues across the UK, including various National 
Trust properties and the Royal Botanic Garden 
Edinburgh, and it will tour abroad to Cyprus and 
Germany. The International Garden Photographer of 
the Year Collection 8 book is on sale now at £18.99. 

If you’d like to enter this year’s competition, 
competition 9 is open for entries until 31 October 
2015. For tour dates and venues for the 2014 
exhibition, to purchase the book or prints from 
2014, or for details on how to enter 2015’s 
competition, visit www.igpoty.com

These two snowdrops, seemingly 
emerging from a white cloud, 

seduced and inspired me. I pictured 
this shot, and similar ones, for my 
portfolio. They would be minimalist 
and would include, when possible, a 
foreground with flowers identical to the 
main subject but close to the lens so 
they would be blurred but harmonious 
in colour. I spent a lot of time walking 
late in the day, looking for areas with a 
multitude of flowers and the 
appropriate light.  

Nikon D800e, Nikon AF-S 105mm f/2.8G VR 
Macro, 1/400 sec, f/3, ISO400

10 Springtime Appearances
  Christiane Vandroux, France  

Third Place, Portfolios

Just before Christmas Toronto 
was hit by the biggest ice storm in 

three or four decades. All the trees and 
plants were covered in a thick blanket 
of clear ice, and I decided to go for a 
walk in High Park, which is the most 
beautiful park in Toronto in any 
season. I came across this amalgam  
of small plants and high grasses; the 
orange and red colours caught my eye, 
and the flowers looked like crystal or a 
Christmas decoration.  

www.500px.com/Golden_Maple

Nikon 1 S1, Nikon 30-110mm f/3.8-5.6 VR,  
1/60 sec, f/5.6, ISO200

09 Frozen Beauty
  Vinh Q T Nguyen, Canada 

Highly Commended, The Beauty of Plants

http://www.igpoty.com
http://www.500px.com/Golden_Maple


LIGHTBOXInspirational images

25April 2015www.digitalcameraworld.com



April 201526

Focus on focusSpecial feature

www.digitalcameraworld.com

I
f a picture isn’t focused 
properly then it’s usually 
destined for the trash, 

irrespective of how well exposed it 
is, or how great the subject might be 
(with the exception of a genuine shot 
of the Loch Ness monster, perhaps!). 
In other words, focus isn’t simply 
important, it’s fundamental to the 
success of each and every image  
you take. But ‘being in focus’ means 
different things for different genres; 
what may be applicable for shooting 
sport might not be so relevant for 
capturing a pin-sharp macro image. 

On the face of it, focus is a simple 
concept to understand: the subject is 
either in focus or it isn’t. But actually 
there’s a lot more to it than that. The 

amount of your subject that’s in focus 
is dictated by a number of variables, 
such as aperture and lens choice, both 
of which have a profound effect on 
the image. Sometimes you’ll want to 
capture every part of a scene in sharp 
focus, while at other times it might 
be better to restrict the focus, so that 
only the main subject is sharp and the 
background is blurred. 

In this feature we’ll examine the 
role of focus for five different genres 
(landscapes, portraits, wildlife, macro, 
and sport) and provide practical, step-
by-step advice on how best to focus 
your subjects. What’s more, five of the 
country’s leading Nikon pros will reveal 
their tricks of the trade for nailing pin-
sharp images every time…

Struggling with inaccurate or inconsistent 
focusing? Then struggle no more with our 
essential guide to nailing pin-sharp shots of 
landscapes, portraits, wildlife, and more…
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■ The aim when shooting most 
landscape images is to record all parts 
of the scene in sharp focus, from the 
furthest hills to the closest foreground 
objects. This is usually achieved 
by stopping down (in other words, 
reducing the size of) the aperture, to 
f/16 for example. This in turn increases 
depth of field to bring everything 
into focus from front to back. (Avoid 
using your lens’s smallest apertures, 
though, as this can result in a softening 
of image detail– see Step by Step.)

However, the depth of field in an 
image is also affected by two other 
factors: the focal length of the lens, 
and the distance at which the lens is 

focused. The longer the focal length, 
the shallower the depth of field will be, 
and vice versa. This means that depth 
of field is greater when using a wide-
angle lens compared to a standard or 
telephoto lens – assuming they’re all 
focused on the same point. 

In other words, it’s generally much 
easier to get both near and far parts 
of a scene in focus when using a wide-
angle lens set to a small aperture. 
In fact, if your lens is wide enough it 
might even be possible to achieve 
sharp focus throughout the scene 
using a mid-range aperture of f/8 or 
f/11, which for most lenses is the sweet 
spot in terms of optimal image quality. 

Whenever I’m shootIng I  
take a hyperfocal dIstance 

calculatIon chart, WhIch tells 
me Where to focus to achIeve 
front-to-back sharpness for 

any gIven focal length and 
aperture combInatIon. 

It’s useful to carry one, but it’s not 
something I refer to for every photo.  

In most situations, a quicker and easier 
method is to focus a third of the way into 

the frame (that’s one third up from the 
bottom of the viewfinder, rather than a 
third of the way into the scene). Broadly 

speaking this is where the hyperfocal 
focus point would be. Nine times out of 
ten this technique works just fine, and  

I only really refer to my hyperfocal 
distance chart when my images  

feature close foreground subjects.
Whichever method you use, review 

your picture afterwards on your LCD by 
zooming into an area of both foreground 
and background to check for sharpness.

Pro Adam Burton 
Pro-file Devon-based landscape 
specialist Adam has been a full-time 
professional photographer since 2008. 
He has published five books, and his 
clients include the AA, The Times 
and National Geographic.

thInk deep
Capture pin-sharp landscapes by 

maximising depth of field to bring 
everything into focus

L a n d s c a p e s

pro tIps! 
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KITBaG 
Smartphone apps like 
Field Tools are an easy 

way to calculate hyperfocal 
distance, and if you always 

carry your phone, you’ll 
never forget the 

calculator!

sTep By sTep focusIng from front to back

01 set a small aperture 
(but not too small)

Of the three variables that influence 
depth of field (DOF), aperture is 
arguably the most important, and the 
one you have most control over. In order 
to maximise DOF, set a small aperture, 
but not too small (at apertures smaller 
than around  f/16, something called 
diffraction actually starts to soften 
images). Unless it’s very bright this will 
result in a slow shutter speed, so use a 
tripod and set mirror lock-up, and use a 
remote release or Nikon’s two-second 
timer, to avoid camera shake.

02 focus on the  
rIght area 

Irrespective of focal the length you 
choose, always ensure that you focus 
accurately in order to optimise depth  
of field in your image. Remember that 
more of the scene will be brought into 
focus behind the focus point than in 
front, which means you need to focus  
on the optimal part of the scene (the 
so-called hyperfocal distance) to 
maximise depth of field. (See Pro Tips!, 
left, for more details on how to do this  
if you don’t have a hyperfocal distance 
chart to hand). 

03 sWItch to  
manual focus 

If you use autofocus, make sure that the 
active focusing point is aligned precisely 
on the spot you want to focus on. 
Alternatively, use the default central 
focusing point to autofocus, and then 
lock the focus by switching your lens to 
manual mode, before recomposing your 
shot. Another option is to use Live View 
to magnify the image on the LCD on the 
back of the camera to 100% view, and 
then manually focus on a detail or edge 
that you know is on or near the 
hyperfocal distance. 

Left
At longer focal 
lengths, it’s even 
more important  
to set a small 
aperture to get 
everything sharp 
from front to back 

Bottom left
When foreground 
objects are very 
close to the lens, 
it’s worth getting 
the hyperfocal 
distance right

Bottom right
If you’re using a 
long exposure, a 
rock-solid tripod 
is essential
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pro tIps! 

the InclusIon of out-of-focus 
hIghlIghts, or ‘bokeh’, In 

portraIts can add a beautIful 
effect to the background of 
Images and Is the result of 
shootIng a subject usIng a 

‘fast’ lens that WIll alloW you 
to Work at WIde apertures. 

The effect is most noticeable in 
highlights – so, when shooting contre 
jour (into the light). Look for locations 
where there are bright areas of light in 
the background, such as sun coming 

through trees [top], and make sure that 
you are close to your subject and the 
background is some distance away. 

Different lenses produce different 
types of bokeh; the effect will be more 

pronounced with lenses that have a 
maximum aperture of f/2.8 or wider. 

‘Good’ bokeh isn’t just confined to 
out-of-focus specular highlights; it  
can also be used for soft, dreamy 
backgrounds of uniform colour. 

Pro Kate Hopewell-Smith 
Pro-file Lifestyle and wedding  
pro Kate was one of the first UK 
photographers to specialise in boudoir 
photography. She is on the panel of the 
Guild of Photographers and one of only 
seven Nikon Ambassadors in the UK.

Top
Blurring out 
dappled light in 
the background 
results in a lovely 
‘bokeh’ effect, 
which helps to 
focus attention 
on your subject   

Above
When shooting 
contre jour, or 
into the light, 
focus on the 
rimlight around 
your subject’s 
face to help them 
really stand out 

Right
When shooting 
kids, switch to 
continuous AF; 
this will adjust 
the focusing if 
your subjects 
move closer or 
further away 

Bottom
When you’re 
further away 
from subjects, 
focusing on their 
face(s) should be 
sufficient to get 
the key elements 
in sharp focus

the eyes have It
Most good portraits boast pin-sharp eyes, 

so discover which settings you need to 
focus attention where it matters most

p o r T r a I T s

■ Portraits are typically shot on a 
short to medium telephoto lens at a 
wide aperture in order to make the 
subject stand out clearly from the 
background. The combination of a 
longer focal length lens and a very 
wide aperture means that depth of 
field is much more limited than when 
shooting landscapes with a wide-angle 
lens. Because of this focusing needs 
to be very precise. The band of focus 
may be just a few centimetres deep 
when taking a close-up portrait, so it’s 
important that the subject is sharp 
where it matters. 

The crucial part of any portrait is the 
eyes, so at least one eye needs to be 

sharp, no matter what. As long as this 
is the case, it almost doesn’t matter 
if nothing else within the frame is in 
focus – the viewer will engage with the 
subject of the photo automatically. 

Another consideration is that your 
subject is unlikely to stay completely 
still, even when you’re shooting a 
formal studio portrait, and any head 
movements, however minor, could 
well throw the subject’s eyes slightly 
out of focus. This problem will be more 
exaggerated the closer you are to your 
subject, so it’s important to have your 
Nikon set up correctly so that you can 
be sure of getting the crucial part of 
every portrait sharp.
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KITBaG 
For the most beautiful 

bokeh, don’t just choose a 
lens with a wide maximum 

aperture. Get one with 
seven or more diaphragm 

blades for smoother 
highlights.

sTep By sTep focusIng on the eyes

01 set the focus  
poInt manually

The most reliable way to focus on your 
subject’s eyes is to select a focusing 
point that sits over them. Select a 
single focus point rather than a cluster 
for greater accuracy. While the number 
of focus points available will vary, most 
Nikons have plenty to choose from 
(some even allow you to restrict the 
number available, though we don’t 
recommend that in this instance), so 
it’s usually possible to select one that 
aligns with the subject’s eye without 
changing your composition. 

02 focus on the 
nearest eye

If the subject is facing the camera, both 
eyes will be in the same plane of focus 
and therefore both will be sharp. 
However, if the subject is at an angle to 
the camera then focus on the eye that 
is nearest to it, even if this means the 
other eye is slightly out of focus. For 
more distant portraits you can focus 
more generally on the subject’s face 
rather than trying to pinpoint a single 
pupil – the eyes should still be sharp 
due to the increased depth of field at 
longer shooting distances.

03 sWItch to 
contInuous af 

To maintain the focus on your subject’s 
eyes or face, try switching your Nikon’s 
AF mode from autofocus single (AF-S) 
to autofocus continuous (AF-C). This 
will ensure that as long as the shutter 
button is half pressed, the camera will 
keep refocusing on your subject, even 
when they move. This may be useful 
when photographing restless children, 
for example, but it’ll also take care of 
minor movements in adult subjects, 
and will help keep the eyes in focus 
when shooting close-up portraits. 
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Long lenses are heavy, 
so some sort of support is 

usually essential. If using a 
tripod, use a ball head, or 
better still a gimbal head, 

to maximise freedom 
of movement. 

*This applies to the professional range of Nikon bodies. With other models you  
can nominate the AE-L/AF-L button to activate AF in the Custom Setting Menu.

pro tIps! 

use your af-on* button to 
actIvate autofocus. thIs 

technIque WIll greatly assIst 
your WIldlIfe photography. 

In your camera’s Custom Setting 
Menu, under Autofocus, you will find an 
option for AF activation. Choose ‘AF-ON 
only’. Now the AF function is completely 
disconnected from the shutter release 
mechanism. In practice, this means you 

can focus with your thumb in 
continuous AF mode – which means 

your camera will automatically adjust 
the focus whenever your subject moves 
towards or away from the camera – and 
use your forefinger to fire off a burst of 

shots at the height of the action. 
The trick is to make sure the active 

focus point remains over the subject the 
whole time – think of it as tracking the 

subject through the viewfinder. It takes 
a little getting used to, but once you’re 

familiar with it you’ll find the back- 
button focusing technique simplifies 

the process and improves your hit rate.

Pro Chris Gomersall 
Pro-file Chris has been a 
professional wildlife photographer for 
30 years, including 14 years as in-house 
photographer for the RSPB. He was 
named European Wildlife Photographer 
of the Year in 2007.

■ Wildlife photography has many 
similarities to both portraiture and 
sport photography, and there is a 
lot of cross-over in their respective 
focusing techniques. Like portraits, 
most wildlife images tend be taken 
at wide apertures using a mid to long 
telephoto lens. The use of a wide 
aperture has the effect of blurring out 
the background in a very similar way to 
when shooting people, but the result 
is even more pronounced because 
of the longer lens. In addition, a wide 
aperture enables a fast shutter speed 
to be set, which helps to eliminate 
blur caused by both camera shake 
and subject movement, something 

which isn’t really a factor when you’re 
shooting portraits. 

Point of view is a consideration for 
wildlife photography, as this has an 
impact on background and foreground 
blur when using long focal length 
lenses with their very narrow angle of 
view. Positioning the camera closer to 
the ground will accentuate the bokeh 
effect because the background will 
become further away from the subject, 
and so more out of focus. Similarly, 
the foreground will be brought closer 
and thrown out of focus, creating two 
‘layers’ of attractive bokeh at the top 
and bottom of the picture, with the 
subject in sharp focus between them. 

stay on track
Successful wildlife photography depends 
on precise focusing, and uses techniques 

from other genres to bag sharp shots

W I L d L I F e
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sTep By sTep focusIng from afar

01 set a WIde  
aperture

When using a long telephoto lens to 
photograph wildlife at close range, 
depth of field is very limited, especially 
at wide apertures. Because of this, you 
should take care to focus accurately on 
the eyes or face of your subject using a 
single autofocus point (see page 31 for 
more on this). Set a wide aperture using 
aperture-priority or manual mode, and 
then adjust the ISO to provide a shutter 
speed fast enough to prevent any blur 
from camera shake and subject 
movement spoiling your photograph. 

02 track your  
subject 

For moving wildlife you’ll need a fast 
shutter speed – upwards of 1/500 sec 
– continuous focusing and a fast frame 
rate. Once the subject is well-framed, 
engage AF by half-pressing the shutter 
release (though see Pro Tips!, left, for 
more on this). The central focusing point 
is often the most sensitive, so use this 
whenever possible, and keep the 
shutter button half-pressed to maintain 
focus. Try to keep the subject framed so 
that the focus point remains on the eyes 
and shoot in short bursts.

03 keep an eye on  
the background 

To make your subject stand out clearly 
against the background, take care to 
line it up against distant landscape 
features and set your lens’s widest 
aperture to produce soft-focus 
backgrounds. Solid backgrounds of a 
neutral colour – greens and browns 
– work best for wildlife. Also, try to  
avoid hotspots or highlights in the 
background. Get down low to introduce 
blurred foregrounds too, which will give 
extra depth to your images and add a 
feeling of intimacy. 

Above
Including something  
in the foreground and 
blurring it out helps to  
leads the viewer’s eye 
towards your subject

Left
Getting down low and 
including some blurred 
foreground also helps to 
isolate your subject from 
its surroundings

Far right, top
Shooting in burst mode 
will help you capture the 
peak of the action

Far right, bottom
It’s important to keep  
the active focus point 
over the subject when 
using continuous AF 
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■ The effects of focusing, or more 
importantly, mis-focusing, are far 
more pronounced when you are 
shooting subjects in extreme close-up, 
because depth of field is limited to 
just a few millimetres. It’s possible to 
increase the depth of field by shooting 
at a very small aperture, for example 
f/16 or f/22, but even then the amount 
of your subject that will be recorded 
in sharp focus will be limited to a very 
narrow band indeed. 

Also, using such a small aperture 
may not always be desirable in macro 
photography, as this can bring the 
surroundings more into focus, which 
may draw viewers’ attention away 

from the subject. In fact, many of 
the most successful macro shots 
are taken at quite a wide aperture, to 
deliberately restrict the point of focus 
to a very specific part of the subject in 
order to give it greater impact. 

Irrespective of the aperture you 
decide is appropriate for your subject, 
precise focusing is vital. This requires 
a methodical, disciplined approach 
with a high level of accuracy in both 
focusing and camera positioning. To 
achieve the best results you’ll need 
to take your time, and to make very 
fine adjustments, as well as make 
constant checks to ensure you have 
got the best possible focus. 

depth of fIeld Is Inherently 
shalloW at hIgher 

magnIfIcatIons, so there Is no 
room for error When focusIng. 

the slIghtest movement WIll 
throW your subject out of  

the focal plane. 
Use a tripod to keep your camera in a 

fixed position – it is the perfect focusing 
aid, and will also enable you to take 

advantage of your camera’s Live View 
function. The latter will allow you to 

zoom in on a small area of your subject 
in order to check critical sharpness and 

make fine adjustments to your focusing. 
I recommend using Live View focusing 

for close-ups; nothing else allows you to 
position your point of focus so precisely. 

Also, it allows you to see how the 
aperture you set affects depth of field. 
By adjusting the aperture while you’re 
viewing the subject on the LCD you can 

visualise how much of it will be 
recorded in sharp focus.

Pro Ross Hoddinott 
Pro-file Outdoor close-up specialist 
Ross was British Wildlife Photographer 
of the Year in 2009. An Ambassador for 
Nikon UK, he has sat on the judging 
panel for the Wildlife Photographer  
of the Year competition.

focus by eye
At high magnifications there is no margin 
for mis-focusing, so pinpoint accuracy is 
required for bitingly sharp macro shots

M a c r o



35April 2015www.digitalcameraworld.com

Focus on focus

KITBaG 
While extension tubes 

and their ilk are useful for 
getting close-ups, if you’re 

serious about macro 
photography, you should 

invest in a proper 
macro lens.

sTep By sTep focusIng from close up

01 sWItch to  
manual focus

Although modern autofocus (AF) 
systems are highly sophisticated, AF is 
rarely the best option for close-up work. 
AF has a habit of struggling to lock on to 
small, nearby objects and fine detail, 
especially when you’re shooting in 
low-light or low-contrast situations. 
Manual focus is usually a better option 
for macro photography, allowing you  
to select and place your point of focus 
with far greater accuracy – precisely  
on an insect’s eyes or the stamens of  
a flower, for example.

02 thInk about 
aperture

Aperture selection has a critical effect 
not only on how much of the subject 
appears in focus, but also on the 
surroundings. By selecting a wide 
aperture only the parts of the subject 
that are in the same plane as the focus 
point will come out sharp. Everything 
else will be blurred. Conversely, by 
stopping the aperture down to, say,  
f/16, more of the subject, but also  
the surroundings, will appear sharp.  
It comes down to the subject being 
photographed, and personal preference. 

03 fInd a suItable 
parallel 

Focus is not only affected by the 
aperture that you choose, but also by 
the positioning of the camera in relation 
to the subject. In order to capture more 
of your subject in focus, make sure the 
back of the camera is parallel to (in 
other words, in the same plane as) the 
most important parts of the subject. 
For example, if you want to get the 
wings of a resting butterfly in sharp 
focus, then the camera’s sensor should 
be parallel to both wings. That way 
you’ll capture maximum detail.

Far left
In this image, the 
butterflies’ wings 
are parallel to the 
camera sensor  
for maximum 
sharpness

Top
Think about the 
background, too: 
let your subjects 
stand out!

Middle left
Water drops can 
look fantastic in 
macro shots, but 
they need to be 
pin-sharp

Left
Sometimes you 
may want to set a 
small aperture to 
get more of your 
subject in focus
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Special feature
KITBaG 

Fast telephoto primes 
are eye-wateringly 

expensive. While most of us 
can’t stretch to a 300mm 

f/2.8, hiring one for a big 
event is an option.

 

■ In sport photography it’s important 
to try to maximise the visual impact 
of every image you take. One way of 
achieving this is by reducing the depth 
of field to an absolute minimum, which 
means that your lens and aperture 
choice are crucial. 

A fast (wide aperture) prime 
telephoto lens such as a 300mm 
f/2.8 will not only give you the best 
possible optical quality, it will also give 
you the tiny amount of depth of field 
you’re looking for. Unlike most lenses, 
they are designed to work at their 
best wide open at f/2.8, giving crisp, 
sharp images and throwing anything 
in the background out of focus. They 

also have incredibly smooth bokeh 
which makes it look like the subject 
is isolated from it’s background, 
giving the picture an almost three 
dimensional feeling. The down side  
is that such lenses are very costly!  
(See Kitbag, above right). 

The nature of sport means that 
your subject is going to be constantly 
on the move, so you need to optimise 
the settings on your camera to give 
yourself the best chance of securing 
a shot. You rarely get a second chance 
when shooting sport, which means you 
must be confident that your camera 
can focus accurately and maintain 
that focus at the critical moments. 

the rIght lens choIce counts 
for nothIng If your camera  
Isn’t set up WIth the rIght 

autofocus settIngs. 
Most people are aware of the many 

different patterns and numbers of focus 
points available to them in their camera, 

but very few adjust the focus tracking, 
which can be just as crucial. 

The AF tracking speed refers to how 
quickly the camera tries to refocus on a 
subject if it suddenly comes into frame. 

For instance, with rugby, tries are 
sometimes scored between the posts 

[above right]; if you had the tracking set 
on the wrong speed and were behind the 
try-line, your camera would attempt to 

shift focus from the player to the 
goalpost as he dived over the try-line to 

score. By slowing the tracking down 
slightly the camera will delay how quickly 

it tries to refocus and would ignore the 
goalpost for longer, retaining focus on 

the player. Each sport differs so you have 
to adjust your tracking accordingly.

Pro Mark Pain 
Pro-file Chief sports photographer at 
the Mail on Sunday, Mark was named 
Sports Photographer of the Year at the 
2005 and 2011 British Press Awards. A 
Nikon Ambassador, he founded the UK’s 
first sports photography school.

pro tIps! 

focus on actIon
When shooting sport, it’s crucial to isolate 
your main subject from its background to 

really make the activity stand out

s p o r T
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Focus on focus

sTep By sTep focusIng on movement

01 the faster,  
the better

Fast primes are top of the list when  
it comes to autofocus speed and 
accuracy – another reason why they 
are the lens of choice for most sports 
pros. With a subject that may only be in 
frame for a few seconds, autofocus 
needs to be virtually instant and 
utterly reliable. Where possible, 
always use your camera’s most 
responsive AF points (usually the 
central ones, but check your manual  
if you’re unsure) to acquire focus, as 
these will lock on quickest. 

02 keep up WIth  
the pace

To track and maintain focus on a 
subject, use continuous focus mode 
(AF-C). The camera will then continually 
adjust the autofocus so that the part of 
the subject that is aligned with the 
active focus point will be kept in focus, 
even if it moves towards or away from 
the camera. Keep the focusing point on 
the subject’s face, even if it means that 
the composition may be slightly out, as 
you can always crop the shot later. And 
back-button focusing can be a boon 
when shooting sport (see page 32). 

03 frame rate 
matters

Sports photography is about capturing 
the height of the action: the moment 
the goal is scored, the sprinter crossing 
the finish line. This requires a fast 
shutter speed to freeze the action, plus 
a fast frame rate. An SLR that will fire 
off eight to 10 frames per second will 
increase your chances of nailing a good 
shot. Time the shot for when the action 
reaches its peak rather than simply 
blasting away, otherwise you run the 
risk of maxing out your camera’s buffer 
before the peak of the action.

Left
Use back-button 
focusing in 
continuous AF 
mode to track 
fast-moving 
subjects

Bottom left
As with wildlife, 
burst mode will 
help you get sharp 
shots at the peak  
of the action 

Top
With some sports 
it’s possible to 
pre-focus on a 
particular point, 
and then wait for 
your subject to 
pass that point

Above
If in doubt, focus on 
your subject’s face 
and keep it under 
the active AF point
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Take out a print subscription to N-Photo 
to be inspired by amazing Nikon images, 
plus tips, techniques and must-try photo 
projects. Each issue is delivered direct 
to your door and features free gifts, 
including a CD with step-by-step videos.

■ Save up to 35% 
■ 13 issues delivered to your door
■ FREE Manfrotto Advanced Monopod

Take out a digital subscription to 
N-Photo to enjoy everything in the 
print edition, plus interactive tutorials, 
videos and galleries. Enjoy each issue on 
your digital device, so you will never be 
without the latest issue.

■ Interactive videos and galleries
■ 13 issues in a one-year subscription
■ Always have the latest issue to hand

Take out our new bundle package to 
enjoy N-Photo in print and via your digital 
device. Have the latest issue delivered 
to your door, while benefiting from an 
interactive digital edition so you can read 
your favourite photo mag on the move.

■ Save a whopping 59% 
■ 13 issues delivered your door
■ FREE Manfrotto Advanced Monopod

You can now enjoy the print or digital editions of N-Photo, or  
both together, with our three fantastic discounted packages

print digital print + digital

From £26.49  
(based on a six-month subscription)

From £19.99  
(based on a six-month subscription)

From £31.99  
(based on a six-month subscription)

OptiOn 1 OptiOn 2 OptiOn 3

SubScribe tO

Save up to 

35% 

NOW  
AVAILABLE  
ON APPLE & 

ANDROID!

Save 

59% 

and get thiS Superb ManfrOttO 
MOnOpOd wOrth £29.95 free!*

Your subscription will then continue at £31.99 every 6 months - SAVING 26% 
on the shop price and giving you an 83% discount on a digital subscription. 

*The Manfrotto Compact Advanced Monopod is available on both the 
print-only and print & digital bundle subscription for UK customers only.

www.digitalcameraworld.com

Quote code: NMPRINT15 Quote code: DIGITAL15 Quote code: NMBUNDLE15

Save up to 

45% 

free 
Manfrotto
Advanced 
Monopod!

free 
Manfrotto
Advanced 
Monopod!
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Purchase our Ultimate Nikon Pack and enjoy an 
N-Photo subscription plus more Nikon-related 
goodies worth a total of £241. Get the most from 
your Nikon SLR with this essential pack.

■  A one-year subscription to N-Photo magazine, 
both in print and digital

■ Master Your Nikon DVD
■  The Ultimate Nikon Bookazine – the 

comprehensive guide to using your Nikon SLR
■ Manfrotto Agile I Sling bag worth £69.99

All from just £89.99  

Prices and savings quoted are compared to buying full priced UK print and digital issues. You will receive 13 issues in a year. If you are dissatisfied in any way 
you can write to us or call us to cancel your subscription at any time and we will refund you for all unmailed issues. Gift is subject to availability. Please allow 

up to 60 days for the delivery of your gift. In the event of stocks becoming exhausted, we reserve the right to replace with items of a similar value. Prices correct at point of print and subject to change. 
For full terms  and conditions  please visit myfavm.ag/magterms.  Offer ends 15 May 2015. 

OptiOn 4

the ultiMate 
nikOn bundle!

hOw tO SubScribe

Offer for new UK subscribers only. Based on a one-year subscription, saving 36% 
on the shop price and giving you an 87% discount on a digital subscription.

The Manfrotto Compact Advanced Monopod 
is the ideal accessory for photography. It’s 
lightweight and packs down small, making it 
ideal for taking on your travels. You can quickly 
attach your SLR plus a standard zoom lens (up to 
200mm) with one hand using the quick wheel. In 
addition, the reinforced-aluminium, five-section 
leg design means you can reach a height of 
155cm while maintaining shooting stability.

Worth 
£241!

www.digitalcameraworld.com

Visit www.myfavouritemagazines.co.uk/nphMOnOpOd
or call 0844 848 2852 Quote NMPRINT15, DIGITAL15, NMBUNDLE15 or UNPBUNDLE
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Ingenious recipes for 
stunning shots

To watch the videos use this  
web link… bit.ly/NPhoto44

THis monTH’s projecTs…
PROJECT ONE | CAMERA TECHNIQUES

44  Break the rules
Explore six ways to rebel against the 

accepted ‘rules’ of landscape composition to 
capture more interesting and original shots

PROJECT TwO | SPECIAL EFFECTS

47  Double up
Have fun shooting a reflective self-

portrait that captures your best side – not  
just once, but twice! 

PROJECT THREE | DIgITAL DARkROOM

48  Protect yourself 
Discover the quick and easy way to 

add copyright and contact details to your 
images in Lightroom

PROJECT FOUR | gEAR SkILLS

50  Stack ’em up! 
Why stop at a single filter when you 

can mix and match for impressive effects

PROJECT FIVE | TAkE IT FURTHER

52  Have a heart 
Learn how to create shaped 

catchlights in subjects’ eyes to add  
a heartwarming touch to family photos

PROJECT SIX | CREATIVE PHOTOSHOP

54  Create a comic book hero 
Give a portrait shot against a plain 

white background some pop art punch using 
Smart Filters and layers in Photoshop

PROJECT SEVEN | THE BIg PROJECT

58  Stack for impact 
Set up your Nikon to shoot a sequence 

of landscape images, then combine them in 
Photoshop to create amazing skies

52

5044

58

Welcome To 
nikon skills

Click on this web link 
bit.ly/NPhoto44  
for your video  

in troduc tion to this 
mon th’s Nikon skills
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Ingenious recipes for stunning shots

Key sKill    Tools to use and settings to choose
Some of the most conventional things in a landscape photographer’s kit will help you break the rules

Project one    Camera TeChniques

Break the rules

We reveal six fresh 
ideas for macro 
photography

When it comes to composing  
a landscape photo there are a 

multitude of rules we’re instructed 
to follow. There’s the rule of thirds, 
which states that we should place 
interesting objects on the ‘third’ lines 
within the frame. Then there’s the 
‘foreground interest’ rule, which has 
us all scrambling around to find an 
attractive rock or plant to include in 
the foreground of our shot. We must 
also keep our horizons straight, 
eliminate ‘dead space’, and avoid 
placing our subject dead-centre. 

Often, by following these rules 
we’ll end up with a great photo. But if 
we simply apply them by rote to every 
scene we come across, we run the risk 
that all of our images will start to look 
very similar, and probably very similar 
to other photographers’ shots as well. 
So here’s a challenge for you. Go out 
and look for six totally different 

compositions in one location. Look  
for unconventional angles, and 
manoeuvre your subject around  
the frame in interesting ways.

It can be rather liberating to shoot 
what feels right for that particular 
location, in that light, at that moment, 
rather than squeezing the scene in 
front of you into a conventionally 
‘good’ composition. It might lead to a 
killer shot or a complete dud, but one 
thing it certainly won’t lead to is a 
series of photographs that were 
pre-planned in your head before  
you even set eyes on the location.

We went to Strumble Lighthouse in 
Pembrokeshire on a mission to look 
for new and interesting angles at a 
popular photography spot. Here are 
the results, and a few suggestions  
to get you started on your own 
challenge. And remember, the  
only rule is: there are no rules!  

the mission
■ Go to one location 
and try to capture six 
different compositions

time needed
■ One to two hours

sKill level
■ Anyone can do it
■ Some tricky aspects
■ Advanced technique

Kit needed
■ Nikon D-SLR  
■ Tripod

James Paterson liberates himself from the 
constraints of conventional composition…

 here’s a challenge for you. Go out and look for six totally 
different compositions in one location. Look for unconventional 
angles, and manoeuvre your subject around the frame 

next issue… 

Tripods
As with all landscape photography, a tripod is 
an invaluable tool to have for this project. When 
the risk of camera shake is removed, longer 
shutter speeds enable narrower apertures  
and lower ISOs for maximum image quality.

Filters
No landscape photographer should be without 
neutral density and graduated filters (see page 
50). By reducing the light that reaches your 
sensor they enable long exposures to capture 
a calming motion blur in water and clouds.

aperture
We’re often told to use narrow apertures for 
landscapes (see page 28). But as we’re being 
unconventional, why not go for a wide aperture 
for shallow depth of field? Putting the focus on 
something new can add intrigue to your shots.

To watch the video use this web link… bit.ly/nPhoto44

http://www.bit.ly/NPhoto44




QUICK TIP! If 
you’re not sure 
how to break 
the rules, take 
a look a t your 
own portfolio. 
The sort of shot 
you take over 
and over? Don’t 
repea t tha t!
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01 The safe option
We started with the safe shot, a standard view of the 
lighthouse. A quick Google search of the location turned 
up several near-identical versions. There’s the rule of 
thirds, the leading lines and the foreground interest, all 
working together to produce a nice, if very safe, landscape.

02 sent to the corner
Move your subject around the frame. This shot was taken 
from almost the same spot as the first, but a downwards 
tilt and a shift in framing has pushed the lighthouse into 
a corner, forcing the viewer’s eye to wander through the 
photo and producing a more dynamic composition.

03 stuck in the middle
Placing your subject dead-centre within the frame is 
something we’re often told not to do, but it can lead to a 
striking composition, particularly if, like here, there’s a 
symmetry to the surrounding landscape or leading lines 
that direct the eye towards the subject.

05 Big skies
The ‘big sky’ shot is 
something that can 
work very well if 
you have a single 
point of interest  
in a landscape. 
Including a huge 
expanse of sky  
(or foreground) 
emphasises the 
sense of isolation. 
Simply pull the 
camera back, or use 
a wide angle and 
frame the subject 
along the bottom or 
top of the frame. 

04 Tilted 
horizon 
An image creates 
its own reality, 
so why shouldn’t 
the world be 
tipped on its 
edge? Landscape 
photographers are 
taught to avoid 
wonky horizons, but 
an intentional tilt 
of the camera isn’t 
always bad. Here, 
the tilt emphasises 
the vertigo-
inducing approach 
to the lighthouse.

06 Go abstract
We’re told that a landscape should have a definable 
subject for the viewer to focus on. However, excluding 
any recognisable subject can result in beautiful abstract 
images – there’s something very calming about having 
just an array of soft pastel colours blending into one.

Leave The herd
■ Without putting yourself 
in danger, one sure way to 
avoid obvious compositions 
is to look for the places 
most people don’t or won’t 
venture. Everyone sees the 
same view by standing on 
the path, but if you can get 
above or below your subject, 
you unlock a whole new 
viewpoint. Anything from 
simply lying on the ground 
to clambering around your 
location can lead to more 
dynamic shots.

steP By steP    have it your way
One great subject, six great shots – and only one of them follows convention



Double up
Have some fun shooting an original  
self-portrait with Paul Grogan

Step by Step    Hold up a mirror...
Here’s how to capture your best side – twice!

01 Frame at last
The first step is to take the mirror out of its 
frame, as it will just get in the way of the 
reflection. Once you’ve found something to 
rest the mirror on, and something to sit on, it’s 
worth thinking about what’s in the background, 
and what’s going to be reflected in the mirror.

02 Get set up
Set up your camera on a tripod, with a remote 
release attached, and point it roughly where 
you’re going to be sitting – a kit lens set to its 
longest focal length is ideal, positioned so 
your face fills the frame. It’s useful to have an 
assistant to help with framing and focusing.

03 Find an angle
The key is getting the angle of the mirror right 
– and positioning yourself so that you and your 
reflection are as symmetrical as possible. 
Experiment with the angle of your head,  
so that it doesn’t look too wide or too thin. 
Then it’s simply a matter of experimenting!
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project two    special eFFects

Self-portraits are always  
a good staple if you’re 

struggling for inspiration – or can’t 
find a willing model to pose for you! 
The challenge is to shoot something  
a bit different. That’s where this easy 
project comes in – all you need is your 
SLR, a tripod, a remote release (if you 
don’t have one, use your camera’s 
self-timer), and an old mirror. 

For the effect to work you need to 
be able to take the mirror out of its 
frame. The thinner the glass the 
better; very thick glass can result in  
a double reflection that makes the 
reflected part of the image look 
slightly out-of-register. The mirror 
also needs to be big enough to reflect 
your whole face, but not so big that it 
becomes unwieldy – mirrors are 
heavy, so it helps if they’re small 
enough to balance on a table. It also 
helps to find something to sit on while 
you’re shooting, partly to ensure you 
stay in the same position, and partly 
so you can stay relaxed while you’re 
posing. Here’s how it’s done…   

Next iSSue…  
Have fun with light – 
make a flash stencil

the miSSioN
■ To get creative  
with mirrors

time NeeDeD
■ Ten minutes

Skill level
■ Anyone can do it 
■ Some tricky aspects 
■ Advanced technique

kit NeeDeD
■ Nikon D-SLR 
■ Remote release 
■ Tripod ■ Mirror 

to watch the video use this web link… bit.ly/Nphoto44

http://www.bit.ly/NPhoto44
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Next issue… 
Organise your photos 
for a faster workflow

the missioN
■ To assign your 
name to your photos 

time Needed 
■ Ten minutes

skill level
■ Anyone can do it
■ Some tricky aspects
■ Advanced technique

kit Needed
■ Lightroom 5 It’s common practice to  

share your digital photos as 
electronic copies. You might do this 
by emailing them to clients, posting 
them on your Facebook page or 
presenting them in an online gallery. 
Once you’ve shared a photo you can’t 
control where it ends up, because it’s 
easy for others to make an electronic 

copy. This can lead to scenarios where 
your work is shared and/or published 
without you being credited or paid for 
it. As the creator of the image, you 
own the copyright to it, so others 
must seek your permission if they 
want to use it. To help them do so you 
can assign your copyright details to 
the photo’s metadata.

When your camera processes an 
image to render its colours and tones, 
it also includes information about the 
camera settings used to capture the 
photo, such as the shutter speed and 
aperture setting. This metadata is 
stored with the image file, so where 
the image goes, the metadata goes 
too. By inserting your copyright and 

Project three    Digital DarkrOOM

George Cairns shows you how to protect your images by assigning your 
copyright and adding your contact details to every picture’s metadata

Protect yourself

teAch 
YourselF 

liGhtroom
PArt 3

to watch the video use this web link… bit.ly/NPhoto44

http://www.bit.ly/NPhoto44
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01 Filter using metadata
In the Library module, click a thumbnail. In the 
right-hand panel, toggle open the Metadata tab. 
Here you’ll see information such as the Capture 
Date. If you click the arrow to the right of the ISO 
Speed Rating you can display all the other 
photos captured using the same setting.

02 Copyright – YOU!
Details such as ISO Speed Rating can’t be altered, 
but there are blank fields that you can type in to 
add to the metadata. Type your name into the 
Copyright field. Set the Copyright Status menu 
to Copyrighted (or Public Domain, if you want 
anyone to be able to use the photo at will).

03 include contact details
To add detailed information, click the Default 
drop-down menu to the left of the Metadata 
panel’s label and choose IPTC. This gives you 
more text fields to edit, so you can add your 
email address and website details. This will help 
others contact you if they wish to use your image.

05 assign multiple presets
Hold down Shift and click to select multiple 
thumbnails in Lightroom’s Grid view. Go to the 
Preset drop-down menu on the Metadata tab  
and choose the custom preset you created in  
the previous step. Any details you included will 
be added to the selected photos.

04 Create a preset
To speed things up, click the Metadata panel’s 
Preset drop-down menu and choose Edit Preset. 
Edit the fields, then choose Save Current 
Settings as New Preset from the Edit Metadata 
Preset window’s drop-down menu. Click Done. 
Click Save As. Name the Preset. Click Create.

06 assign presets on import
You can assign your copyright details to every 
photo as you import it. Click Import and browse 
to the folder or memory card that you want to 
import. In the Apply During Import Panel, open 
the Metadata drop-down menu and choose the 
desired custom preset. 

Add your name and copyright details to your photos
steP bY steP    the ’right stuff

contact details into this metadata, 
your photo is less likely to be used 
without your being credited.

Lightroom’s Metadata panel  
is designed to enable you to add 
important information such as who 
created a photo, and who owns the 
copyright. We’ll show you how to edit a 
photo’s metadata and then turn that 
information into a metadata preset, 
so that you can apply your copyright 
details to multiple photos with a few 
clicks. We’ll also show you how to 
quickly apply presets to multiple 
photos as you import them, which is a 
huge time-saving step in your picture 
processing workflow.  
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stack ’em up!

Next issue… 
Get closer to subjects 
with extension tubes

the missioN
To use multiple filters 
for creative effect 

time Needed
■ One to two hours

skill level 
■ Anyone can do it 
■ Some tricky aspects 
■ Advanced technique

kit Needed
■ Nikon D-SLR  
■ Tripod ■ Filter holder 
■ ND grad filter(s) 
■ ND filter(s)

Screw-in filters are all very 
well, but they’re limited to  

a single change or effect. Using  
a slide-in filter system enables you  
to stack multiple filters, so you can 
balance bright skies, blur moving 
water or clouds, and even polarise 
reflections, all at the same time. 

When shooting early or late in the 
day, you’re often presented with a sky 

that is much brighter than the main, 
foreground landscape. This is where 
an graduated ND filter comes in: dark 
at the top and clear at the bottom, it 
darkens bright skies without affecting 
the exposure of the landscape below 
–and because you can slide them up 
and down, you can decide where to 
place the transition from dark to  
clear (see Step by Step below). 

A full ND filter, meanwhile, darkens 
the whole image. To ensure a correct 
exposure, you need to set a slower 
shutter speed, which effectively 
enables you to blur moving water, 
clouds and more, even on bright days. 

Using both sorts of filters at the 
same time might sound complicated, 
but you just have to do things in the 
right order. Here’s how it’s done... 

03 The first filter
Next, slide your weakest grad into the slot that’s 
nearest the lens, with the dark end at the top, and 
slide it down until the transition from dark to clear 
just kisses the horizon – if it’s too high or too low it 
will be obvious in the final image. Take a test shot 
and check your histogram.    

06 The right time
Because NDs are very dark, make sure you’re 
happy with your composition before adding one. 
With the filter attached, increase the exposure 
time the correct number of stops (see top right), 
take a test shot, and adjust again if needed.

02 Stay grounded
As you’ll be using an ND grad to balance out the 
sky, you can set your exposure for the ground. 
Put your camera in manual mode, select an 
aperture of f/22 and an ISO of 100, and then 
adjust the shutter speed until the exposure 
needle lines up with the ‘0’.

05 …Three’s a wow
Once the ND grads have ensured a balanced 
exposure, it’s time to add a full ND to enable a 
longer shutter speed. A one-stop ND will enable 
you to double the exposure time, a two-stop ND 
will enable you to double it again, and so on. 

01 Find your sea legs
As you’ll be using a slow shutter speed, you’ll 
need a tripod and a remote release. Screw in a 
filter adapter, then attach the filter holder. If 
you’re using a wide-angle lens, there’s a chance 
you’ll catch the edge of the adapter in your shot. 
Either zoom past it, or crop the image in editing.

04 Two’s company…
If the graph fits nicely within the histogram you 
won’t need to attach a second ND grad, but if it’s 
stacked towards the right-hand side, you’ll need a 
second filter to darken the sky even further, until 
the graph isn’t cut off or ‘clipped’ on the right. 

Use one filter to balance the exposure, and another to enable a long exposure
steP BY steP    The more, the merrier

Project four    Gear SkillS

Matt Tuffin reveals the secret to better beach shots: layer multiple filters

To watch the video use this web link… bit.ly/NPhoto44

http://www.bit.ly/NPhoto44
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WhaT iS a SToP?
■ A lot of references are 
made to ‘stops’ with ND 
grads and NDs. A ‘stop’ 
equates to a change in either 
the shutter speed, aperture 
or ISO, and  denotes halving 
or doubling of light levels. If 
you halve the shutter speed 
(going from 1/60 to 1/30 sec, 
for example), that equates 
to a stop. Most D-SLRs will 
allow smaller increments, 
so you may need to move 
the dial two or three ‘clicks’ 
before achieving a full stop. 

Quick tip 
Rather than 
buying multiple 
adapters for 
your filter 
holder, use a 
stepping ring to 
save time. 
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Have a heart

Next issue… 
Mirror magic for  
location portraits

tHe missioN
■ Capture customised 
catchlights in your 
subject’s eyes

time Needed 
■ 30 minutes

skill level
■ Anyone can do it 
■ Some tricky aspects 
■ Advanced technique

kit Needed
■ Wire coathanger
■ LED fairy lights
■ Sticky tape
■ Macro or zoom lens

It’s often said that eyes are the 
most important feature in a 

portrait. Whenever you’re shooting 
portraits, you should always be 
looking for ways to draw attention  
to them. One way we can do this is by 
making sure they have catchlights. 
These are the tiny reflected highlights 
we see in a person’s eyes. They may be 
small, but these little sparks draw the 
viewer in and bring the subject to life, 
which is why you’ll see catchlights in 
almost every good portrait. 

Catchlights are, of course, created 
by the surrounding lights. This could 

be anything that emits or reflects 
strong light, like a lamp, a window, a 
flash, or the sun. 

If you want to learn about portrait 
lighting, catchlights can tell you a lot. 
Look closely at any good portrait and 
from the position and shape of the 
catchlights you’ll be able to determine 
the number of lights used, their shape, 
where they were placed, and whether 
they were large or small. Most of the 
time catchlights will be square or 
circular, as these are the shapes of 
most light sources, but you can make 
much more creative catchlights if you 

like, simply by changing the shape of 
the light source.

Here’s a fun project to try out at 
home. Use fairy lights to shape your 
catchlights. (Fun fact: this technique 
was used to create the multiple 
catchlights in Galadriel’s eyes in the 
Lord of the Rings films.) All you need 
are a few LED fairy lights, an old wire 
coathanger, and a macro or zoom lens 
that allows for close-ups. By shaping 
the wire and attaching your LED lights 
you can customise the reflected 
specks of light to your own design, and 
add extra sparkle to your portraits.   

Project five    Take iT furTher

James Paterson reveals how to create custom-shaped catchlights

To watch the video use this web link… bit.ly/NPhoto44

http://www.bit.ly/NPhoto44
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01 Bend it, shape it…
Bend a piece of wire or an old metal coat hanger into the 
shape you want your catchlight to be. (Coathangers are 
ideal as they have ready-made handles.) Try to keep the 
shape simple, as if it’s too complex it’ll be difficult to  
make out when reflected as a tiny catchlight.

02 attach the lights
Double the fairy lights up a few times, then run them along 
the shape. Use sticky tape to attach the lights to the metal 
frame. Make sure the lights are LEDs, as they won’t heat up 
like old-fashioned fairy lights. And, of course, be careful 
when using electrical wiring.

03 See for yourself
Turn on the LED lights to see how they look. You can judge 
the effect by holding it up to your face and using your 
phone’s frontal ‘selfie’ camera to see how it’s reflected in 
your eye. If the LEDs are looking too scattered, tuck them  
in tighter for a more a clearly defined shape. 

05 hey! Look at this!
Bring the lights in close to your subject and experiment by 
moving them around to see how different positions affect 
the shape and clarity of the catchlight in the subject’s eye. 
You could also try including the lights in the corner of the 
frame to add a few bright spots of bokeh.

04 aim high
The light from the LEDs won’t be very strong, so you may 
need to use a high ISO. One simple way to do this is to use 
manual mode, set a wide aperture (in this case f/3.3) and a 
fast shutter speed of at least 1/100 sec. Then set Auto ISO. 
This way, the ISO varies depending on the light.

06 Capture the sparkle
When working at close quarters depth of field becomes 
very limited (even at narrow apertures). Because of this, 
precise focusing is critical, and even more so when your 
subject is moving. Select a focus point over the closest  
eye and make sure the lashes are sharp.

Take time to prepare your catchlight before getting your subject involved

MixiNg CoLour 
TeMPeraTureS
■ The light from LEDs is a 
similar colour temperature 
to tungsten bulbs. If you’re 
concerned about choosing 
the correct white balance, 
shoot in RAW so you have 
more control over fixing 
colour casts in post-
production. You can get 
creative by mixing colour 
temperatures. Here, the light 
from a window has given the 
background a blue colour that 
contrasts with the subject.

steP BY steP    add a lighthearted touch

Quick tip  
Lighting a face from above is 
the most natural angle even when the subjec t is 
lying down, so 
posi tion the light above eye level



NikoN skills Ingenious recipes for creative shots

54 April 2015

Create a comic book hero

Next issue… 
Discover a different 
way to use HDR…

 In this walkthrough you’ll learn how to use the Filter Gallery 
to apply filters in layers, so that you can build up a more 
convincing and unique-looking art effect 

the missioN
■ Turn friends or  
family into comic  
book characters

time Needed 
■ 15 minutes

skill level
■ Anyone can do it 
■ Some tricky aspects 
■ Advanced technique

kit Needed
■ Photoshop CC or CS

One way to create an 
eye-catching image is to give 

a photograph a stylised artistic 
makeover. A portrait shot against a 
plain background is perfect for this.  
By using Photoshop’s filters you can 
simplify the colours and tones in the 
picture to make them look as though 
they were drawn and inked by a comic 
book artist. 

This technique, which is essentially 
done using filters, is an effective way 
to produce things such as creative 
profile pictures to represent you on 

social media sites, or even a 
personalised birthday card design.

You need to put a bit of effort in with 
filters in order to produce convincing 
results. If you simply slap a single 
filter such as Cutout onto a photo it 
will make the shot look obviously 
filtered, and your work will look like 
anyone else’s. In this walkthrough 
you’ll learn how to use the Filter 
Gallery to apply filters in layers,  
so that you can build up a more 
convincing and unique-looking art 
effect. For a comic book look, that 

means using simple washes of colour 
and pen-like outlines around key facial 
areas. We’ll show you how to mix a 
filtered layer’s colours and tones with 
other layers using blending modes, to 
help create a more artistic look. We’ll 
also use filters to mimic the tiny 
coloured dots (known as Ben-Day 
dots) that created the washes of 
colour in classic comic books or 
posters. This helps give your  
filtered photo that pop art look.

In this tutorial, you’ll also learn how 
to apply filters to your images in a 
non-destructive way by using Smart 
Filters. These allow you to tweak the 
settings of any filter at any time, and 
enable you to fine-tune the look that 
these filters produce.  

ProjeCt six    cReatIve pHotosHop

George Cairns explains how to use Smart Filters to give a portrait shot some pop art punch

BEFORE

AFTER

to watch the video use this web link… bit.ly/Nphoto44

http://www.bit.ly/NPhoto44
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01 smoothly does it
Open comic_start.jpg. Click on the Background layer. Pick 
Layer>Duplicate Layer. Click OK. Go to Filter>Convert for 
Smart Filters. Click OK. Go to Filter>Noise>Median. Set 
Radius to 2. Click OK. Go to Filter>Blur>Surface Blur. Set 
Radius to 23 and Threshold to 15 to smooth the skin. Click OK.

02 switch to paint
Go to Filter>Filter Gallery. Click on Paint Daubs. Set Brush 
Size to 8 and Sharpness to 3. Set Brush Type to Simple. Click 
the New effect layer icon at the bottom-right. Click the 
Accented Edges thumbnail. Set Edge Width to 3. Drop Edge 
Brightness to 14. Push Smoothness up to 15. Click OK.

03 stamp it out
Click on the Background Copy thumbnail at the top of the 
Layers panel to target it. Press Shift+Cmd+Alt+E (or Shift+ 
Ctrl+Alt+E on a PC). This Stamp Visible command creates a 
flat layer (Layer 1) with the combined look of all the layers 
and filters below. Go to Filter>Convert for Smart Filters.

05 Make things simple
Click on the New effect layer icon. Click on the Diffuse Glow 
thumbnail. Set the Graininess slider to 0, Glow Amount to 5 
and Clear Amount to 19. Click again on the New effect layer 
icon. Click on the Cutout filter’s thumbnail. Set Number of 
Levels to 4, Edge Simplicity to 3 and Fidelity to 1. Click OK.

04 Focus on the edges
Go to Filter>Filter Gallery. Click on the Accented Edges 
effect layer, then on the Trashcan to delete it. Click on the 
Paint Daubs effect layer and replace it by clicking on the 
Poster Edges thumbnail. Set Edge Thickness to 2, Edge 
Intensity to 2, and Posterization to 5 to add edge lines.

06 Rearrange the filters 
Pick Filter>Blur>Surface Blur. Set Radius to 8 and Threshold 
to 13 to create a simplified version of the subject’s features. 
Click OK. Drag the Surface Blur label below the Filter 
Gallery label to create a smoother version of the original 
photo. It also blurs out many of the finer illustration lines.

Use Smart Filters and layers to create a unique comic book look

sMaRt objects
■ When you use the Convert 
or Smart Filters command 
to turn a layer into a Smart 
Object, Photoshop creates 
a hidden copy of the original 
layer, so you can access its 
unfiltered look at any time. 
You can turn specific filters 
on and off when working 
with a Smart Object layer by 
clicking the appropriate filter 
label’s eye-shaped icon in the 
Layers panel.

steP BY steP    Marvel at this

Quick tip  
To adjust any 
of your Smart 
Filter set tings, 
double-click 
on the filter’s 
label below the 
white Smart 
Filter layer in 
the Layers panel. 
Click on the 
Filter Gallery 
label to edi t 
filters such as 
Paint Daubs 
or Accented 
Edges. You can 
also adjust the 
set tings of non 
Filter Gallery 
filters

To download the start images for this tutorial, visit bit.ly/start-44

http://www.bit.ly/start-44
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07 perfect blend
Most Photoshop users will recognise the handiwork of the 
Cutout filter so, to blend this filtered layer with the filters 
on the lower layer, set Layer 1’s blending mode to Color 
Dodge. For a more subtle blend, set Layer 1’s Opacity slider 
to 49. Now the Cutout effect blends more subtly with the 
other filters, creating a more illustrated look.

08 Go dotty
Click on Layer 1. Perform the Stamp Visible command. Go 
to Filter>Filter Gallery. Choose Halftone Pattern, and set 
the Pattern Type to Dot. Set Size to 4 and Contrast to 17. 
Click OK. To combine the dots you’ve just made with the 
colours from the layer below, set Layer 2’s blending mode 
to Overlay. Set Opacity to 71%.

09 just add watercolour
Go to Layer>New>Layer. Click OK. Drag transparent Layer 
3 below the ink dot layer (Layer 2). Grab the Brush tool. In 
the Brush Preset picker, choose the Water Color Light 
Opacity tip. Set Opacity to 45. Set Size to 400. Spray a blue 
foreground colour onto the white background. The colours 
will be stronger where the strokes overlap.

10 He speaks!
Select the Custom Shape tool. Select the speech bubble 
from the Custom Shape picker. Set the Fill option to white. 
Set Stroke to black. Set Stroke Width to 90. Set font size to 
41. Draw a speech bubble. Create a new layer. Select the 
Horizontal Type tool. Choose the Lithos Pro Regular font. 
Type some text to personalise your comic book image.

tweak tHe text
■ Your speech bubble’s font 
size will vary depending on 
the size and resolution of 
your photograph. Double-
click on the text layer to 
select the text. As well as 
increasing the size of the font 
in points you can click on the 
Character Panel icon in the 
Options bar. This opens the 
Character panel. Here you 
can adjust the values in the 
Vertically and Horizontally 
scale boxes to enlarge the 
text so that it fits nicely 
inside the bubble.

keY skill    stroke a path
Make the bubble look hand-drawn 
with an edge that varies in width

To start off, add a new transparent layer 
to the top of the stack. Select the Brush 

tool, and choose a Round Point Stiff Bristle 
brush tip. Set Size to 50. Set the foreground 
colour to black. Click on the Shape 1 layer. Click 
on the Paths panel. Double-click on the Shape 1 
Shape Path thumbnail. Click OK in the Save Path 
window to create a copy. Click back on the 
Layers panel. Click to target the new 
transparent layer. Click back on the Paths panel. 
Right-click on the Shape 1 Shape Path copy and 
choose Stroke Path. Set the Tool dropdown to 
Brush. Tick Simulate Pressure. Finally, click OK.
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stack for impact

Next issue… 
Learn how to shoot and 
process a stunning  
day-to-night panorama

the missioN
■ To shoot a sequence 
of landscape images, 
then combine them 
into a single frame

time Needed
■ Two hours

skill level
■ Anyone can do it 
■ Some tricky aspects 
■ Advanced technique

kit Needed
■ Nikon D-SLR
■ Tripod
■ Photoshop  
CS5 or above

Imagine capturing a 
succession of passing 

moments within a single frame. 
Well, in this month’s Big Project we 
show you how to do just that, by 
creating an amazing ‘time stack’.

To do this we set up our camera just 
as we would for a time-lapse, so that it 
captured frames at regular intervals 
to record the movement of clouds. 
Typically a sequence like this would 
then be combined into a time-lapse 
video showing, say, the rising sun in  
a matter of seconds. But rather than  
do the usual thing, we’re going to try 
something a little bit different.

Taking inspiration from the great 
photography of time stack maestro 
Matt Molloy, we’re going to combine 
the lightest parts of our sequence of 
images into one incredible frame. It’s 
exactly the same method you would 
use to combine night-time star trail 
images, but when used on a sunset or 
sunrise instead it produces a painterly 

effect that, while unpredictable, can 
be very eye-catching.

We’ll start by showing you which 
camera settings and kit you need to 
shoot a time stack (or indeed a more 
conventional time-lapse). Once you’ve 
captured the sequence, we’ll then look 
at how to combine the lightest parts 
in Photoshop CS or CC using the 
Lighten Blend Mode. 

With hundreds of shots to process, 
combining them manually would be a 
real chore, so to speed things up we’ll 
write an Action to automate the task. 
If you’d rather skip this, we’ve provided 
the finished Action among the project 
files, ready to try out on your own 
image sequence (it also works for 
blending star trail shots). But making 
Actions is a useful skill that comes in 
handy any time you want to speed up 
monotonous tasks. It’s easier than you 
might think and, once an action is set 
up, you can kick back while Photoshop 
does all the hard work for you.  

Project seveN    THE BIG PROJECT

James Paterson reveals how to shoot a series of images and combine 

To watch the video use this web link… bit.ly/NPhoto44

http://www.bit.ly/NPhoto44
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http://www.bit.ly/start-44
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ON LOCaTION    Get set up to stack
You don’t need much specialist equipment – the important thing is that your camera stays completely still

03  Shady business
We wanted a correct exposure  
for the moving clouds with the 
foreground in shadow, so dialled 
in a stop or so of under-exposure 
using exposure compensation.

02  Lock, stack and barrel
Focus on your subject, and then 
switch the lens to Manual Focus 
to lock it in place. That way you 
can be sure the same areas will  
be sharp in every shot.

01  Keep it steady
Set your camera up on a sturdy 
tripod. Once the sequence has 
begun, be sure not to nudge  
your camera or tripod as any 
movement will spoil things.

04  Break it up
Add interest to your composition 
by including a subject that breaks 
up the horizon, like our old diving 
board. Bodies of water work well, 
reflecting the clouds and colours.

April 2015

Set aperture-priority mode
When shooting a sequence in conditions where the light levels will increase 
as the sky brightens, use aperture-priority mode. This way, the shutter speed 
will adjust as the sequence is shot, while depth of field will stay constant. 
Choose a fairly narrow aperture for good depth of field. (We used f/11.)

Start interval shooting
Most Nikon D-SLRs feature intervalometers that enable you to set up for a 
time-lapse sequence in the Shooting menu. Set the interval between shots 
to around five seconds and choose a high number of shots so the sequence 
will last long enough. Ensure you have enough space on your memory card.

01

02

03

04

iN cAmerA    Settings for the sequence
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HOw TO makE  
a TImE LaPSE
■ We’re making a time stack 
here, but seeing as you’ve got 
the images for a time-lapse 
sequence, why not see how 
they look as a moving video 
too? To do this, simply go to 
File>Open, select the first 
image in your sequence, then 
check the ‘Image Sequence’ 
box at the bottom of the 
Open dialog. Hit Open and 
choose a frame rate such  
as 30fps, then go to the 
Timeline Panel (Window> 
Timeline, CS5 extended or 
above) and hit the play 
button. The sequence will 
render slowly. Once it’s done, 
hit play again to view it full 
speed, then go to File> 
Export>Render video to 
export it in a video format.

01 action stations!
First we’ll record an action, then we’ll automate it within a 
second action so that it runs on a folder of images. Open the 
Actions Panel (Window>Actions) and click the flyout menu 
at the top-right. Make sure ‘Button Mode’ is unticked, then 
choose New Set. Name it Timestack and hit OK.

03 Take shortcuts
When recording actions, it’s usually best to use menus and 
keyboard shortcuts whenever possible, so every command 
remains universal. Press Cmd/Ctrl+A to Select All, then 
Cmd/Ctrl+Shift+ ~ (tilde key) to switch to the previous 
document. Hit Cmd/Ctrl+V to paste the layer in.

02 Start recording
Open the first two images in your sequence, then click the 
New Action icon at the bottom of the Actions Panel. Name 
the action ‘Copy and Close’, then hit Record. From now on, 
everything you do will be recorded in the action, but you can 
hit Stop at any time to pause it, and Record to continue.

04 Lighten up
Go to Layer>Layer Style>Blending Options and set Mode: 
Lighten. Next go to Layer>Merge down to combine the 
layers into one. Press Cmd/Ctrl+ ~ to switch back over to 
the other document and go to File>Close. Click the Stop 
button in the Actions panel to stop recording.

Once you’ve got your photos, it’s time to merge them in the digital darkroom
steP BY steP    Stack ’em high and blend ’em fast! 

05 Test it first
To check the action is working, open another image, click on 
the action and press play, then close the document. Next 
we’ll create a second action to automate the task. We’ll use 
a dummy set of images to test it, so just copy 10 random 
images from your sequence into a separate folder.

06 Take more action
Click the New Action icon again. Call it ‘Timestack Lighten’ 
and hit Record. Go to File>Open and open the first image 
in your sequence. We need to make a fresh copy, so go to 
Image>Duplicate and hit OK. Next press Cmd/Ctrl+Shift+ ~ 
to switch back to the first document and go to File>Close.

Quick tip  
If you’d prefer 
not to make 
the ac tion from 
scra tch, we’ve 
supplied i t along 
with the projec t 
files. To install i t, 
simply drag and 
drop timestack.
a tn into the 
open Photoshop 
workspace
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07 automate it
Go to File>Automate>Batch. Choose Set: Timestack, 
Action: Copy and Close, Destination: Save and Close.  
Next, set Source: Folder then click the Choose button and 
navigate to your folder of 10 random test images. Hit OK  
to automate the action and watch as Photoshop copies, 
pastes and blends the layers for you.

09 add a reminder
You can also add reminders or ‘stops’, for future reference. 
Highlight the Open step, then click the Action Panel’s flyout 
menu and pick Insert Stop. Type ‘Open the first image in the 
series’, check ‘Allow Continue’ then hit OK. Drag the Stop 
step above the Open step. It will then remind you to open 
the first image the next time you want to use the action.

08 Build in pauses
Press the Stop button to stop recording. To make sure the 
action will work on other images in the future, take a look at 
the Timestack Lighten action and you’ll see square boxes to 
the left of each step. Highlight the boxes next to ‘Open’ and 
‘Batch’. Now the action will pause at these points, allowing 
you to specify the correct start image or source folder.

10 Run the action
Now the action is ready to be used on your proper, complete 
set of photographs. Highlight the set then click the flyout 
and choose Save Set. Close any open images, then highlight 
the Timestack action and hit Play. Choose the first image 
and specify the source folder with your full sequence of 
shots in, then sit back and watch the action run.

11 Try different options
The effect might work first time, or you may need to 
experiment by using every other frame. To do so, expand 
your grid in Bridge, then hold Cmd/Ctrl and drag down 
columns to select alternate rows. Copy and Paste the 
selected files into a new folder, then run the action again.

12 keep experimenting
We’ve used every sixth shot, then combined two versions 
(one for the sky, one for the water) using a Layer Mask. We 
used the Camera Raw filter to boost the tones. If you need to 
remove jet trails, make a new layer, grab the Spot Healing 
Brush, check Sample All Layers, and paint to remove.

TRy DaRkEN 
INSTEaD
■ If you want a different 
effect, you could try 
blending the frames using 
the Darken Blend Mode 
rather than Lighten. You 
needn’t make a new action 
from scratch for this. 
Instead, simply make a 
duplicate of the existing 
‘Copy and Paste’ action and 
replace the step where the 
Lighten Blend Mode is used. 
To do this, drag the step to 
the trash then hit record 
and record the process of 
changing a layer’s Blend 
Mode to Darken. 

Quick tip  
The blending 
ac tion doesn’t just 
work wonders on 
skies, i t can also 
be used to merge 
shots of long-
exposure traffic 
trails, crea ting  
a vibrant mix  
of neon lines  
and shapes
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MissiON To capture 
Florida’s amazing 
birds and wildlife

PHOTOgrAPHer Daniel Moll
Age 36 LOcATiON Florida, USA 
KiT Nikon D300, Nikon 
D7000, Nikon AF 300mm 
f/4, Nikon 70-300mm 
f/4.5-5.6 VR, Nikon 
55-200mm f/4.5-5.6, 
Nikon 18-55mm f/3.5-5.6
WeB www.danielmolls 
photography.com

project info

The birds and the beasts
Living in Florida, Daniel Moll is surrounded by hundreds  
of species of exotic birds, and plenty of land-based wildlife too

been inspired to get out and 
capture the myriad photographic 
opportunities in my new 
environment. Located in the 
historic district of America’s 
oldest city, we are surrounded  
by abundant wildlife, forts, 
landscapes, beautiful beaches, 
and – my personal favourites – 
birds. Florida has hundreds of 
native species of birds, ranging 
from small sandpipers to the 
majestic bald eagle, to which 
you can add the many species 
that migrate from the north to 
our state, where the weather is 
so much warmer.

My portfolio includes a big 
variety of subjects, but taking 
pictures of birds is my passion. 

Growing up in 
Pennsylvania, I  

started learning the art of 
photography from my father 
using a Nikon N6006 film 
camera. It was instilled in me 
early on to use manual mode to 
help me be more creative with 
my photography, and although 
the new Nikon bodies take great 
pictures in auto and program 
mode, I still shoot in manual 
mode 99 per cent of the time.  
To be a good photographer you 
need to learn everything you 
can about your equipment, and 
you never stop benefitting from 
the input of others. 

I moved to St Augustine in 
Florida four years ago, and I’ve 

01 PeLicAN crOssiNg
Nikon D300, Nikon AF 
300mm f/4, 1/1600 sec, 
f/7.1, ISO200

http://www.danielmollsphotography.com
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stalking birds of prey
• Be pa tien t, and know 
your environmen t 
• A monopod is hugely 
helpful wi th long glass
• Use con tinuous AF  
for moving subjec ts

03 reTUrNiNg HOMe
Nikon D300, Nikon AF 300mm f/4, 

1/1600 sec, f/5, ISO250

Although there are plenty of 
species to choose from, the 
majority of my time is spent 
capturing the osprey [3], a bird 
of abundant grace and character. 
I’m captivated by the beauty of 
these birds as they gather for 
their daily fishing expedition, 
and about three hours before 
low tide I love to watch them 
hovering over an inlet close to 
where I live, waiting for the 
perfect fish to hunt. They start 
their dive with their talons fully 
extended, before plunging deep 
into the water to catch their 
prey, and it can be comical to 
watch them fly away hauling 
fish almost as big as they are!

Mid-flight fights
I visit numerous nests to observe 
and photograph the adults 
returning with the catch of the 
day to feed their chicks. It’s 
always a huge thrill to see the 
babies growing, learning how to 
fly and preparing to venture out 
on their own. Several times I’ve 
marvelled as an eagle has 

attacked an osprey in mid-flight 
to steal its fish; when this 
happens, the osprey just goes 
back and catches another one.

Given the abundance of other 
wildlife in this area, I’ll also 
occasionally photograph deer, 
wild pigs, alligators, manatee 
and bobcats, to mention just a 
few – I love being surrounded by 
the sound of alligators bellowing 
early in the morning. 

I’ve always shot with Nikon 
equipment. My first digital 
camera was a Nikon D70 and 

it’s always a huge thrill to see the baby 
ospreys growing, learning how to fly and 

preparing to venture out on their own  

I’ve gone through a couple of 
other models, working up to 
what I mainly use today, the 
D300 and the D7000. Most  
of my shots are taken with my 
Nikon 300mm f/4, but I’ll also 
use my 70-300mm, 55-200mm 
and 18-55mm Nikon lenses.

St. Augustine has been voted 
one of the top 10 locations in the 

world for photography, and 
while I can’t speak for anyone 
else, I can definitely say it’s 
become number one on my list. 
It’s a bird-lover’s paradise, and a 
photographer’s paradise too! 

P aul’s 
 top t ips…

02 BrANcH LiNe
Nikon D300, Nikon AF 300mm f/4, 
1/1600 sec, f/8, ISO400
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A letter from Palouse
Claude Robidoux embarked on an eight-hour drive from his 
home in Canada to photograph this spectacular US region

the butte all the way to the top, 
with a few places to pull over 
along the way, and a large 
parking lot right at the top.  
From here I was rewarded  
with spectacular views of the 
surrounding hills as far as the 
eyes could see. Dotted around 
the landscape are a few farms, 
houses, trees and roads, and 
farm machinery on the move.

I had read that the ‘golden 
hour’ was the best time to 
photograph the hills on a sunny 
day, and having driven all day I 

can’t free myself very often, but 
last August I finally took the 
plunge and made the trip.

The Palouse is located in 
south-east Washington State 
and parts of Idaho, and what 
makes it so attractive to 
photographers is the Steptoe 
Butte State Park. Driving 
through the park’s rolling hills  
I was already in awe of the 
landscape, and my excitement 
intensified when I started up  
the big hill that is Steptoe Butte 
itself. There’s a road that circles 

A few years ago I heard 
of the Palouse through a 

photographer I had met in a 
gallery. I had no idea what or 
where it was, so when I got 
home I researched it on the 
internet, and after looking 
online at images of the region 
other photographers had taken, 
and knew I had to go there.

The Palouse is roughly an 
eight-hour drive from my town, 
and being a father of two young 
daughters and working on the 
railroads away from home I 

01 HArvesT sUN
Nikon D610, Nikon AF-S 70-200mm f/2.8, 

1/15 sec, f/8, ISO100

project info
MissiON To documen t 
the spec tacular 
rolling hills of 

America’s Palouse region
PHOTOgrAPHer 
Claude Robidoux
Age 40 LOcATiON Bri tish 
Columbia, Canada
KiT Nikon D610, Nikon 
14-24mm f/2.8, Nikon 
50mm f/1.8G, Nikon 
70-200mm f/2.8 VR II, 
Nikon TC-17E, Nikon 
SB-910, Nikon SB-700
WeB www.robidoux.
photography

http://www.robidoux.photography
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arrived a couple hours before 
sunset, so my timing was 
perfect. After pausing to take in 
the view and work out where 
the sun was going to go down,  
I set up my tripod and started 
composing images in the 
viewfinder so that I’d be ready 
when the moment was right. 
The lower the sun, the longer 
the shadows on the landscape, 
which creates an eye-catching 
three-dimensional effect.

The only lens I used was my 
Nikon 70-200mm f/2.8, which  
is wonderfully versatile: at the 
short end it was perfect for wide 
compositions that included the 
sky, while if I zoomed in I could 
isolate parts of the landscape 
and focus more on leading lines, 
shapes and shadows.

The Palouse changes 
throughout the seasons, and in 
August they harvest the wheat, 
which gives much of the 
landscape a light brownish 
colour. At first I was a bit 
disappointed, because in many 
of the images I’d seen, the hills 
were mostly green, but the 
opportunity to photograph  
the harvest made for some 
interesting shots.

I took as many shots as I 
could before the sun finally 

Palouse has become so popular 
with photographers that the 
Chamber of Commerce in 
Pullman, the area’s largest town, 
has produced a ‘Photography 
Hot Spots of the Palouse’ map, 
which shows you where to find 
old barns, red barns, lone trees, 
abandoned houses, windmills 
and good viewpoints. I didn’t 
have time to visit all the little 
towns, but I did stop at Palouse 
town, where I photographed 
some colourful cafes and stores.

I enjoyed my trip so much 
that I’m planning another one  
in the spring. According to the 
locals it’s the best time to visit in 
order to capture the hills when 
they’re green, while others are 
yellow from the canola, a sort of 
rapeseed. The weather in spring 
is less predictable, and it rains 
more often – but that will just 
make for more dramatic and 
interesting images! w

03 sTArK LiNes FOr MiLes
Nikon D610, Nikon AF-S 70-200mm 

f/2.8, 1/25 sec, f/8, ISO200

sunrise to sunset
• Research when sunrise 
and sunse t are going to 
happen, and whether the 
weather’s due to be clear
• Use a circular polariser
to cu t through haze and
deepen blue skies
• Use a tripod wi th a 
spiri t level to keep your 
images straigh t – wonky
horizons ruin shots!

P aul’s 
 top t ips…

disappeared, trying different 
compositions. And as I always 
do after sunset, when everybody 
packs their gear and leaves, I 
stay to observe the changing 
colours in the sky. The sky 
became a deep blue and the 
clouds turned pink, and these 
colours complemented the 
brownish hills below.

Time to explore 
That night I found a hotel in 
Colfax, a town located less than 
30 minutes drive from Steptoe 
Butte. The next morning I was 
up at 4am to make sure I would 
be on time to capture images at 
sunrise. On account of the 
harvest it was very hazy and 
dusty, which isn’t usually a good 
thing in landscape photography, 
but here it allowed me to shoot 
directly into the sun without 
capturing any flare as it rose 
over the rolling hills, looking 
like a giant yellow ball [1].

Steptoe Butte isn’t the only 
great location in the Palouse, 
and after trying different 
compositions for about an hour 
after sunrise, it was time to 
explore the countless gravel 
roads in search of barns, lone 
trees, and anything else the 
farmland had to offer. The 

The lower the sun, the longer the  
shadows on the landscape, which creates 

an eye-catching three-dimensional effect  

02 NOT OF THis WOrLd?
Nikon D610, Nikon AF-S 70-200mm f/2.8, 

1/20 sec, f/8, ISO100
03 WiNdMiLLs iN THe disTANce

Nikon D610, Nikon AF-S 70-200mm f/2.8, 
1/60 sec, f/10, ISO100
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extreme photo school
Kevin MacAulay’s time in the Canadian military enabled him 
to hone his photography skills in challenging environments 

vastness of the North. We 
travelled by snowmobile along 
the west side of Ellesmere 
Island, living in tents on the ice.

I recorded our journey using  
a Nikon D300, which was a 
challenge in temperatures that 
fell as low as -55ºC. The trick 
was to make sure you didn’t 
keep your camera or lenses 
anywhere where condensation 
could form, but this was harder 

After being promoted to the 
rank of Sergeant in 2007 I was 
chosen to be part of a specialist 
photographic and video team 
known as Combat Camera. In 
April 2008 I went on a High 
Arctic sovereignty patrol with 
the Canadian Rangers called 
Operation Nunalivut, which  
is Inuit for ‘Our Land’. These 
patrols are undertaken to assert 
Canada’s sovereignty in the 

My interest in 
photography began  

in high school, when I was 
chosen to be a yearbook 
photographer. I joined the 
military, and in 1990 I began  
my photographic training at  
the Canadian Forces School  
of Aerospace Technology and 
Engineering as a Photographic 
Technician. My first issued 
35mm camera was the Nikon 
FM2. I loved that camera! As 
photography progressed into the 
digital era the military began to 
use the Kodak and Nikon DCS 
line of digital cameras.

The trick was to not keep your camera or 
lenses where condensation could form; just 

removing the lens cap could cause a lens to fog  

01 A POrTrAiT, OF sOrTs
Nikon D3, Nikon AF-S 24-70mm f/2.8G ED, 
1/400 sec, f/10, ISO250

project info
MissiON To take 
grea t photos of real 
people in real ligh t, 

in their environmen ts 
PHOTOgrAPHer Kevin 
MacAulay Age 44 
LOcATiON On tario, Canada
KiT Nikon D750, Nikon 
24-120mm f/4G VR, Nikon 
70-300mm f/4-5.6G VR, 
Nikon 50mm f/1.8D, Nikon 
SB-700 Speedligh t
WeB www.kaptured
memories.ca 

http://www.kapturedmemories.ca
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than you might think; just 
removing the lens cap and 
replacing it could cause a lens to 
fog with the heat of your hand. 
It is also a good place to learn 
about your camera’s metering 
system. You’re surrounded by 
snow, and your camera sees 
everything as mid-grey and 
delivers under-exposed shots, so 
you have to compensate for this.

I’ve always enjoyed 
photographing people wherever 
I was, capturing their emotions 
and their environment, and my 
passion now is available-light 
portraiture. I want to master 
natural light, and I’ve just 
upgraded from the D7000 to  
the D750, which has a great ISO 
range and is enabling me to 
capture images that exceed my 
expectations. I have loved my 
25-year photographic journey, 
and Nikon has been there with 
me the whole way. 

04 A FAce FrOM THe cOLd
Nikon D300, Nikon AF-S 70-300mm 

f/4-5.6G IF-ED VR, 1/250 sec, f/8, ISO200

03 FUNNeLLiNg iN THe cOLd
Nikon D300, Nikon AF-S DX 18-200mm 

f/3.5-5.6G ED VR II, 1/400 sec, f/10, ISO200

shooting in extreme 
low temperatures
• Choose a weather-
sealed body to preven t 
ice infiltra ting
• Keep the bat tery warm 
when not in the camera
• Take spare bat teries, 
as cold weather drains 
bat teries more quickly

03

04

02 HOMe BAse
Nikon D300, Nikon AF-S 

24-70mm f/2.8G ED, 
1/500 sec, f/11, ISO200

P aul’s 
 top t ips…
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Win a lexar memory card and reader!
Write ourStar Letter and you’llwin a 16GB600xSDHCUHS-Imemory card and
Dual-SlotUSB3.0 reader fromLexarProfessional! Seewww.lexar.com for details.

your letterS
We’d love to hear your thoughts on the mag and all things
photographic! So email us atmail@nphotomag.com

Since I live in Australia, I have
only just recieved my copy of
issue 40 and I was horrified at
the photo of the box jellyfish.
It’s a beautiful photo, but
given that the photographer
is from Spain and the photo
taken in South Africa, he can
probably be forgiven for not
knowing these creatures are
deadly. There are a number
of species of these jellyfish,
but those that inhabit many

beWare of the fiSh

tropical waters are extremely
dangerous. In anticipation of
visitors to Australia who tote
cameras, I’d like to say that
besides our more well-known
terrestrial nasties, they should
be aware that our rivers and
oceans also have sea snakes,
cone shells, stonefish, box
jellyfish, Portuguese man-
o-war, salt water crocodiles
and rays. When travellers are
visiting countries that are new

to them, please ensure that
homework is done before
travelling and taking images.
Dianne Tattersall, via email

Great advice Dianne. We
all chase the perfect shot,
and sometimes without
enough concern for our
own wellbeing. Take heed,
adventurous photogs, do
your homework and don’t
get stung!

SnoWdropS in bloom
On a recent visit to Hodsock
Priory near Worksop I had the
opportunity to take some photos
of the snowdrops in bloom. I
used my Nikon D3300 and a
Nikon 50mm f/1.4G lens to take
various shots from different
angles. Many out-of-focus shots
and muddy knees later, I finally
found one that seemed to work.
I hope you like my efforts; it’s

not as easy as it looks, taking
a picture!
David Williams, via email

Superb image, David, it was
clearly well worth the effort!

tripod trouble
I was a bit surprised that Project
4 in issue 42 didn’t mention
what has become a number
one tip for me, which is to get
a tripod that is matched to the
height of the shooter. One long
day of bending over to look
through the view finder and
your back will thank you.
Richard C Griffin, via email

You’re quite right, Richard,
not all tripods extend to eye
height, and it’s important to
get one that does. Our big test
of sturdy tripods (page 98) is a
good place to start!

We reserve the right to edit any queries for clarity or brevity. You can also write
to us at N-Photo Magazine, The Ambury, Bath, BA1 1UA, UK

Our image in issue 40
showed the beautiful,
but deadly, box jellyfish

■Keep your copies of N-Photo neat
and tidywith our bespoke binder. Each
stores a year’sworth of your favourite
photomagazine – and costs from£9.99!
Order yours today at…
www.myfavouritemagazines.co.uk/
n-photo-binder

http://www.myfavouritemagazines.co.uk/n-photo-binder
http://www.myfavouritemagazines.co.uk/n-photo-binder
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Weasked‘IfNikoncouldsupply
onemoreaccessoryinthebox
withyourcamera,whatwould
youchoose?’

AdecentrearLCDcover for theD4.
Bloodyannoyedafterspendingall
thatmoneyandgettingnocover
for theLCD!
MarkHaylett

Anextrabatterywouldbenice.
Memorycardsyoucanfindeven in
drugstores,butcamerabatteriesare

a no to video?
I’ve been reading N-Photo
from issue 1 and been a Nikon
user for 50 years. Fred Wells’
suggestion in the letters section
of issue 43 has prompted me
to send this email. I would not
like to see articles on the subject
of video in this magazine. I
feel that this subject requires a
totally different approach, and
presents the added difficulty of

sound! Jorge Camilo Valenzuela
makes this same point in his
interview in the same issue. I
feel that video requires a new
magazine, so please stick to
what this magazine does best;
still images.
Robert R Williams, via email

Point taken Robert. Anyone
agree or disagree with this?
We’re getting a lot of feedback
on the topic of video!

veryspecific.Lensareamatter
ofpersonalpreference,asare
protectivecases.
JonathanAraujo

Batterygrip.AllmyNikonshave
abatterygrip. I cannot imagine
shootingwithoutone.
IgorYudovich

I always justgetanextrabattery
andagripanyway,andthey’rereally
useful, sothatwouldbemychoice.
JonNadelberg

As I’mnotafirst timebuyer, Ihave
all thecards Ineed,andasNikonetc
seemtohaveadifferentbattery for
eachlevelofcamera, itwouldbea
brilliant Ideatohaveasparebattery
included inthebox.
KevinRPeden

Secondbatterydefinitely. Ibought
myD90andpowerpackandextra
batterieswouldhavebeenuseful.
NickAllen

Subscribe to our free newsletter at www.ColorConfidence.com for further information

Bring your
coloursto life

Visit us at The Photography Show – Stand F21 & F31

Europe’s leading colour management specialist and distributor into the digital imaging markets
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Capturing a statue or monument is, 
on the surface at least, extremely 

simple. The subject is static, outdoors and 
most are instantly recognisable. This ease 
can lead to simply snapping a sharp image 
without considering the environment, or 
how the light affects the shape and colour. 
Being able to move around and use the 
background can make a static object shine. 

Phil Cooke’s shot of a mirrored statue on 
Loch Earn at St Fillan’s, Perthshire, uses 
the beautiful surrounding landscape to 
emphasise the statue, showing technical 
skill and creativity. Catching the light at 

just the right point, and using the available 
colour to such an impressive degree, made 
this image stand out to both judges and 
voters alike. 

If you’d like to see what the judges and 
your fellow N-Photo readers have to say 
about your own images (and have a shot at 
winning a fantastic Manfrotto 3N1-25 PL 
Pro Lite Camera bag worth £200, pictured 
right), why not enter our latest competition 
online at www.photocrowd.com? The 
theme this time is ‘Nightlife’, and as always, 
the more creative the interpretation of the 
theme, the better – but do stay on-theme!

Enter today, and your photographs could be here next month…
competition winners

In order to enter 
the competition, 
or to vote for your 
favourite shots, you 
will need to register 
with Photocrowd. 
It’s easy to do via 
the website www.
photocrowd.com.  
Voting is randomised 
to ensure fairness – 
all images get some 
exposure, people 
don’t just look at the 
first 50 or so!

Mirrored Statue,  
St Fillans
A stunning image 
by Phil Cooke, full 
of technical craft 
and unique 
framing, alongside 
an eye-catching use 
of colour. There’s a 
mix of stillness and 
motion, activity and 
inactivity, and order 
and chaos that 
almost splits this 
image in half. 
We’ve seen plenty 
of other images of 
this particular 
statue, but this one 
used the natural 
surroundings in 
impressive fashion.

Crowd & JudgeS’ winner

thiS 
Month’S 
winnerS

competition

timeless
Using a slow shutter 
speed to capture 
crowd movement 
isn’t a new 
technique, but it 
does take time to 
perfect and make 
relevant to the 
surrounding area. 
This image 
represents a superb 
combination of 
motion and 
stillness, using the 
crowds that so 
many photographers 
try to avoid. The 
flapping flags and 
moving clouds help 
make the monument 
the focal point.

JudgeS’ 2nd plaCe
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want to appear here? Send A brief bio And four jpegS, with the Subject line ‘me & my nikon’, to mail@nphotomag.com

me & my nikon

nick’s  
top tip!

Care for your glass – use 
a UV filter to protect 

the front element  
of the lens 

A New Hope
Here, the storms have 
passed and calmer 

weather has arrived

we Are An IslaNd 
Coot chicks huddled on a 
submerged stone wai ting 

for their mum

Christmas Angel
I was experimen ting wi th 

my 50mm f/1.8 lens  
when I took this

grey squirrel
I used a high IsO se t ting in 

the local woodland to 
capture this image

I am fortunate to live in an area 
of South Wales that is steeped in 

industrial history and surrounded by 
natural beauty. The industrial heritage has 
been widely recorded, the natural history 
less so. The urge to record the beauty of 
South Wales inspires me to take pictures. 

Although I’d had Nikon film cameras 
in the past, my first taste of digital 
photography was with a Nikon Coolpix 
4100. I decided to move to a D3100 for 
the better quality of image that comes 
with a D-SLR, with my current camera 
being a Nikon D7100 [1]. 

My main lens is a Nikon 16-85mm 
f/3.5-5.6G ED [4] that can be used 
for landscapes and closer portrait work 
and produces excellent results. My main 
tripod is a Giottos Silk Road YTL9353 [2] 
with a Giottos MH7002 ball head and is very 
flexible, thanks to its pivoting central bracket. 
My favourite lens is the Nikon 60mm f/2.8G  
ED [3]. It can be used for portraits, but I 
mainly use it for macro shots. 

I’m finally on a journey that I’ve always 
wanted to start. My only problem now is 
dividing my weekends evenly between  
my camera and my wife!  

Fact FiLe
occupation Civil servan t
age 44 Location rhondda 
Cynon Taff, wales
cuRRent kit Nikon D7100
WeBSite www.flickr.com/
photos/furball1/

remember this…

nick Davies
The natural beauty of South Wales 
inspires the photographs Nick takes…

2

1

Nick’s portfolio

01 Carry a tripod – 
you’ll always need one 
when you haven’t got i t
02 Don’t be afraid to use 
high IsOs to ge t the shot 
03 Change your 
viewpoin t rather than 
relying on your zoom 
04 Know your subjec t. 
A li t tle research can 
make for a be t ter shot 
05 I f nothing inspires 
you, try going for 
abstrac t or macro shots

43
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Some people say 
processing, others say 

editing, and yet others say 
post-processing, but whatever 
terminology you use, this is 
essentially an activity that you 
carry out on RAW files. You can 
work on JPEGs and TIFFs in 
apparently similar ways, often with 
the same software tools, but only a 
RAW file has the depth of 
information that enables different 
interpretations of an image without 
any loss of image quality. 

As we saw in issue 40’s article on 
RAW vs JPEG, the captured image 
– whether you shoot in RAW or JPEG 
– has to undergo basic processing to 
deliver a viewable image. The 
difference is that if you shoot in 
RAW, you can do all this processing, 
and more, using software that’s 
more capable than the camera’s. 
Here we’ll show you the essential 
techniques for getting the most out 
of a RAW image file.

Creative control
RAW-processing software  
has benefited from lots of 
improvements over the last few 
years, and this will continue. These 
improvements have been in two 
main areas: the number of tools 
available, and the quality of the 
edited image. However, a lot of what 
goes on during this processing is 
concealed in various ways, not 

because software companies are 
trying to hide anything, but because 
it keeps things more user-friendly. 
Given the complexity of the 
computing involved this isn’t a bad 
idea, as most of us would rather get 
on with taking pictures, but it does 
cause some confusion. With so many 
sliders doing apparently similar 
things, which ones should you use, 
and in what order?

Probably the most widely used 
RAW processing software is Adobe 
Camera RAW, or ACR, which is used 
in both Lightroom and Photoshop, 
and this is the one we show here to 
keep things simple, but that’s not to 
say other options aren’t as good – 
these days, the standard of 
RAW-processing software is  
pretty high across the board.

A cleAR RAW/jpeg diffeRence Editing rEsults comparEd

freeman on… 
GettinG more 
from raW 
This issue, Michael Freeman explores how to 
make the most out of the data in your RAW files

In this shot, taken at the door of an 
old church in Cartagena, Colombia, 
the exposure was set for the 
exterior, but as shot the interior is 
almost featureless, concealing the 
important detail of the bell-ringer. 
This can be pulled out in RAW 
processing, but see what happens 
when exactly the same processing 
(namely local adjustments with a 
Graduated Filer and three Radial 
Filters), is applied to the JPEG: there 
just isn’t the range of information in 
the file to work on. oriGinaL raW JPeG
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Order, Order

DeveLoP a system
Speed up your processing by consistently following a logical workflow

 There will never be universal 
agreement on the best order 

to use tools when processing, not 
least because there are so many,  

but you won’t go far wrong with  
the following. Software engineers 
generally design the windows on the 
assumption that users will start at 

the top and work downward, but 
there’s no compulsion. The way 
shown here starts off like that,  
but backtracks once or twice. 

in THe RAW
Behind the scenes – 
software that digs  
into RAW files

1  Under Lens Corrections, 
check Color and lens Profile. 
Color is always worth 
correcting, but treat the lens 
profile according to your taste: 
distortion correction can 
sometimes lose some of the 
image near corners, and may 
eliminate a look you want to 
retain. Similarly, vignetting is 
sometimes a good thing. 

2  Use the Crop Tool and 
Straighten Tool if necessary.

3  Tweak colour Tint and 
Temperature as needed.

4  Check overall Exposure.

5  Recover Highlights if they 
need it, but save any major 
adjustment of bright areas 
for local adjustments 
(Adjustment Brush, Radial 
Filter or Graduated Filter).

6  Brighten up Shadows if 
needed, but only by a little.  
As above, save any major 
adjustment of shadows  
for local adjustments.

7  Raise Contrast to 
compensate for the 

flattening effect of steps 4 
and 5 above.

8  Check that the white 
point is accurately set using 
the Whites slider (check the 
Highlight clipping warning at 
the top-right of the histogram).

9  Check that the black 
point is accurately set with 
the Blacks slider (check the 
Shadow clipping warning at 
the top-left of the histogram).

10  Adjust over-light or 
over-dark areas with the 

Adjustment Brush, Graduated 
Filter or Radial Filter.

11  Adjust Clarity only if 
essential, and very cautiously. 
It tends to give a fake look.

12  Think twice before 
adjusting Saturation or 
Vibrance. Vibrance prevents 
clipping by colour channel, so 
looks milder than Saturation.

13  Examine the image at 
100% magnification for any 
dust spots, and use the Spot 
Removal tool if needed.

76-79
Nikon Know-How
Get more from 
your RAW files with 
Michael’s guide to 
perfect processing

80-81
Nikon software
Remove colour casts 
from your shots using 
Nikon Capture NX-D – 
George Cairns shows 
you how it’s done

82-83
Ask Rod…
If you’ve got a 
hardware problem, 
a buying decision to 
make or some other 
query, just ask Rod!

YOUR fRieNdlY  
NiKON eXPeRT
Our roving Contributor at 
Large, renowned professional 
photographer and prolific author 
Michael Freeman presents a 
monthly masterclass that’s 
exclusive to N-Photo. Michael 
has published dozens of books 
on photography, including the 
bestselling Perfect Exposure. 

■ You might not realise it, but 
RAW files you open in ACR have 
already been processed. Most RAW 
processing software performs 
so-called demosaicing, corrects for 
a green cast, and applies a gamma 
curve before even showing you the 
image on-screen. Some software, 
however, enables you to see the 
original incarnations of RAW files 
before any of this hidden processing 
is applied. RAWDigger is one.

A full frame and a detail as you 
normally see them on opening a 
RAW file, and as they look before 
green cast correction, gamma 
correction and demosaicing.
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Perfect rAW territOry

ProCessinG a hiGh-Contrast sCene
The benefits of shooting in RAW become apparent when processing images taken in very bright, direct sunlight

 This is a high-contrast, 
high-dynamic-range scene 

where the lighting is divided sharply 
between sunlight and shadow. The 
exposure is efficient, meaning that 
it’s as bright as it can be without 
clipping any highlights, so the RAW 
processor has the maximum amount 
of information to work on. 

The highlights need to be 
darkened, and the shadow areas 
brightened, while maintaining 
contrast and enhancing the glow on 
walls and pavements in the shadow 
areas. There are two different ways 
of handling this, and both need the 
extra data stored in a RAW file. 

One way is to rely on the Highlight 
and Shadow recovery sliders, which 
are very sophisticated. The problem 

with these, as you can see from  
the version below, is that the result 
looks a bit flat. It lacks richness, and 
has that slightly non-photographic 
look typical of local adjustments, 
which work on neighbouring pixels 
(See ‘Global vs local processing’ at 
the bottom of the page). 

The other method, which is more 
laborious but to my mind superior, is 
to isolate the two zones – sunlit and 
shadow – using a local adjustment 
brush. In this case, the brush was 
used to lighten the shadows. The 
overall controls were then used to 
process the sunlit area. In effect, 
each zone was processed 
independently, and the extra data in 
the 14-bit RAW file allowed a full, 
rich result with glowing shadows. 

In ACR, the shadow 
areas were selected 
with a local 
adjustment brush, so 
that the two zones, 
sunlit and shadow, 
could be processed 
independently using 
the Exposure slider

unprocessed rAW file
Opened in ACR the high 
dynamic range is evident,  
but the absence of clipping 
warnings shows that all the 
information is there in the file.

processed for sunlight
To demonstrate only, this is 
how the image would look 
processed to favour the sunlit 
area. The shadow detail is 
seriously compromised.

flAt result from sliders
A typical one-step procedure 
relies on using the Highlights 
and Shadows sliders. It works to 
a point, but at the cost of a flat, 
not-quite-photographic look.

processed for shAde
Again for the purpose of 
demonstration, processing the 
image to brighten the shadows 
leaves the sunlit façade of the 
cathedral badly over-exposed.

the full rAnge
Using the full dynamic range  
of the RAW file and a local 
selection, both the sunlit and 
the shadow areas have been 
processed to their full potential.

Localised processing is very powerful, but use it with care...
■ In film-based photography, most of the ways 
of adjusting how a picture looks affect the entire 
image. Digital processing, in contrast, enables us 
to adjust increasingly specific attributes. Many 
of these methods are distinctly non-traditional, 
in that they can adjust brightness and colour 
according to what neighbouring pixels look like. 

This is called tone mapping, a digital procedure 
for mapping one set of tones and colours to 
another. And there are two kinds of tone mapping: 

global operators and local operators. The first 
applies its calculations across a whole image, 
the second works only at a certain distance from 
each pixel. This kind of processing can alter the 
image – by teasing out shadow detail, for example 
– to a degree that would just be impossible using 
methods such as Curves. However, if used without 
care, the result will look less ‘photographic’. 
It pays to treat localised adjustments like 
Highlights, Shadows and Clarity with caution.

globAl vS locAl pRoceSSing

A detail of an image processed with Highlights and Shadows 
recovery, for a local effect. The sliders are highly effective,  
but traditionalists might not like the over-processed look
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different strOkes

more than one Way to skin a Cat...
How you process your images depends on your personal preference, and the overall look you’re trying to achieve

 There’s more than one way to 
process an image, even if 

you’re looking for the same result, 
but with subtle differences. How 
subtle depends on your judgment. 
One operation that’s much in 
demand is the twin adjustment of 
Highlights and Shadows to bring out 
more detail. Even this is disputed, 
with some believing that too much 
detail tends to be teased out 
nowadays simply because it  
can be (and yes, I think that, too). 

In this architectural interior (of an 
old colonial house in Singapore) shot 
without any added lighting, the area 
behind the stairs is very bright, as it’s 
bathed in tropical sunlight. At the 
same time the top of the stairs fades 
into darkness. It would be good to 
bring more out of each area, and  
ACR offers three ways to do this. 

In the first, using just the Basic 
window, the Highlights and Shadows 
sliders each work on a restricted 
range of tones, lowering or raising 
the brightness according to which 
way you drag the slider. Also, 
significantly, they can recover 
apparently lost detail – the 
Highlights slider, for example, can 
use information in one or two of the 
three colour channels (red, green, 
blue) to ‘reconstruct’ the lost detail. 
Here, used at -100 and +50 
respectively, they do a good job. 
However (there’s always a however 
in processing!), if the sliders are used 
too aggressively, they tend to flatten 

contrast so much that the end result 
can have a ‘non-photographic’ feel. 
And again, there’s inevitably some 
dispute around what ‘looks like’ a 
photograph and what ‘looks like’ 
reality  – a shifting quicksand of  
an idea if ever there was one!

Next up, an apparently similar 
tool is available in the Tone Curve 
window: the Parametric Curve. 
Despite its off-putting name, this is 
very simple in use. The tonal range is 
split into four – Highlights, Lights, 
Darks and Shadows – and by 
selecting these one at a time, you 
can adjust the Curve smoothly to 
control each one. Despite being 
similar to the Highlights and 
Shadows sliders that we just used, 
however, the effect is not quite the 
same, and the bright sunlit area 
beyond the stairs is pale and  
lacking in contrast. 

Last but not least is the more 
tedious, but ultimately more 
successful, method of selecting 
specific areas and then changing 
their Exposure and Contrast – the 
digital equivalent of dodging and 
burning a negative in a darkroom. 
Using the Radial Filter, which can 
now be added to or erased with a 
brush, a total of nine local areas 
were independently adjusted. This 
involved more work, but gave much 
more control. The differences are 
obvious when the shots are seen 
side by side, though perhaps less  
so when they’re seen one at a time. 

One fOrmAt tO fit them All 

DnG – a universaL fiLe format?
Adobe’s Digital Negative format goes some way to providing a file format that can be read by any RAW processing software

 DNG (or Digital Negative) is  
an Adobe initiative to design a 

‘universal’ RAW image file that can be 
opened in any RAW software. Using 
Adobe software like Photoshop or 
Lightroom, you can save a RAW file 
as a DNG and retain all the raw data.

Most camera manufacturers 
design their own RAW file formats, 
and keep improving them to work 
best with their cameras, so there  
is no common standard. 

This is one of the problems that 
DNG is designed to solve, the 

concern being that it may be 
impossible to read old RAW files in 
the future. This is hardly likely, given 
that first, once a RAW file format has 
been opened there is no reason why 
this ability should ever be lost; and 
second, that reverse engineering all 

RAW files has been simple to date 
(dcraw does this). 

In practice, DNG polarises opinion, 
but the choice between it and RAW 
(in our case .NEF) hinges on workflow 
rather than quality, where there is no 
difference whatsoever.  

Here’s the image as shot: the top of the 
stairs is very dark, losing detail, while  
the area through the door is over-bright

Using the Tone Curve achieves a 
‘photographic’ result, but it can’t handle 
local contrast in shadows and highlights

The Highlights and Shadows sliders use 
local tone mapping, and are effective,  
but at the cost of diluting the contrast

Working individually on nine local areas 
selected with the Radial Filter brings out 
the detail in shadows and highlights
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Find the right balance
If two photographers shoot 
the same scene at the same 

time with identical cameras, the 
colours in the resulting photos can 
look quite different. One camera’s 
shots might feature a cool, blue 
colour cast, while the other camera 
could capture warmer-looking 
colours. These discrepancies in 
colour can occur because different 
white balance settings were used.

Your Nikon has a range of white 
balance presets to help it deal with 
the different colour temperatures 
produced by various light sources. 
Daylight has an average colour 
temperature of 5000 degrees K,  
for  example, while light from an 

incandescent bulb has a lower 
colour temperature of around 
3000K. Confusingly, lower-colour-
temperature light sources produce 
warmer colour casts, while higher 
temperatures produce colder ones. 
Your Nikon’s white balance settings 
are designed to counter these tints 
and produce accurate colours.

White balance presets
You camera’s Auto White Balance 
(AWB) setting will analyse whites or 
greys in different lighting conditions, 
and warm them up or cool them 
down as necessary. Sometimes the 
AWB setting won’t succeed, and 
you’ll end up with cold-looking 

landscapes, or indoor portraits in 
which skin tones appear too orange. 
Choosing an in-camera white 
balance preset can give better 
results – selecting Direct Sunlight, 
for example, tells the camera that 
the colour temperature of the 
ambient light is close to a cool 
5500K, so it will warm up your  
shots accordingly. 

Choosing in-camera white balance 
settings manually can be time-
consuming, so you may prefer to 
stick to AWB. And as long as you 
shoot RAW, Capture NX-D enables 
you to select a different white 
balance setting post-shoot, so you 
can banish colour casts with ease.  

George Cairns explains how to remove colour casts using Capture NX-D

nikon know-how

Key terms explained
JARGon BUSTER
KELVIN

 The Kelvin (K) scale is named 
after Lord Kelvin, a 19th-century 
British physicist. A Kelvin is a 
unit of measure for temperature, 
and in photography it’s used to 
describe the colour of different 
light sources, and of natural light 
at different times of the day. 

COLOUR CAST
 Colour casts are tints of cool 

blue or warm orange that need to 
be corrected in order to create 
more faithful colours.
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01  before and after
When you’re adjusting an image’s white 
balance, it helps if you can compare the edited 
version with the original – you’ll often find 
that an image’s colours look okay until you 
see the difference that selecting a different 
white balance setting makes. To do this, click 
and hold on the Multi-Preview icon and choose 
Compare Before and After Images. This will 
enable you to see the image’s original colours 
in the left-hand pane.

02  Metadata 
Before you start to correct a photo’s colours it 
can be helpful to check which white balance 
setting was used to take the shot. The Shade 
setting will warm up colours to counter the 
cool quality of shaded light, for example, while 
Incandescent will cool down warm artificial 
lighting – so if you select Incadescent when 
shooting outdoors you’ll capture images with 
very blue colours. The metadata pane enables 
you to discover which white balance setting 
was used at the time of shooting.

03  edit pane 
If you shoot in RAW, this pane enables you 
view  and adjust a range of camera settings, 
including the white balance preset used for 
each shot. By default the white balance will 
be  set to Original, and your image will be 

displayed with the setting that you chose 
in-camera applied. 

04  White balance presets 
If you’ve used an incorrect white balance 
preset in-camera and need to change it, or  
if  you just want to adjust the white balance  
to create a different feel, you can experiment 
with the various presets in this drop-down 
menu, which correspond to the presets on 
your D-SLR. Our unprocessed example image 
has rather cold-looking shadows, so we could 
try warming them up by using the Shade 
preset. However, in this case the Shade preset 
will make the warmer-looking, sunlit parts of 
the building look too orange.

05  White balance pane 
After clicking the white balance icon this  
pane  appears. Its drop-down menu also gives 
you access to various white balance presets 
(such as Direct Sunlight), but you can also 
apply a more suitable custom white balance 
by using the Gray Point Sample tool.

06  gray Point Sample tool 
You use this tool by clicking on a tone in your 
image that should be white or grey. Capture 
NX-D will warm up or cool down that tone to 

create neutral whites or greys, and the  
same  adjustment will be applied to colours 
throughout the image to correct them. You 
can also select the Gray Point Sample tool  
from  the main toolbar. 

07  Fine adjustment 
After using a white balance preset or applying 
a custom white balance, you can fine-tune the 
results using this slider. This is particularly 
useful when dealing with images that were 
shot under mixed lighting.

08  tint 
As well as suffering from blue or orange 
colour casts, some images may exhibit green 
or magenta tints caused by fluorescent or 
other artificial lighting. You can counteract 
these tints using this slider.

Mixed lighting
 This location’s mixture of sunshine and dark 

shadows is a challenge for the camera’s AWB 
setting. Shadows have a cooler (bluer) light than 
areas in direct sunlight, and after AWB has cooled 
down the image to produce accurate colours in 
the sunlit areas the colder shadows look too blue.

banish the blues
 Click the white balance icon in the Edit pane  

to  open the White Balance pane. Select the Gray 
Point Sample tool, and click on an area that 
should be white or grey (such as the flagpole in our 
church scene). This warms up the image to correct 
the cool blue cast and produce neutral whites. 

get the balance right
 Now that we’ve warmed up the cold shadows 

the warmer sunlit areas look too orange. Drag  
the Fine  Adjustment slider left to cool down the 
image overall – you need to find the right balance, 
cooling down the warm oranges but without 
making the shadows look too cold.

CUSTOm WHITE BALANCE
Produce correct colours in images shot under mixed lighting conditions

nikon know-how

hOW it WOrKS WHITE BALANCE
Adjust a photo’s colour temperature to counteract warm or cool colour casts

Downloading Capture NX-D

whERE To GET 
CAPTURE nX-D

 Capture NX-D is available as a free 
download from the Nikon website at 
http://nikonimglib.com/ncnxd/ 
It’s up to date with support for the 
latest Nikon D-SLRs, and as new 
models are introduced, Capture  
NX-D should be the first software to 
support them. Another key advantage 
is that it exactly replicates the 
Picture Controls, white balance  
and other settings of your Nikon.

http://www.bit.ly/start-44
http://nikonimglib.com/ncnxd/
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Ask    Rod...
Our resident expert answers your  
questions and solves your issues.  
If nobody else can help, ask Rod!

If you’d like Rod to come to the rescue 
regarding your Nikon-related question, 
email it to mail@nphotomag.com. 
Please note that we reserve the right  
to edit any queries for clarity or brevity.
You can also write to us at:
N-Photo Magazine, 
Quay House, The Ambury
Bath, BA1 1UA, UK

Get in touch…

 I’ve upgraded from a D200 to the D600. 
Can you tell me what is the widest lens I 
can use without risking vignetting? 
Alan Wisberg, via email

Rod says… Vignetting is a reduction of an image’s brightness 
at the edges of the frame, usually indicated by darkened 
corners. It can be caused by a number of things, including 
filters and filter holders when shooting at very wide angles, 
especially at wider apertures. 

With dedicated FX (full-frame) lenses, you shouldn’t have 
too many problems with vignetting, as these lenses are built 
for the full-frame sensor format. You’ll only really encounter 
an issue if you try to use a DX lens on an FX body, because a 
DX lens is designed for a  smaller sensor, and so produces an 
image that isn’t big enough for an FX sensor. That said, your 
D600 should compensate automatically for this when an DX 
lens is attached, by automatically restricting images to the 
middle of the sensor. The only down side is that resolution 
will be reduced, as you’re no longer using the whole sensor. 
The only instance in which you’ll experience vignetting is if 
you disable this so-called DX crop mode.

 What is the typical life expectancy  
of a D60’s shutter? Mine is approaching 
10,000 actuations 
Martin Shaw, via email

Rod says… A Nikon D60 shutter typically has a life 
expectancy of around 50,000 actuations, although many 
models go past that figure without issue when taken care  
of. If your shutter does fail for any reason, there are repair 
options through Nikon or third parties. Whether the cost of 
the repair is beyond what you’re willing to pay is another 
matter, but a dead shutter needn’t mean a dead camera. 

 Could you 
recommend a 
scanner for 35mm 
slides, negatives 
and larger format 
negatives? 
Edward Laine, via email

Rod says… Unfortunately 
the last Nikon Coolscan 
scanner was produced in 
2004, thanks to the growth 
of digital photography and 
the dwindling interest in 
film photography. 

There are a number  
of third-party options to 
choose from, including the 
range from Plustek, which 
suits a variety of budgets, 
and Epson flatbed models. 
We haven’t tested film 
scanners in N-Photo, but in 
our experience dedicated 
slide and negative scanners 
are better suited to the task 
than flatbed models, which 
require a special holder and 
other modifications. 

You can pay specialist 
firms to do your scanning. 
Depending on the amount of 
negatives you have, this may 
be cheaper, especially when 
some of your more unusual 
sizes are considered. 

A D-SLR shutter is very robust, and will normally have a lifespan 
extending into the tens of thousands of actuations

The Nikon Coolscan range of 
scanners was discontinued 
around 10 years ago

The different sizes of DX and FX sensors means some lenses 
will be affected if you move from APS-C to a full-frame D-SLR

 I’m looking to sell my D300 
and upgrade. How can I 
check the actuations? 
David Lloyd, via email

Rod says… How you check the number of 
shutter actuations depends on your model of 
camera. On some the information can be found in 
the menu, while on others you’ll need to look through the EXIF 
data (and some older models don’t offer the feature at all). In 
the case of the D300 it’s in the EXIF data, so all that’s required 
is a recent image and a program capable of reading the EXIF. 

Actuations aren’t everything when checking the condition 
of a D-SLR though; Live View only requires a single actuation, 
for example, but can be used to shoot reams of video. Check a 
camera’s physical condition, and check the returns policy, 
before buying used.
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 Why can’t I 
import RAW Files 
from my Nikon 
D750 into Adobe 
Lightroom or 
Elements? 
Barry Tetchner, via email

Rod says… Barry, you need 
version 8.7 of Camera Raw, 
and version 5.7 of Lightroom 
in order to support your 
D750’s RAW files. Photoshop 
Elements 13 supports the 
relevant version of Camera 
Raw, so if you’re using an 
older version of the 
software you’ll need to 
update via Adobe’s website. 

 I have decided to upgrade my lens to photograph 
motorsports and aviation. What would you recommend  
for low, medium and high budgets? 
Dave Hewitt, via email

Rod says… The focal length we’d recommend for those subjects is between 70mm and 
300mm. The most affordable option within that range is the Nikon AF-S 70-300mm 
f/4.5-5.6G IF-ED VR, which has Vibration Reduction technology to combat shake and 
costs around £419 ($639). The Sigma 70-200mm f/2.8 APO EX DG OS has a fixed aperture 
and optical stabilisation, and costs around £739 ($1128). The Nikon 70-200mm f/2.8G ED 
VR II, which has the second-generation VR technology, is the most expensive option. It 
costs around £1579 ($2410), and is recommended if you’re taking the step up to a more 
professional body as well, but either of the other options will be perfect for you.

HELP ME CHOOSE...

NIkoN D610 vs D600 These cameras are so similar there don’t seem to be 
many changes, but the D610 has a fair few advantages…

01  More of the same
Physically, these two D-SLRs 
are very similar. The 850g 
magnesium alloy body is 
convenient to cart around all 
day, and robust enough to stand 
up to professional usage, while 
the layout of the controls is the 
same enthusiast-orientated 
design as on the D7100, making 
it ideal for users new to full-
frame cameras. 

02  Faster burst shooting
Half a frame per second gained 
on the D610 may not sound like 
much, but going from 5.5 to six 
frames per second gives you an 
extra shot every two seconds, 
which is especially useful for 
increasing your chances of 
success when shooting fast-
moving subjects such as sports 
or wildlife.

03  Be more discreet
The Quiet Continuous mode 
adds a more subtle edge to 
the burst mode. It knocks the 
speed down to three frames per 
second to minimise the noise 
caused by mirror movement 
inside the camera, which is 
useful for shooting indoors, 
especially when photographing 
events such as weddings.

04  Auto white balance 
improvements
Although this is somewhat 
difficult to measure, the 
auto white balance has been 
improved, and it definitely 
reacts more quickly than 
before. If lighting conditions 
change the camera is capable 
of responding rapidly, which 
is useful when moving from 
outside to indoors.

key differences
£1199/$1497
Being the most affordable 
FX body Nikon produces 
makes the D610 extremely 
attractive to any DX 
photographer stepping up.

£870/$1350
The D600 can still be found 
new in a few places, but it’s 
more likely you’ll be buying 
used, due to the camera 
being discontinued.

Burst shooting
There are two options 
for burst shooting: six 
frames per second, or 
three frames per 
second in Quiet mode.

Weatherproofing 
The magnesium alloy 
frame is protected 
against dust and water, 
making it an excellent 
choice for outdoors. 

24 MP FX sensor
The amount of detail 
that can be captured 
means the D610 is 
suitable for every 
photographic style.

Sensor issues
Issues with the D600’s 
sensor were well 
publicised, leading to an 
extended warranty for 
those models affected.

39-point AF
The 39-point AF system 
can mean the difference 
between a sharp 
image and a missed 
opportunity.

3.2-inch screen
Whether you’re 
reviewing images or 
using Live View, the 
3.2-inch LCD screen is 
extremely good. 

Nikon D610 (body only) £1199/$1497 Nikon D600 (body only) £870/$1350

AnSwERS  
in A fLASH!

 My stepson has been 
playing with my D3 and 
I’m unsure how to turn 
the bracketing off 
Lori Scott, via Facebook

Rod says… Hi Lori, if you hold 
down the BKT button on the 
top of the camera, then rotate 
the dial just below the LCD 
display until ‘OF’ is shown, 
that should disable it.

 What are the best 
settings for shooting  
a football match? 
Thomas Sands, via 
Facebook

Rod says… I’d recommend 
1/500 sec at f/2.8 or f/4 and 
auto ISO. Make sure you have 
a decent zoom lens, such as 
the Nikon 70-200mm f/2.8 VR 
II and, if possible, use a D-SLR 
with a high burst rate.

Sigma’s 70-200mm is an 
excellent option for the  
aspiring sports photographer
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As a curtain raiser for his 
talk at The Photography 
Show in March, the 
legendary Don McCullin 
talks to Geoff Harris

on McCullin has been taking  
hard-hitting news photos since 
the late 1950s. We asked him 
about his tough early years, the 
development of his technique, 
why he’s sick and tired of his most 

famous war image, and why he wants to be 
remembered more for his landscapes...

To start at the beginning, we wondered 
if your talent for expressing yourself 
visually may have arisen as a result of 
you suffering from dyslexia as a child?
I’ve always struggled to read, and I miss 
things; it’s a bloody nuisance, but I don’t 
believe that quitting or surrendering to a 
disability is the right thing to do. Always 
fight the things that handicap you in life. 
And I am certain that one half of my brain 
is open to visual arts, as much as it is to 
music – I’m very fond of classical music. 
So if I fall down on dyslexia, it’s not the 
greatest tragedy.

You’ve talked a lot about your tough 
childhood. Your father gambled and died 
young, your mother drank, and you were 
mistreated as an evacuee during the war. 
Did you have any awareness of or interest 
in photography as a child?
None at all. I first became aware of it when 
I saw pictures from the war – the liberation 
of Belsen, for instance. I didn’t come from 
a particularly scholarly background, and 
I was disobedient and played truant a lot. 
There was one art master who persuaded 
me to take a scholarship to get into 
Hammersmith School of Arts and Crafts, 
although it was more associated with the 
building trade and bricklaying. I used to 
abscond to look at birds.

You ended up working as a 
photographer’s assistant in the RAF.  
Is that where your career started?
Not really. In fact, I failed my trade test 
to become an aerial photographer in the 
RAF. I couldn’t remember enough to pass 
the theory paper, and my dyslexia made it 
hard. I did buy my first camera when I was 
in the RAF, however – a Rolleicord.

So how did you get started as a serious 
photographer?
When I left the RAF I started mixing with 
budding photographers and enjoying 

 DON 
 McCULLIN 

C L O S E - U P
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Early Morning at the Kumbh Mela 
Hindu Pilgrimage, on the banks of 

the Ganges at Allahabad, 1989
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Residents take shelter as British soldiers charge rioters in 
Derry’s Bogside, 1971 (above)

A protester sits in front of police in Whitehall during the 
Cuban Missile Crisis, 1963 (top right) 

The Guvnors, Finsbury Park, London, 1958 (bottom right).  
This image became McCullin’s first published photo after  

one of the gang killed a policeman

of my professional life I’ve been involved 
with political tragedies around the globe. 
I also bought a load of photography 
books from a junk shop in Cornwall. 
They featured people like Stieglitz, 
Frederick Evans and Edward Steichen, 
and I started to base my principles on 
these photographers from the turn of the 
last century. I was out today, shooting 
landscapes, and I was looking at the results 
and it was like Stieglitz talking.

Your first serious overseas work was  
in Berlin, wasn’t it?
I was taken on as a freelancer by The 
Observer, but my trip to Berlin in 1961, 
when the Wall was being constructed, was 
self-funded. I had voices in my head telling 

photography, and I got my first break 
by accident. A lot of the guys I grew up 
with in Finsbury Park in North London 
were wayward. There was a gang clash 
where I lived, the police tried to separate 
the two factions, and a policeman was 
fatally stabbed. The perpetrator, Ronald 
Marwood, had featured in an image I had 
taken previously called The Guvnors.  

It showed the gang posing in a bombed-out 
building, and the papers suddenly wanted 
the picture. Marwood was persuaded to 
hand himself in by his father, but you 
couldn’t kill a policeman in 1958 and not 
go to the gallows. So I started my career  
on a harsh and violent note. 

Who were your influences back then?
I met a few other serious photographers, 
including Philip Jones Griffiths, who had 
a great influence on me and gave me a lot 
of guidance. A lot of it was from a left-
wing perspective, though, and I wasn’t 
that interested in the political aspects 
of photography – I enjoyed photography 
because it enabled me to get away from 
political stuff. So it’s strange that for most 
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me to go. When I got there, sometimes 
I was the only photographer covering 
this massively important event. I had no 
money, nowhere to stay and only one 
camera. What made me do it? To this day 
I don’t know. It was the same when I was 
covering the conflict in the Belgian Congo. 
I went 1000 kilometres into an area where 
journalists weren’t allowed, borrowed a 
uniform and got in a plane operated by the 
CIA. It could have easily ended in tragedy. 
My father used to gamble the family wages 
at the dog track, and I had told myself I 
would never be a gambler, but I’ve gambled 
for the highest stakes in the world.

The Congo was grim. You say in the 
documentary movie, McCullin, how 

Don McCullin CBE is a British photographer 
famous for his images of conflict and disasters

■ Born in 1938, McCullin had 
a tough London childhood, 
and established himself as a 
photographer with his images 
of a local gang. He has worked 
for many publications, but is 
best known for his work for The 
Observer and Sunday Times.

■ McCullin has covered 
conflicts in Cyprus, the Congo, 

Vietnam, Bangladesh and 
Beirut, as well as the effects 
of AIDS and famine in the 
developing world.

■ McCullin’s books include Don 
McCullin in Africa and Shaped 
By War. A  BAFTA-nominated 
documentary film about his life 
and career, entitled McCullin, 
was released in 2012. 
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left out of the final story edit by The Sunday 
Times. How weird is that?

What Nikon equipment were you using 
in the 1960s?
I used a Nikon F, as it was the workhorse of 
photojournalism. It was built like a German 
Tiger tank. I could drop it, pick it up again, 
and carry on shooting – until, that is, it 
stopped a sniper’s bullet in Cambodia, in 
1968 [above right]. I also used two light 
meters, until they got ruined by the climate 
in Bangladesh.

Was there a reason you didn’t use a 
50mm portrait lens?
Every reason in the world. Nobody used a 
50mm standard lens, it was too close. You 

daily bread and they choked on it. I would 
go in and out like I was on a package 
holiday, three to five weeks at a time. 

Your most famous image from Vietnam 
is the shell-shocked US Marine with the 
‘thousand-yard stare’ [above]. Do you  
feel you have become typecast by it?
I am sick and tired of that image. I have 
taken far better pictures. I was talking 
to Eddie Adams, another Vietnam 
photographer, who took the image of the 
Saigon policeman executing the Viet Cong 
suspect in the street [see My Best Shot, 
N-Photo 27]. He said he was sick of that 
picture, too, as everyone had forgotten his 
previous work. This is the danger. In fact, 
my image of the shell-shocked Marine was 

much you hated the sadistic mercenaries, 
and you saw some terrible sights quite 
early in your career. Did you ever feel like 
packing it in and going back to being a 
press photographer in London?
Once I realised my pictures were having an 
impact, there would have been no point in 
me walking away from something I knew 
I was capable of delivering. I wanted to 
work in an acceptable, proper way, rather 
than taking atrocity pictures. I wanted to 
take pictures that communicated to people 
how wrong the things they were looking 
at were. Having been a failure in the first 
25 years of my life, suddenly I had found a 
key that could change my life and give me 
hope. I felt like a decent, useful person. 

While you worked in many other places 
during the 1960s, covering conflicts 
and national emergencies, you are 
particularly well known for your work 
during the Vietnam War. How did you 
stay calm and get such beautifully 
composed shots, especially during  
the vicious battle for Hue in 1968?
That’s a good question. Even to this day 
I relive those battles. Robert Capa said if 
your pictures weren’t good enough you 
weren’t close enough; I’d add that there’s no 
point taking a picture of a dramatic event 
if you get the exposure wrong. So I used to 
check with light meters before standing up 
to shoot, and I used two lenses – a 28mm 
for getting in close and a 135mm short 
telephoto for working at a distance. I used 
the 135mm for the image of the US Marine 
throwing a grenade [top right]. I could’ve 
used the 28mm and been hit like he was, 
shortly afterwards. It was always exposure 
first, picture next.

Did you consider yourself lucky to 
get out of there in one piece? A lot of 
photographers were killed or wounded  
in Southeast Asia. 
I guess I hoped that people would see 
I was holding a camera, not a gun, so I 
wasn’t a threat. But I was lucky, wasn’t I? 
Photographers died in Vietnam because 
they stayed there too long. It became their 

 I wanted to take pictures 
that communicated to people 
how wrong the things they 
were looking at were 
Don McCullin Photojournalist

A US Marine suffering from shell shock waits to be 
evacuated, Hue, Vietnam, 1968 (right)
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A US Marine hurls a grenade, seconds before being shot 
through the left hand, Hue, Vietnam, 1968 (top)

Don McCullin’s damaged Nikon F camera, hit by a sniper’s 
bullet in Cambodia, 1968 (above)

A Turkish fighter running out of a cinema in Limassol,  
Cyprus, during clashes between Turkish and Greek  

Cypriots in 1964 (above left)

needed a lens with elbow room, so you 
could get some width, and soak stuff up in 
a 35mm frame. 

You have always had a great eye for 
composition. Was framing something  
that came naturally to you?
I never struggled with framing. As soon 
as I look through the viewfinder I have an 
instant recognition of what I’m after. The 
master of composition was Henri Cartier-
Bresson, and it was done in split seconds, 
not five or ten minutes. Composition is the 
most disciplined part of my photography, 
being able to create in a split second.

Cartier-Bresson also used to practise 
being as unobtrusive as possible. Were 

you the same when you were working as 
a photojournalist?
Cartier-Bresson would be very unobtrusive, 
but I often photograph people one-to-one, 
so I can’t be. People ask me if I sometimes 
hide behind the camera, and it’s a really 
stupid question; the answer is no. Morally, 
I feel that when I am in front of a person 
who is sick, starving, injured or dying, I 
have to try to communicate by not making 
their discomfort or pain or shock any 
worse. I go towards them, use my eyes, 
look for consent. It’s tricky. If you don’t do 
it properly you are in dead trouble. More 
often than not I am lucky.

How do you stop people from posing or 
feeling very self-conscious?

I rely on a feeling, an exchange of feelings 
– an understanding that I mean no harm 
to them, that I understand them and feel 
their pain. I got caught in the blast of an 
artillery shell once, and I remember the 
shock of seeing blood pouring onto my 
crotch. A lot of photographers think they 
own photography, and whatever is in front 
of them, but it’s not true. You beg, you 
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A man walks towards the chimneys of the steel foundry in 
West Hartlepool, County Durham, 1963 (above)

 Lots of people went to war for 
the adrenaline rush, but it could 
wear a bit thin after a while 
Don McCullin Photojournalist

and David Douglas Duncan. I have a strong 
sense of the history of photography. You 
borrow from the past in the same way that 
painters and musicians do – it’s not a crime, 
so long as you don’t plagiarise.

Did you get addicted to the ‘rush’ of war?
Yes and no. I felt I should be doing it, that I 
had an understanding of it. Lots of people 
went to war for the adrenaline rush, but 
that could wear a bit thin after a while. 

Your younger son joined the armed 
forces. Did you try to talk him out of it?
I was worried. I talked to him, and also to 
my brother, who was in the French Foreign 
Legion. He said to me “Look, you did it, 
I did it, if he wants to do it then it’s up to 

him.” I was mightily relieved when he came 
back from Afghanistan.

Do you feel that war photography has 
changed since your day?
It’s been stood completely on its head. 
Drones, embedded photographers with 
less access, soldiers with cameras on their 
helmets. Photojournalism as I knew it is 
dead. The tragedy is that all we see these 
days are images of narcissism, film stars, 
the Beckhams. It’s a totally different mix.

When you were ‘let go’ by The Sunday 
Times in the 1980s you did advertising 

persuade, that is the way I work. I never 
assumed that I was entitled.

Are you quite self-critical?
I am incredibly self-critical. I look back 
at some of my images and think “Christ, 
why did I do that?” As I said, I have been 
influenced by many photographers, and I 
didn’t arrive here without Brandt, Stieglitz 

D O n  O n  D I g I ta L
After a lifetime of shooting film 
and doing his own printing in 
the darkroom, Don McCullin 
began using digital cameras 
seriously in 2012. Here he reflects 
on his experiences with the new 
technology…

How are you getting on with digital SLRs?
In some respects I’m struggling. If I’d had digital 
cameras years ago I could have taken them to 
places where you couldn’t possibly have used 
film, and taken some good pictures. Being 
able to shoot at ISO1600, 3200, is amazing. 
The AF systems are fantastic too – once you 
get the AF right there is nothing you can’t 
shoot on the move. On the other hand, I will 
have an everlasting love affair with film. 
You can contaminate digital images with 
Photoshopping, and I wonder if a lot of things 
we see now are not always truthful. Digital 
cameras are a different kind of application, and 
require a different mindset. So I can do nice 
things with them, but it’s difficult for a man of 
my age, who has been using film for 60 years, 
to fall in love with something else. There is no 
denying they are remarkable, though.

Do you use digital cameras for landscapes?
I do, but I prefer film. I read The Times every 
day, and I keep seeing these early morning 
landscapes they publish with extraordinary 
dawns – it looks like something from the 
American West. Digital can do this for you, but 
it tends to exaggerate, and gives you chocolate-
box scenes with very accentuated colours. I 
like to use black and white in my landscapes, 
as I can create drama with Wagnerian skies, 
metallic, dark and threatening…
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Snowy, Cambridge, early 1970s (top). McCullin 
found Snowy standing by the side of the road  

with an ice-cream barrow

Holidaymakers enjoying the sun on Eastbourne 
Pier in the 1970s (above)

and commercial work. Did this feel like 
an anti-climax after what you had been 
used to shooting?
It wasn’t just an anti-climax, it was crap. I 
got lots of money for crap work. I even won 
awards, which are now in the shed. It felt 
like prostitution, but at least I was picking 
up a camera and keeping in touch with 
photography. I do feel very uncomfortable 
about that period, but I had no money, so 
what was I supposed to do? Starve and  
lose my house?

Surely you are proud of those very 
striking images you took for the police 
recruitment posters?
I’m embarrassed, actually. I am not a great 
lover of what the police have been up to 

over the last 25 years. They have made 
terrible mistakes in many cases. 

Looking back on your career, why do you 
dislike being called a war photographer?
I am capable of doing so many different 
things in photography – landscapes, 
portraits, still life. I am bringing out three 
new books this year. I want to show that 
I have not just been taking advantage of 
people for all of my career.

Why do you like to shoot landscapes?
I want to end my life on a peaceful note, 
and people like my landscapes, so I must 
be doing something right. The English 
countryside, particularly in Somerset, 
where I live, is in my pores. I look at it 

• Don will be speaking on the Super 
Stage at The Photography Show on 24 
March 2015. Book your tickets now at
www.thephotographyshow.com

every day, I look at the skies, the howling 
wind and rain; it’s where I belong. It’s not 
always easy, though. I’ll be 80 in October, 
and I’m a mess. I’ve had a heart operation 
and I have chronic arthritis. Last week I 
was on Hadrian’s Wall in a blizzard and I 
nearly fell over. But I have to balance-off 
this war photographer nonsense. I am in 
the last stages of my life, and I want to 
leave behind something beautiful. I know 
I’m going to do that. I’m at my best now. 
I am devoted to my journey. 
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Nikon generally replaces 
its entry-level models every 

year, so it’s no surprise to see 
the D5500, which sits above the 
D3300, making its debut in 2015. 
As we’ve seen with other recent 
additions to the Nikon line-up, 
however, the new model offers an 
incremental upgrade, rather than a 
complete overhaul.

Just like the D5300, the D5500 has 
a monocoque construction (ie its shell 
is made in a single piece). However, 
it is slimmer than its predecessor, 
especially in the area between 
the lens mount and the grip. This 
thinning has meant that the internal 
layout of the camera has had to be 

redesigned, but it results in a deeper 
grip which makes the D5500 feel 
more secure in the hand.

The top plate sees a slight redesign, 
with a simplified mode dial which 
contains just eight different exposure 
modes, including automatic, semi-
automatic and manual settings. 
Around the mode dial is a switch for 
activating Live View shooting, which 
is very easy to quickly flick on and 
off when you need it. 

Compact companion
As standard, the D5500 ships with 
the same innovative 18-55mm 
collapsible kit lens that comes with 
the D5300. You can also buy the 

D5500 body-only if you already have 
some lenses in your kit and just want 
a new D-SLR. To use the 18-55mm 
kit lens, you’ll need to hold down 
a button on the side of the lens to 
extend it first before you take your 
shot. Once that’s done, you can leave 
the lens extended for the next shot to 
speed things up.

Give it a poke
The most talked-about difference 
between the D5500 and D5300 is 
that the 3.2-inch, 1,037,000-dot 
vari-angle LCD on the back of the 
camera is now touch-sensitive – 
indeed, it’s the first Nikon D-SLR to 
have this feature. This has a number 
of practical applications: you can, 
for instance, make settings changes 
simply by tapping the ‘i’ icon in the 
bottom-right-hand corner of the 
screen. From here, you can tap the 
setting you wish to change (such as 
white balance) and then tap the exact 
setting you want to use. 

If you don’t like using touchscreens, 
there is an equivalent physical button 
marked with the same ‘i’, and after 
pressing it you can navigate to the 
setting you want to use using the 
directional keys instead.

The touchscreen does make it 
possible to do things that would 
previously have been difficult, if 
not impossible. You can set up the 
D5500 so that it’s possible to change 
a particular setting (for example, 

At last we have a touchscreen on a 
Nikon D-SLR. Amy Davies discovers 
what else the D5500 has to offer

Nikon D5500
D-SLR    Nikon D5500    £709, $996 (with 18-55mm kit lens)    www.nikon.com

HaNG oN!
When viewed  
from the top, the 
redesigned, deeper 
grip is immediately 
obvious. It makes 
the D5500 feel 
much more secure 
in the hand than its 
predecessors did.

 The most talked-about difference between the 
D5500 and D5300 is that the 3.2-inch vari-angle LCD 
on the back of the camera is touch-sensitive – it’s 
the first Nikon D-SLR to have this feature  

SpecificatioNS
Sensor  24.2-million-pixel  

DX-format CMOS
Crop factor 1.5x
Memory 1 x SD/HC/XC
Viewfinder  Eye-level optical pentamirror 

viewfinder, 95% field of view
Video resolution  Full HD (1920x1080) at  

60, 50, 30, 25 or 24p
ISO range   100-25600 
Autofocus points  39
Max burst rate 5fps 
LCD screen  3.2-inch, 1,037,000-dot vari-angle 

touch-sensitive TFT-LCD 
Shutter speeds 1/4000 sec - 30 secs, bulb, time 
Weight 420g (body only)
Dimensions 124x97x70mm 
Power supply Li-ion EN-EL14a battery

FULL REVIEW
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selecting the autofocus point) via 
the touchscreen while you’re using 
the viewfinder. This is a good idea 
in principle, but in practice results 
were mixed. Unless you articulate the 
screen away from your face – which 
feels a little awkward – you risk 
changing settings with your nose.

When you use Live View, you can 
also use the touchscreen to set the 
autofocus point. Just tap the point on 
the screen where you want to focus. 
You can also enable ‘touch shutter’, 
which means that the camera will 
take a shot when you tap the screen, 
once focus has been acquired. 

One down side to the D5500’s 
reliance on the touchscreen is that it 
can seem to take longer than you’d 
expect to change certain settings, as 
you have to go through the i menu 
every time. There is one function 
button near the lens mount to which 
you can assign an often-used setting, 
such as ISO, though. 

It’s easy to connect to Nikon’s 
Wireless Utility app on your 
smartphone, but sadly, within the 
app it’s still only possible to set the 
AF point and fire off the shutter 
release remotely. You can’t change 
any other settings. Nevertheless it’s 
still useful for some things, such as 
taking group shots.

Familiar features
The D5500 features the same 24.2 
million pixel APS-C sized (DX-format) 

Colours are punchy 
direct from the camera, 
without going over the 
top with vibrance

Stick oR twiSt?

If you’re looking for your first camera, the 
Nikon D5500 represents an excellent little 
package. If you’re on a budget and you are 
mainly concerned with image quality, then 
the D5300 offers the same image quality in a 
cheaper body. If you already have a D5300, or 
perhaps a D3300, the main temptation to 
upgrade will be the touch-sensitive screen – 
something which will appeal to some but not 
others. If you have one of Nikon’s much older 
entry-level models, the D5500 represents a 
pretty big jump in image quality, but you may 
find that if you’re ready to take the next step, 
something like the D7100 might appeal more.

sensor as its predecessor, the D5300. 
Like other recent Nikon D-SLRs, 
the sensor has no anti-aliasing 
filter, which makes it better suited 
to capturing fine detail. Given this, 
and the fact that the D5500 also has 
the same EXPEED 4 processor as its 
predecessor, we weren’t anticipating 
any real surprises in terms of image 
quality or performance. 

As with the D5300, and just as 
we’d anticipated, images are very 

pleasing, with bright, but accurate, 
colours in the majority of situations, 
while the lack of an anti-aliasing 
filter ensures some great detail is 
captured in photographs, even  
when using the kit lens.

If you wish to change the colour 
settings, you can use Picture 
Controls, such as Vivid, to boost 
colour. There are also other options, 
such as Landscape and Portrait. 
These are useful to have to hand and 
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only from around ISO3200 and up 
that you can see image noise present 
at these kind of reproduction sizes, 
while even those taken at ISO6400 
remain usable at small sizes. 

Lock and load
As we have found in the past, Nikon’s 
39-point phase-detection autofocus 
system is fast and accurate. Even 
when using the supplied kit lens  
(kit lenses generally being fairly 
basic things), the D5500 is generally 
able to lock onto a subject with ease, 
especially when you’re working in 
good lighting conditions. 

Unfortunately, shooting using Live 
View remains a frustratingly slow 
process. While it’s useful for shooting 

still-life macro subjects to get an 
enlarged view of the scene, for other 
subjects it’s just not practical to use. 

On the whole, the D5500’s 
metering system does a pretty good 
job of helping to produce accurate 
exposures, but dialling in a touch 
of exposure compensation can be 
useful in some situations (such as 
high-contrast ones, which are always 
tricky anyhow) to get a more pleasing 
exposure. Similarly, the automatic 
white balance does a good job, 
although it can sometimes err ever so 
slightly towards unnatural, yellowish 
tones under artificial light – in which 
case, it’s beneficial to set a more 
appropriate white balance setting, 
such as Tungsten.  

you can use them while shooting 
in RAW should you need a clean 
version of the image down the line. 
In addition, there’s a host of digital 
filters available under Creative Mode. 
It’s worth giving these a look to see 
if any strike your fancy, but you can’t 
use them while shooting in RAW, 
so if you decide down the line that 
Photo Illustration (for example) was a 
mistake, you’re stuck with it.

Nikon cameras have a good 
reputation for their performance at 
high ISOs, and the D5500 doesn’t 
disappoint in this regard. Overall, 
detail in JPEGs balances well with 
the appearance of noise when looking 
at images taken at higher sensitivities 
at normal printing and web sizes. It’s 

pReSS it, SpiN it…

Most of the buttons on 
the D5500 are within easy 
reach of your right thumb, 
making it quick and easy 
to change settings. 

A small indent here helps 
you to easily release the 
screen and move it into an 
articulating position, or 
fold it away from the body.

This dial controls different 
things depending on the 
exposure mode. For 
example, it sets aperture 
in aperture-priority mode.

Use these directional 
keys to set the autofocus 
point to whichever one 
you need while you’re 
using the viewfinder. 

This ‘i’ button corresponds 
with the virtual one that 
appears on the 
touchscreen for quickly 
accessing key settings. 

The viewfinder only offers 
a 95% field of view, 
something you need  
to bear in mind when 
composing a shot. 

Even at high ISOs, there’s 
not too much evidence of 
noise appearing at normal 
printing sizes. This image 
was taken at ISO3200
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The D5500 represents a slight upgrade, 
rather than a complete overhaul, but the 

changes that have been made are welcome and 
make using the camera a nicer experience than 
before. Adding a touch-sensitive screen to the 
already well-performing sensor and processor 
combination of the D5300 means that you have 
the best of the old, with a nod to the new. 

The feature set of the D5500 is great. The 
high resolution sensor produces detailed images, 
while built-in Wi-Fi, a 39-point AF system and a 
touchscreen round off the specs very nicely. It’s 
very much a camera which is a sum of its parts 
rather than having one special standout feature. 

While Nikon hasn’t created a game-changer 
with the D5500, it’s nevertheless a very pleasing 
camera that brings a lot very useful features to 
the novice user. It’s ideal as your first D-SLR, or 
as an upgrade from a much older model. If you’re 
on a budget, the older D5300 has the same image 
quality, but lacks the touch-sensitive screen.

The verdict
It’s mostly business as usual…

Nikon D5500

How we teSt…
■ We use a range of industry-standard measurements during 
our extensive lab tests. Resolution is assessed using a chart 
based on ISO 12233, while DxO Analyser software  
is used to measure noise and dynamic range 
across the sensitivity range (www.dxo.com). 

Lab teSt ReSuLtS…
How does the Nikon D5500 compare?

OVERALL BENCHMARK RESULT
We weren’t expecting massive differences in performance 
between the D5500 and D5300, given that they use the same 
models of sensor and processor – and the lab results 
confirm it. A solid performer, but nothing revolutionary. 

Nikon D5500

Nikon D5300

Nikon D3300
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The D5500 isn’t quite as accurate as the other cameras 
here, but in our real-world tests, we found that images 
look very good, with pleasant saturation

COLOUR ERROR Closest to zero is best

RAW NOISE Highest values are best
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This suggests that the D5500 produces slightly noisier 
images than the D5300, which is a little surprising given 
that the level of detail visible doesn’t seem to have gone up.

Nikon D5500 Nikon D3300Nikon D5300

RAW DYNAMIC RANGE Highest values are best

SENSITIVITY

Dynamic range is good at the lowest ISO settings, but it 
drops dramatically at the upper values. Taking high-contrast 
photos in low light isn’t this camera’s strong point…
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The detail resolution in images is high, but it’s not 
noticeably better than that of the D5300 or D3300 
despite the D5500’s lower signal-to-noise ratio.
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We SAy… The D5500 has lots of 
excellent features which make  
for a very attractive package for 
first-time users, though experienced 
photographers may balk at the lack 
of easily-accessed controls.

FEaTURES 
bUILD qUaLITy 
ImaGE qUaLITy 
VaLUE FoR moNEy 

oveRaLL

100 400 1600 6400 102k 409k25600

Live View is useful  
for shooting macro 
still-life images, as  
it helps you to check 
critical focusing

0.1
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ROCK sOLID!
S T U R D Y  T R i p o D S

Indoors or outdoors, a sturdy tripod should help you stay steady, 
even when you’re using the heaviest D-SLR cameras and lenses. 
Matthew Richards tests the best options at a range of prices

tHe CONteNDeRs
1 Velbon Sherpa 5370D kit (comes with  
PH-157Q three-way head) £120, $180

2 Benro A2970F Versatile Transformer  
+ BH2-M ball head £145, $225 

3 Slik Pro 700DX kit (comes with  
three-way pan head) £170, $170

4 Sirui ET-2004 kit (comes with  
E-20 ball head) £190, $200

5 Manfrotto MK190XPRO3-BH kit (comes 
with 496RC2 ball head) £245, $300

6 Benro C2970F Versatile Transformer  
+ BH2-M ball head £245, $420

7 Induro AT214 Alloy 8M  
+ BHD1 ball head £250, $310

8 Manfrotto MT055CXPRO3  
+ 498RC2 ball head £415, $620

9 Sirui N-3204X + K-30X ball head £475, $605

10 Gitzo GT3542XLS Series 3 6X Systematic  
+ GH3780QD ball head £1115, $1530
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I
t’s not just about going 
over to the dark side. 
Naturally, a tripod is all 

but essential when there’s very 
little light, keeping the camera 
steady when the shutter speed is 
slow, but that’s just the start of the 
benefits. Taking time to adjust the 
camera position very precisely can 
make a world of difference when  
it comes to good composition, for 
example. Tripods are also great for 
taking self-portraits (see page 47); 
for time-lapse photography (page 
58); and for using neutral density 
filters to enable long exposures 
(page 8). Further possibilities 
include keeping the camera locked 
in position for a series of exposures 
that you combine to create an HDR 
image, or for precision panning for 
capturing a sequence that will 
form the basis of a panorama. 

In issue 37 we tested travel 
tripods, which are a bit of a 
compromise because while they 
aim to be sturdy, they’re also 
designed to keep carrying size and 
weight to a minimum. This time 
around, we’re focusing on full-

sized tripods that are built to give 
optimum rigidity.

Nobody likes to spend more 
than they need to, so the first eye-
opener is that the tripods on test 
range from just £120/$170 to over 
£1000/$1500. That said, the least 
expensive (in the UK) in the group 
is a Velbon with a maximum load 
rating of four kilograms. That’s 
sufficient for a chunky D810 body 
with a Nikon AF-S 300mm f/2.8G 
ED VR II telephoto lens attached, 
but not quite enough for shooting 
with Nikon’s more massive super-
telephotos. The majority of other 
tripod and head combinations on 
test have maximum load ratings  
of eight kilograms or more.

One money-saving option can be 
to buy a ‘kit’ that includes both legs 
and head in one package. Indeed, 
it’s not possible to buy the legs and 
head separately for some of the 
cheaper kits on test. As you move 
up the price range, any savings you 
get from buying a kit instead of 
separates can be negligible, even if 
kits are available. Buying separates 
also gives you the freedom to mix 

Ball and three-way heads
■ Ball heads tend to be 
faster, as there’s only one 
main locking knob for all 
planes of adjustment, but 
three-way heads offer more 
control for fine-tuning.

Adjustable friction damper
■ Enables greater friction  
to be applied on a ball head 
when using heavier loads, so 
the camera doesn’t fall to 
one side when the locking 
mechanism is released.

pan-only release
■ Sometimes featured on 
ball heads, so that the angle 
of tilt can remain locked but 
the camera can be panned 
horizontally, or swivelled 
through increments.

jaRgON busteR

equIpmeNt KNOw-HOw

FeatuRes tO LOOK FOR…
Check out the finer points of 
tripod design before making 
your buying decision

Multi-angle legs
Ideal for low-level shooting, or on tricky 
terrain, multiple leg angles are a real 
bonus. Most modern tripods have three 
lockable positions, whereas a couple of 
the Manfrotto tripods on test have four.

Mounting platform
Full-sized tripods usually have a 
mounting platform between 50mm and 
60mm in diameter. A close match to the 
diameter of your chosen tripod head’s 
base will help with stability. See our 
comparison table (page 107) for details.

Feet
Rubber pads work well in most 
conditions. On soft surfaces like 
carpet or dirt, spikes can be better 
as they give a more secure footing. 
The Sirui tripods feature retractable 
spikes within rubber feet, whereas 
others have interchangeable spikes 
and rubber pads.

Leg sections
Legs that are made from three 
separate sections (two extending) 
are the most common. With four or 
more sections, there’s a risk that the 
bottom ones may be quite thin and 
spindly. The plus side is that the 
tripod collapses down smaller  
for more compact stowage.

Centre column
Pivoting centre columns are great for 
macro and ultra-wide-angle shooting 
(when you want to ensure tripod feet 
aren’t in shot). With both Benros on test, 
you can lock the centre column at almost 
any position through a 180-degree arc.

Leg section locks
Some photographers prefer 
clip-style clamps, whereas others 
prefer twist locks. Either way, 
manufacturing precision is required 
to ensure firm locking when closed, 
as well as smooth extension of leg 
sections when released.

and match the legs and head, so 
you get the components you really 
want. There’s no need to stick with 
the same manufacturer for both.

Material benefits
The materials used for making 
tripod leg sections and centre 
columns are usually aluminium 
and carbon fibre. The latter is more 
expensive but tends to save weight 
without impacting on rigidity or 
load rating. For example, the Benro 
A2970F (aluminium) and C2970F 
(carbon fibre) tripods on test have 
essentially the same design. When 
used with the same head, the 
carbon fibre outfit is 20 per cent 
lighter in weight, but costs an  
extra £95 ($195).

Most current tripod designs 
have legs that can lock at varying 
angles to the centre column, which 
is useful for maintaining stability 
in low-level shooting. Some also 
feature pivoting centre columns, 
and the debate continues over 
whether clip locks or twist locks are 
the better option. Let’s take a closer 
look at the contenders.



www.digitalcameraworld.com

Sturdy tripods

01 Size matters
Heads fasten to tripods via a 1/4-inch or 3/8-inch 
screw. The latter is more common. To maximise 
compatibility, tripods often have a reversible 
screw, while heads often come with an adaptor, 
which you’ll need to fit or remove as necessary.

02 Hand tight
If you try to fit the head while the centre column 
is securely fastened, the column can be slightly 
scratched as it twists against its locking screw. 
It’s better to loosen or remove the column and 
then screw the head on until it’s hand-tight.

03 Turn the screw
To lock the head in place, many designs feature 
one or more grub screws in the platform at the 
top of the column. Where available, tighten these 
with a hex key or screwdriver once the head has 
been twisted hand-tight onto the column.

step by step    Ensure your head’s screwed on...
Before you do anything else, you’ll need to attach your head to your tripod

■ We measured the maximum 
and minimum operating heights 
of each tripod (without inverting 
the centre column, where this 
was available) as well as its 
collapsed length for carrying.  
We also measured the combined 
weight of each set of tripod legs 
and head using electronic scales, 
and measured the diameter of all 
leg sections, from the widest 
(top) to the thinnest (bottom), 
using digital electronic callipers. 
We went on to check the ease of 

use and smoothness of all 
adjustments available in each set 
of tripod legs and heads. To check 
overall stability, we used the 
tripods with a range of D-SLRs 
fitted with telephoto lenses. We 
looked for good resistance to 
flexing throughout the range  
of operating heights. To gauge 
steadiness in outdoor conditions, 
we switched off stabilisation and 
checked Live View images on the 
LCD in maximum magnification 
mode (100% view).

ReaL wORLD meets Lab
HOw we DO OuR tests…

All tripods were tested under strict conditions to 
ensure an accurate comparison would be possible

10 things we learned in this test
A few design flourishes or clever tricks can go a long 
way towards making a tripod even more useful

1 Weigh it down
Most tripods feature  

a weight hook, usually at the 
bottom of the centre column. 
Hanging a weight (for example, 
your camera bag) from this can 
add stability when shooting 
outdoors in breezy conditions.

2 From the top
In order to ensure 

maximum rigidity, it’s best to 
extend the upper (fatter) sections 
first, and to only extend the lower 
(thinner) sections if necessary.

3 Exposure delay
Many Nikon D-SLRs 

feature an exposure delay mode 
as a custom function. This helps 
to avoid mirror bounce, and will 
ensure sharper shots, especially 
when you’re using macro or 
telephoto lenses with your  
camera on a tripod.

4 Centre column pivot
Pivoting centre columns 

locked into horizontal boom mode 
are especially useful for macro 
shooting, and for avoiding getting 
the tripod feet in frame during 
ultra-wide-angle shooting.

5 on the level
Bubble levels in the tripod 

help to ensure that it’s level 
when set up, but only bubble or 
spirit levels in the head’s camera 
platform enable you to level the 
actual camera.

6 in the bag
A padded tripod bag is 

good to have, even if you need 
to buy one separately. This is 
especially true for carbon fibre 
tripods, which can shatter or 
break on impact.

7 Comfort padding
Spongy padding on one 

or more of the upper leg sections 
enables comfortable carrying, 
especially in cold weather, and 
also helps to protect the tripod 
from damaging knocks.

8 Clip or twist?
Twist-action leg locks aren’t 

any slower to use than the more 
common clip locks, and they can 
provide equally firm locking.

9 Centre column extension
We usually recommend 

extending the centre column 

of your tripod only as a last 
resort, when you absolutely 
need extra height. However, it 
can be preferable to extending 
the bottom leg sections if 
they’re very thin and you’re in a 
situation where the tripod might 
wobble or move.

10 What head?
Ball heads tend to be 

quicker and easier to adjust than 
three-way tripod heads, whereas 
the latter can be better for 
making very fine adjustments.
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We say… Inexpensive to buy but it’s 
somewhat lacking in rigidity.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL
We say… Well engineered and lofty, 
with a fully pivoting centre column.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL

velbon Sherpa 5370D kit (with 
pH-157q three-way head) £120, $180

Benro A2970F versatile Transformer 
+ BH2-M ball head £145, $225

It’s reasonably compact and lightweight for an 
aluminium kit, albeit with a modest load rating

There’s a wealth of clever features and impressive 
build quality packed into this low-priced tripod

The two lightest carbon 
fibre tripods in the group 

weigh 2kg with heads attached, 
and this aluminium Velbon kit is 
only a whisker heavier at 2.1kg. 
It’s quite a narrow design and 
not overly long when collapsed, 
at 63cm. The flip side is that the 
maximum operating height is 
just 170cm and, in keeping  
with its light weight for an 
aluminium tripod, the load 
capacity is only 4kg.

The three-section leg design 
enables the bottom section 
to have a diameter of 20mm. 
That equals the diameter of 
the bottom section of the Gitzo 
legs, although the Velbon’s 
aluminium feels a lot less rigid 
than the Gitzo’s carbon fibre.

The design of the PH-157Q 
three-way head is more like a 
cross between a ball head and 
three-way head. A single locking 
arm enables movement of both 
pan and tilt, while a separate 
locking screw is used to switch 
between landscape and portrait 
orientation shooting.

performance
Rigidity isn’t very impressive, as 
you’d expect from a lightweight 
aluminium tripod. It’s not 
helped by the surface of the 
head’s quick-release plate, which 
feels spongy and fails to give 
a really solid support for the 
camera. Ultimately, it’s the least 
expensive tripod in the group, 
but also the least sturdy.

Take a quick glance at this 
aluminium Benro tripod 

and you’d never guess that it’s 
one of the least expensive in the 
group. Take a longer look and 
the build quality and features 
become even more impressive. 
Based on three-section legs with 
firm yet easily operated clip 
locks, the tripod has a 10kg 
maximum load rating, closely 
matched by the 8kg rating of the 
BH2-M ball head, which can be 
locked with three grub screws.

There are three locking leg 
angles to choose from, plus a 
pivoting centre column. Only 
the Manfrotto tripods in this 
test group match this feature, 
but it’s better implemented on 
the Benro, where you can lock 

the centre column at many 
angles through a 180-degree 
arc. The Manfrottos only offer 
vertical or horizontal options.

performance
There’s a high-precision feel to 
all the adjustments in the legs 
and head, and the extension of 
all leg sections is very smooth. 
A firm footing is guaranteed 
thanks to a set of spikes that 
is supplied as an alternative to 
the fitted rubber feet. Bubble 
levels on the tripod collar and 
head enable quick and easy 
levelling. Our only complaint is 
that the plush padded bag that’s 
supplied isn’t quite long enough 
to accommodate the tripod with 
the BH2-M head fitted.

The head design is interesting and it’s 
quite lightweight for an aluminium tripod

The simple ball head lacks an adjustable 
friction damper or pan-only release



103April 2015www.digitalcameraworld.com

Sturdy tripods

We say… It’s sturdy, but heavy for 
its modest maximum load rating.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL
We say… It’s impressively rigid but 
the maximum height is limited.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL

Slik pro 700DX kit  
(with three-way pan head) £170, $170

Sirui ET-2004 kit  
(with E-20 ball head) £190, $200

The heaviest tripod in the group – by quite a 
margin – complete with a three-way head

This nifty kit combines the compactness of a  
travel tripod with strong load-bearing potential

Bucking the current trend, 
this kit includes a three-

way pan head rather than a ball 
head. It tips the scales at 3.6kg, 
making it the heaviest tripod 
and head combination in the 
group, but it’s more of a 
lightweight when it comes to 
maximum load, its 6.8kg rating 
being one of the lowest. This is 
quite surprising, given that Slik 
claims its AMT (Aluminium 
Magnesium Titanium) material 
gives a 40 per cent increase in 
strength-to-weight ratio 
compared with aluminium.

The three-section legs are 
chunky, with greater diameters 
than most competing tripods, 
measuring 30mm, 27mm and 
24mm from top to bottom. Clip 

locks enable secure fixing, along 
with smooth travel. At the top 
of each leg, a sliding pull-out 
mechanism gives three locking 
leg angles. The three-way head 
features two spirit levels.

performance
The Slik is one of the more 
rigid tripods in the group. 
This is maintained even at its 
impressive maximum operating 
height of 191cm, which is only 
beaten by the 212cm of the 
giant Gitzo. Low-level shooting 
is catered for with a two-section 
centre column, the lower part 
of which can be unscrewed. 
It’s a good performer, and the 
supplied three-way head can be 
easily swapped for a ball head.

A current trend in travel 
tripods is to have the legs 

swing upwards for stowage, so 
the head ends up between the 
feet and the carrying height is 
reduced. It’s seldom used in the 
design of ‘sturdy’ tripods but is 
nevertheless featured in both  
of the Sirui tripods in this test 
group. Indeed, the ‘ET’ in the 
name stands for ‘Easy Traveller’. 
However, with a maximum load 
rating of 12kg for legs and ball 
head, this kit is sturdy enough 
for big cameras and lenses.

Despite being made from 
aluminium, this kit is the joint 
lightest in the group, with the 
Benro carbon fibre outfit. Even 
so, its four leg sections range in 
diameter from 28mm to 19mm, 

so the bottom ones aren’t too 
spindly. The catch is that the 
maximum operating height is 
just 154cm. A centre column 
extender is supplied but that 
only brings the height up to 
162cm, which is still the lowest 
in the group. More usefully, 
replacing the column with the 
extender reduces the minimum 
operating height to just 21cm.

performance
For what is essentially quite a 
small and lightweight tripod 
kit, rigidity is impressive, and 
an improvement over the 
Manfrotto 190-series kit. The 
tripod is very well engineered, 
as is the E-20 ball head, which 
features a pan-only release.

The three-way head that’s supplied in  
this Slik kit will suit traditionalists

The legs swing up and encompass the head, 
making it compact when folded down
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We say… Adjustments are quick 
and easy and the head works well.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL
We say… It’s great value for a 
sturdy, carbon fibre tripod.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL

Manfrotto MK190XpRo3-BH kit 
(with 496RC2 ball head) £245, $300

Benro C2970F versatile Transformer 
+ BH2-M ball head £245, $420

A recent revamp of an old favourite, this complete 
kit features aluminium legs and a decent head

The carbon fibre version of this Benro tripod is 
lighter and stronger than its aluminium sibling

Manfrotto’s ‘190’ series of 
tripods has enjoyed much 

popularity over the years. The 
latest editions have been made 
more compact and portable; this 
aluminium 190XPRO3, with its 
three-section legs and pivoting 
centre column, has a collapsed 
height that’s 7cm shorter than 
its predecessor, although its 
maximum operating height is 
also a little reduced. The main 
reason for this is that the new 
pivot mechanism retracts fully 
into the tripod collar, rather 
than sitting proud. 

New ‘Quick Power Lock’ clip 
fasteners are more comfortable 
in operation. Neat extras include 
a bubble level on the tripod 
collar, which can be rotated so 

it’s not obscured, and a threaded 
socket for attaching accessories.

performance
Extension of leg sections is 
almost too free, with the legs 
crashing to their longest length 
under gravity, while rigidity at 
full extension isn’t quite as good 
as with some competing tripods. 

The legs feature four locking 
angles instead of the usual 
three, and the 496RC2 ball head 
works beautifully. It features an 
adjustable friction damper and 
has a 6kg load rating, although 
there’s no pan-only release. 
The pivot mechanism for the 
centre column is easy to use 
but is limited to two positions – 
upright or horizontal.

More expensive than the 
aluminium edition, this 

version of Benro’s 2970F 
Versatile Transformer tripod is 
made from eight-layer carbon 
fibre. The diameter of each leg 
section, the clip locks and all the 
magnesium alloy castings are 
identical in both cases. With the 
head fitted – it has the same 
BH2-M ball head – there’s a 
reduction in carrying weight 
from 2.5kg to 2kg, while the 
maximum load rating of the legs 
goes up from 10kg to 12kg.

The excellent pivoting centre 
column mechanism is also the 
same in both tripods. One thing 
that is slightly different is that 
the aluminium tripod (with 
head fitted) has a maximum 

operating height of 190cm 
and collapsed height of 77cm, 
but the carbon fibre edition is 
slightly shorter, at 184cm and 
75cm respectively. An upside  
of this is that the tripod fits into 
the padded bag that’s supplied 
with the head fitted. 

performance
There’s really no difference  
in the performance of the two 
Benro tripods. Both feel equally 
rigid and sturdy and, as we’ve 
mentioned, the fasteners and 
head are identical. The carbon 
fibre edition is noticeably lighter 
to carry, but is typically rather 
more expensive to buy. Even so, 
it’s competitively priced for a 
carbon fibre tripod.

The ball head features an adjustable 
friction damper, but no pan-only release

With a maximum height of 184cm, it 
doesn’t quite match the aluminium Benro
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We say… Compact for carrying, but 
the bottom leg sections are spindly.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL
We say… Extremely rigid, with an 
easy pivot facility and a great head.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL

induro AT214 Alloy 8M  
+ BHD1 ball head £250, $310

Manfrotto MT055CXpRo3  
+ 498RC2 ball head £415, $620

The Induro BHD1 ball head is really impressive,  
but the legs can feel a bit wobbly at full extension

With upgraded load ratings and superior rigidity, 
this is a highly desirable Manfrotto pairing

Like the Gitzo and Sirui 
tripods on test, this Induro 

aluminium model has four-
section legs. It collapses down to 
64cm (with head attached) and 
extends to an impressive 180cm 
maximum operating height. 
Another similarity with the 
Gitzo and the carbon fibre Sirui 
tripod is that the leg section 
locks have a twist, rather than 
clip, action. Some say that clips 
are faster to use than twist locks 
but that’s not our experience. It’s 
certainly easy to lock or unlock 
all sections simultaneously with 
one hand when the legs are at 
their minimum height.

The standard of engineering 
feels close to that of the Benro 
tripods on test, and similarities 

include three locking angles for 
each leg, plus a bubble level on 
the tripod collar. The maximum 
load rating also matches that of 
the Benro aluminium tripod, at 
10kg. However, the ball head 
has a higher rating of 12kg and 
boasts a more elaborate design.

performance
Despite there being a fairly 
typical 4mm difference in the 
diameter of each leg section, 
extension is a little lacking 
in smoothness. The bottom 
sections measure just 16mm in 
diameter, which has an adverse 
affect on rigidity. By contrast, 
the ball head is super-steady 
and has an adjustable friction 
damper and pan-only release.

Unlike the aluminium 
Manfrotto 190-series 

model on test, which comes as a 
kit, the MT055CXPRO3 carbon 
fibre legs and 498RC2 ball head 
are sold separately. The 
maximum load ratings of 9kg 
and 8kg respectively are a little 
down on some competing outfits 
in the group, but both parts feel 
particularly sturdy. 

Like the 190-series model, 
this new-generation 055-series 
tripod has been revamped, with 
the same updated clip locks, 
four-way multi-angle leg locks, 
90-degree pivot mechanism and 
an adaptor socket for attaching 
accessories. There’s also the 
same rotating bubble lock on 
the tripod collar. However, 

the carbon 055’s leg sections 
have a wider diameter, and the 
maximum operating height 
is loftier, at 183cm instead 
of 171cm (head attached). A 
contributing factor is that the 
498RC2 head itself is also taller.

performance
Compared with the Manfrotto 
190-series model, the carbon 
fibre 055 feels much more rigid, 
even at its higher maximum 
extension. The leg sections also 
extend more smoothly. The ball 
head is particularly solid and 
has a pan-only release. The only 
sticking point is that the price of 
the legs and head is nearly twice 
that of the 190-series kit (more 
than double, in the US).

The Induro BHD1 ball head is very sturdy, 
and has a maximum load rating of 12kg

The solid 498RC2 ball head features both  
a friction damper and a pan-only release
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We say… Excellent quality, and the 
detachable leg/monopod is a bonus.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL
We say… Superbly engineered. The 
modular approach adds versatility.

FEATURES 
BUilD qUAliTY 
RigiDiTY 
vAlUE FoR MonEY 

OveRaLL

Sirui n-3204X + K-30X ball head 
£475, $605

gitzo gT3542XlS Series 3 6X 
Systematic + gH3780qD head £1115, $1530

Works really well as a carbon fibre tripod, and 
converts into a monopod for one-legged use

The ‘systematic’ approach enables you to configure 
this modular tripod to suit your exact requirements

Sold as separate legs and 
head, the Sirui ‘NX’, or 

Universal X, series shares much 
of the design philosophy of the 
Easy Traveller kit also on test. 
It’s compact, thanks to legs that 
swing upwards and encompass 
the head when folded. The 
folded height is greater, at 51cm 
compared with 43cm, but the 
maximum operating height is 
more impressive, at 187cm. The 
maximum load rating is beefed 
up, at 18kg and 30kg for the 
carbon fibre legs and ball head 
respectively, while the carrying 
weight only rises from 2kg to 
2.4kg. Leg section locks are 
changed from clip to twist.

One of the legs can be 
unscrewed to form the basis 

of a separate monopod. The 
centre column comprises two 
pieces and, when split, the 
longer section can be used with 
the head to form the monopod, 
while the shorter one can be 
used for ultra-low-level shooting 
(at just 13cm high) without the 
need to invert the camera.

performance
Rigidity is slightly better than 
with the smaller Sirui tripod on 
test, and nearly as impressive 
as in the Manfrotto 055 carbon 
fibre model. The K-30X ball 
head is beautifully engineered. 
The head’s main locking screw 
doubles as an adjustable friction 
damper and the pan-only 
release is a useful addition.

Gitzo is a favourite with 
many pro photographers, 

and the ‘Systematic’ range is its 
most exotic product line. The 
idea is that the large aperture  
at the centre of the tripod collar 
can be configured with a geared 
or sliding centre column, a 
levelling base, a video half-ball 
adaptor or, as supplied here, a 
flat disk. You fit the components 
that best suit your requirements.

The GT3542XLS (extra long) 
tripod has four-section carbon 
fibre legs. When folded with the 
GH3780QD ball head attached, 
the 80cm carrying height is the 
joint-longest in the group, along 
with the Slik 700DX. However, 
with all leg sections extended, 
the Gitzo reaches 212cm, 

dwarfing everything else in the 
group. That’s quite something, 
considering it doesn’t have a 
centre column. The lack of a 
centre column enables ultra-low 
shooting down to 20cm.

performance
As you’d expect from a tripod 
of this price, the build quality 
is fabulous. The load rating of 
the legs and head are 25kg and 
21kg respectively, and the Gitzo 
feels solid even when supporting 
the heaviest D-SLRs and lenses. 
All adjustments are quick, easy 
and effective, and the ball head 
locking mechanism works well. 
Even so, performance of some 
competitors comes close, at a 
fraction of the price.

The ball head’s main locking screw 
doubles as an adjustable friction damper

The locking mechanism on the very solid 
GH3780QD ball head works really well
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nAME velbon Sherpa 
5370D kit

Benro A2970F  
+ BH2-M

Slik pro 700DX kit Sirui ET-2004  
+ E-20

Manfrotto 
MK190XpRo3-BH 
kit

Benro C2970F  
+ BH-2M

induro AT214  
+ BHD1

Manfrotto 
MT055CXpRo3  
+ 498RC2

Sirui n-3204X  
+ K-30X

gitzo gT3542XlS 
+ gH3780qD

ConTACT velbon.co.uk kenro.co.uk sliktripod.co.uk sirui.co.uk manfrotto.co.uk kenro.co.uk indurogear.com manfrotto.co.uk sirui.co.uk gitzo.co.uk

STREET pRiCE £120/$180 £145/$225 £170/$170 £190/$200 £245/$300 £245/$420 £250/$310 £415/$620 £475/$605 £1115/$1530

MAin TRipoD MATERiAl Aluminium Aluminium Aluminium Aluminium Aluminium Carbon fibre Aluminium Carbon fibre Carbon fibre Carbon fibre

MAXiMUM opERATing 
HEigHT

170cm 190cm 191cm 154cm (162cm 
with extender)

171cm 184cm 180cm 183cm 187cm 212cm

MiniMUM HEigHT  
(noT invERTED)

52cm (27cm  
split column)

49cm (23cm  
with pivot)

60cm (38cm 
split column)

43cm (21cm  
with extender)

43cm (15cm  
with pivot)

49cm (23cm  
with pivot)

44cm 51cm (15cm  
with pivot)

39cm (13cm  
split column)

20cm

FolDED HEigHT (+ HEAD) 63cm 77cm 80cm 43cm 66cm 75cm 64cm 73cm 51cm 80cm

WEigHT (WiTH HEAD) 2.1kg 2.5kg 3.6kg 2.0kg 2.4kg 2.0kg 2.4kg 2.6kg 2.4kg 3.0kg

MAX loAD (lEgS, HEAD) 4kg, 4kg 10kg, 8kg 6.8kg, 6.8kg 12kg, 12kg 7kg, 6kg 12kg, 8kg 10kg, 12kg 9kg, 8kg 18kg, 30kg 25kg, 21kg

lEg DiAMETERS 26, 23, 20mm 29, 25, 22mm 30, 27, 24mm 28, 25, 22, 19mm 26, 22, 19mm 29, 25, 22mm 28, 24, 20, 16mm 29, 25, 21mm 32, 28, 25, 22mm 32, 28, 24, 20mm

loCKing lEg AnglES 3 angles 3 angles 3 angles 3 angles 4 angles 3 angles 3 angles 4 angles 3 angles 3 angles

lEg EXTEnSion loCKS Clip Clip Clip Clip Clip Clip Twist Clip Twist Twist

CEnTRE ColUMn Split/invert invert only Split/invert invert only invert only invert only invert only invert only Split/invert no column

COmpaRIsON tabLe
HoW THE  
TRipoDS  
CoMpARE

Top tripod runners-uptHe wINNeR Is…

ovERAll

What’s good: Incredibly rigid and robust, modular 
design, monster maximum height and load ratings.
What’s bad: Massively expensive, it’s more than  
twice the price of anything else in the group.
Our verdict: Superbly well designed and engineered,  
it should last you a lifetime.

FEATURES
BUilD qUAliTY
RigiDiTY
vAlUE FoR MonEY
ovERAll

For the ultimate in high-grade build- 
quality and rock-solid sturdiness, the 

Gitzo is an outright winner. It’s a joy to  
}use and, despite lacking a centre column, 
achieves a spectacular maximum operating 
height. The only real problem is that its 
asking price of £1115/$1530 is far more 
than most of us would be prepared to pay 
for a tripod, no matter how sturdy it is. 

Taking purchase price into consideration, 
our recommendation for ‘best buy’ in the 
group is the Manfrotto MT055CXPRO3 
carbon fibre tripod and 498RC2 ball head. 
It’s nearly as rigid as the Gitzo, less than 
half the cost, and features a neat 90-degree 
pivoting centre column. The Sirui N-3204X 
carbon fibre tripod and K-30X ball head is 

If it’s sturdiness you want, this top-
quality Gitzo is by far the best option

gitzo gT3542XlS Series 3 6X 
Systematic + gH3780qD ball head

Manfrotto MT055CXpRo3  
+ 498RC2 ball head
What’s good: Quick adjustments extend 
to a 90-degree centre column pivot facility.
What’s bad: Rigidity isn’t quite as good as in 
the Gitzo tripod on test, but it’s not far behind.
Our verdict: Well thought out, it’s an excellent  
tripod and the ball head is similarly impressive.

another particularly enticing proposition, 
complete with a detachable leg for use as a 
monopod. If you’re on a tight budget, the 
Benro A2970F aluminium tripod and 
BH2-M ball head are unbeatable value, and 
the Benro C2970F is also great value for a 
carbon fibre tripod.  

Benro C2970F + BH2-M ball head
What’s good: Well engineered. The 
pivoting centre column is also very  
smartly implemented.
What’s bad: The ball head is basic, lacking  
a pan-only release or adjustable friction damper.
Our verdict: Fabulous value for a carbon fibre tripod 
of this quality with such an advanced set of features.

Sirui n-3204X + K-30X ball head
What’s good: Quality craftsmanship, 
detachable leg for monopod use.
What’s bad: Not quite as rigid as the  
055 and lacks a pivoting centre column.
Our verdict: With hefty maximum load ratings, it’s  
a solid competitor that’s well worth the asking price.

http://www.velbon.co.uk
http://www.kenro.co.uk
http://www.kenro.co.uk
http://www.sliktripod.co.uk
http://www.sirui.co.uk
http://www.sirui.co.uk
http://www.manfrotto.co.uk
http://www.manfrotto.co.uk
http://www.indurogear.com
http://www.gitzo.co.uk
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New gear
expert opinions on All the lAtest hot kit

rATED & prEvIEwED NIkoN D810A
Shoot for the stars with Nikon’s first SLR 
designed specifically for astrophotography 
D-sLr    £3000, $3797     www.nikon.com

■ With its excellent resolving power and noise control, the D810 is 
popular with astrophotographers. Its standard sensor isn’t the best 
for capturing nebulae, however, and in an interesting – if very niche 
– development Nikon has addressed this with the D810A, which has 
a modified infrared (IR) filter to make it four times more sensitive to 
the H-alpha (656nm) wavelength that these dust and gas clouds 
emit. The D810A has a native sensitivity range of ISO200-12800 
(expandable to ISO100-51200) and a Long Exposure Manual (M*) 
mode that enables timed exposures up to 900 seconds, as well  
as the usual Bulb and Time modes. To help with focusing and 
composition when shooting in Live View there’s also a new Virtual 
Live View Exposure Preview that brightens the on-screen image. 

fIrsT ImprEssIoNs: By its own 
admission, Nikon has released this 
highly specialised sLr in part because 
it can: it has the technology and has 
seen a gap in the market. It will be 
interesting to see if any of this 
technology will trickle down to  
its more mainstream ranges in  
due course. watch this space,  
if you’ll excuse the pun...

gloxy power Blade
LED constant light    £126, $194    www.digitaltoyshop.co.uk

■ The stick-like design of this constant light source makes it handy  
for a range of effects, from portrait fill lighting to light painting. There 
are 10 brightness levels and four modes, a filter for shooting under 
tungsten light and a 1/4-inch thread for tripod mounting. The unit is 
powered by a rechargeable 7.4v 2000mAh battery. The Power Blade is 
an interesting solution that kicks out plenty of light, and features just 
enough options to make it a worthy kitbag addition.  

Hahnel universal flash Accessory kit for speedlites
flash modifier    £50/$80    www.hahnel.ie

■ It’s amazing how a touch of flash can elevate your photography; add 
a light modifier and you’ll be light-shaping like a pro, and this set from 
Hahnel includes five modifiers and a bracket. There’s a simple softbox, 
a honeycomb diffuser, a mini snoot, a colour effect filter kit for mixed 
lighting conditions, and a bounce flash. While the Velcro straps for 
attaching the modifiers to your flashgun seem a cheap option they  
do the job, and keep the kit compact and lightweight.  
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NANEu 
mILITAry  
ops ALpHA 
A decent-sized daypack  
at a fantastic price 
Backpack    £39, $136    www.naneubags.com

■ Naneu’s Military Ops Alpha is a typical 
daypack, with an upper compartment for 
personal kit and a rear-access lower 
section that will snugly accommodate a 
Nikon D750 with 24-70mm lens, SB-910 
flash unit and a 50mm lens. The camera 
section contains padded dividers to keep 
your gear safe, and there’s an array of 
pockets on the front and sides, along 
with a selection of zipped pockets on  
the inside. The quality and weight of the 
fabrics is reassuringly sturdy and there’s 
a good amount of padding where it’s 
needed, making the bag comfortable  
to carry fully loaded. The straps offer 
plenty of scope for adjustment to enable 
a personalised fit, and the bag also 
features chest and waist straps for added 
comfort when trekking. At the price, this 
bag is outstanding value.  

Drobo mini
secure storage    £282, $389    www.drobo.com

■ The Mini is a RAID system, which enables data to be stored across 
several drives, so if a drive fails your data will remain safe. Setup is 
straightforward: add four 2.5-inch drives up to a total of 8TB and the 
Mini sorts out the configuration. Our tests showed read speeds of 400 
megabytes per second and write speeds of 300 megabytes per second 
using a Thunderbolt connection, which is exceptionally fast. There’s 
little to fault with the Mini other than the price.  

Lee filters field pouch
filter holder    £38, $56    www.leefilters.com

■ Available in black or sand colours, the field pouch is designed to hold 
up to ten 100x100mm or 150x100mm filters. Made from tough fabric, it 
can be carried by a shoulder strap or clipped to a belt. Under the top 
flap are ten filter sections, with two zips that once released enable the 
concertina design to expand for easy access to your filters. The pouch 
offers excellent protection, but it would be useful if there were extra 
sections to store adapter rings and the filter holder.  

New gear rated and previewed
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PRo PiCKs

5  NikoN SB-800 
SpeeDLight  
(SuperSeDeD By NikoN 
SB-910, £340, $547)
■ What’s it for? I use 
flashguns on location. I’ve 
also got two SB-80DXs and 
an SB-900, but the SB-800s 
get the most use as they’re 
so versatile. Both of mine 
are in a pretty bad state 
of repair, but they’re still 
ticking over.
■ Plus points Built-in 
optical slave and CLS 
modes, and a massive  
range of manual output.
■ Minus marks Nikon has 
stopped making them. 

3  NikoN aF-S 85mm 
f/1.4g FX  
(£949, $1497)
■ What’s it for? This lens 
is the perfect length for 
portrait work. I used to 
rent one so often that in 
the end it just made sense 
to buy one. When stopped 
down to about f/4 the image 
quality is superlative, and it 
captures a very satisfying 
shallow depth of field too.
■ Plus points It’s great in 
low light, which I need from 
time to time.
■ Minus marks It’s bit 
pricey, but in my opinion 
well worth the cash.

4  BoweNS gemiNi 
750pro moNoLight  
(£590, $1050)
■ What’s it for? I’ve been 
using Bowens lights since 
the 1990s. They’re superbly 
built and very robust – I had 
a pair of Esprit 500s that 
I was using continuously 
from 1998 until last year.
■ Plus points Each head 
can run off mains or battery 
without any mucking about, 
and I do so much work both 
on location and in the studio 
that having one system that 
can do both is essential.
■ Minus marks None that 
I’ve come across.

1  NikoN D800  
(SuperSeDeD By NikoN 
D810, £2350, $3000)
■ What’s it for? This is 
my main body for shooting 
feature images, covers and 
portraits, although I also 
use the D4 a lot. It delivers 
superb image quality in 
a small body, as well as 
fantastic video imagery.
■ Plus points When 
handled well, the D800 
easily rivals medium-format 
digital backs.
■ Minus marks It’s pretty 
unforgiving if you ‘spray and 
pray’, as 36 megapixels will 
show up a lot of mistakes.

2  NikoN aF-S 24-70mm 
f/2.8g eD FX  
(£1230, $1687)
■ What’s it for? I probably 
shoot 70 per cent of my 
work on it. It’s got fantastic 
optical quality, and is 
incredibly well built – I’ve 
had it repaired three times, 
but that’s due to my being 
an idiot rather than faults. 
It’s big and heavy, but it 
balances well on my bodies. 
If it felt lighter I doubt I’d 
trust the build quality!
■ Plus points It’s got a 
useful focal range and a 
fast constant aperture.
■ Minus marks Its price!

4

51
2

3

From Rory McIlroy to Mo 
Farah, Tom has shot some  
of the biggest names in sport

You can see Tom’s work at 
www.tmphoto.co.uk; he blogs 
at www.photosmudger.com

http://www.tmphoto.co.uk
http://www.photosmudger.com
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Dropbox

Flickr

   FREE (2GB)    www.dropbox.com

   FREE (1TB)    www.flickr.com

Pros Easy to use and stores 
virtually any file type.
Cons Not quite able to match 
the style and value of Flickr.
We say The best way to store 
multiple file formats.

Pros Ideal for displaying a 
huge image portfolio.
Cons Can’t store RAW files.
We say Offers tremendous 
bang for no bucks, providing 
you stick to uploading JPEGs.

Dropbox is great for storing  
pretty much any digital file type. 
Organising files is a cinch thanks 
to the intuitive folder system, plus 
you can access your files on the go 
with apps for iOS, Android and 
Blackberry mobile devices.

All this and 2GB of storage is 
free with a Dropbox Basic account. 
A Pro account offers 1TB for £7.99/ 
$9.99 a month or £79/$99.99 a 
year, or you can get an extra 500MB 
of space for referring a friend.

For its versatility and simplicity, 
Dropbox is superb, but ultimately 

Where most cloud storage 
providers make you cough up  
for more than a few gigabytes of 
storage, Flickr offers 1TB for free, 
with unobtrusive adverts covering 
the cost. If you’d rather go ad-free, 
you can for a $50 annual fee.

What makes Flickr stand out is 
its ability to display your photos in 
an attractive photostream. Other 
users can follow your activity and 
comment on your shots, or you can 
make images private.

Flickr is designed for presenting 
your shots rather than just storing 

acking up your shots is hardly a blast, and that was 
especially the case back when that meant spending 
time burning them to CDs. Fortunately, keeping your 

photos safe is now much easier thanks to the cloud. Put simply, 
‘the cloud’ is just techno-jargon for online storage. You can 
choose from numerous websites offering anywhere between 
1GB and 1TB of free remote hard drive space.

Backing up like this doesn’t just eliminate the hassle of 
dealing with discs or hard drives, it also enables you to access 
your photos from anywhere with an internet connection. The 
ability to share shots is another bonus, while websites like Flickr 
let you exhibit your images to the world, with scope for other 
users to leave feedback. Of course, if you’d rather keep your 
photos private, most cloud storage providers make it easy to set 
restrictions to make images accessible only to your password-
protected account, or to anyone with a private web link.

We’ve compared six of the best cloud storage websites; three 
aimed at photographers and three suited to general storage.  

Don’t risk your photos: whisk them  
up into the safety of the cloud

mini test  

Cloud 
storage

01 Freemium
Most storage providers give you some free space, with extra 
capacity available for a monthly or annual fee. Prices vary 
considerably, though, so make sure you get a good deal.

02 File formats
If you just want to back up or share JPEGs, then pretty much 
any provider will fit the bill. However, you’ll need to choose more 
carefully if you’ll be storing TIFFs or RAW files.

03 Net speed
Don’t fork out on a premium cloud storage subscription if your 
internet connection runs at a snail’s pace. Consider spending  
the same cash on a fast external hard drive instead. 

04 Show off
Not all online storage websites will display your photos in 
attractive galleries for the world to see them at their best.

05 Keep moving
Cloud storage is great for keeping your photos accessible on the 
go, so make sure your preferred provider has apps to help view 
and upload images from your mobile devices.

Head in tHe Cloud
With so many storage providers vying for your 
photographs, here’s how to find them the best home

B Flickr’s more attractive interface, 
social interaction and sheer value 
make it the better option.

them, so it’ll only display JPEG, GIF 
and PNG images. Dropbox is better 
if you need to upload RAW files.
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Google Drive

Adobe Revel

Microsoft OneDrive

Canon Irista

   FREE (15GB)    www.google.co.uk/drive

   FREE (2GB)    www.adoberevel.com 

   FREE (15GB)    www.onedrive.live.com 

   FREE (10GB)    www.irista.com

Pros Storage combined with 
cloud-based productivity apps.
Cons Can be daunting at first.
We say Cloud computing at its 
finest, but overkill for simply 
storing photos.

Pros Is great for storing both 
photos and video.
Cons Free account is limited. 
Uploading can be slow.
We say Photography-focused 
storage; decent value.

Pros Cheaper subscription 
plans than Drive.
Cons Won’t display photos as 
well as some rivals.
We say Offers a good balance 
of versatility and value.

Pros Attractive interface. 
Good social media integration.
Cons Extra storage is pricy and 
not available to US residents.
We say Performs well, but 
other providers are better value.

Drive isn’t just another cloud 
storage provider, it’s also home  
to several free office apps. Like 
Dropbox, Drive is geared towards 
file sharing, with multiple users 
able to modify shared files. You 
can store photos on Drive, but it 
doesn’t offer the same stylish 
setting as more photography-
focused online storage. To really 
show off your shots, you’ll need to 
sync them with a Google+ page.

15GB of free storage comes with 
Drive, although this is shared by 
other Google apps like Gmail.  

Revel provides photography-
orientated storage with attractive 
image galleries. Group Libraries 
enable friends to add photos to 
one shared folder, and you’re free 
to make any photo private. There’s 
integration with Lightroom and 
Elements, and you can make quick 
edits in Revel itself. Uploading is 
easy, with apps for Windows, Mac, 
iOS and Android. There’s also 
support for RAW file formats.

When you start off in Revel you 
can upload unlimited files for 30 
days, after which you’re limited to 

Microsoft’s cloud storage offers a 
very similar set-up to its arch-rival, 
Google Drive. Anyone familiar with 
the Microsoft Office suite will feel 
right at home with OneDrive’s 
integrated office apps.

OneDrive adopts the same look 
and feel as Windows 8, so it’s easy 
to navigate. However, it isn’t 
designed solely for photographers, 
so don’t expect the same viewing 
experience as you get from Flickr.

Pricing is close to Google’s, with 
15GB for free and an extra 100GB 
costing $1.99 per month. However, 

Irista is designed to rival the likes 
of Flickr and Revel, giving you a 
gallery-driven interface that’s for 
displaying your shots in style. It 
accepts JPEG and common RAW 
file formats and is easy to use, 
with options to filter images by 
camera or lens type and arrange 
shots by year, tags and EXIF data. 
Social media is heavily integrated, 
so you can upload images to Irista, 
share them to Facebook or Flickr 
and track any Likes or comments.

Two subscription plans allow 
you to increase Irista’s free 10GB of 

You can increase the space to 
100GB for $1.99 per month, while 
1TB costs $9.99 per month.

50 files per month. Subscribing to 
Revel Premium removes the cap 
for a monthly fee of $5.99.

Microsoft’s 1TB option is better 
value at $6.99 per month, and 
includes the Office 365 package.

storage to either 50GB or 100GB 
for a monthly fee of £4.49 or  
£9.99 respectively.

















April 2015 121

ISSUE 45 | ON SALE THURSDAY 9 ApRIL 2015

Learn all this in the next set of Nikon Skills…

Sneak peek at our MaY iSSue

TROUBLE  
SHOOT!

MASTER YOUR NIKON

From blurred shots to bad composition and poor  
exposure, discover 37 things that photographers  

do wrong – and how to stop doing them!

Free ViDeo DiSC!
 ■ Six fresh ideas for stunning macro shots this 

spring ■ How to get up close without a macro 
lens ■ HDR as it should be done! ■ Stunning 
day-to-night panoramas ■ And much more…

Plus all this…
■ Michael Freeman steers a course 
through the exposure triangle 
■ We take an in-depth look at the 
best super-telephoto zoom lenses 
■ Nature pro Paul Harcourt Davies 
shares the secrets of his success 
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BaTTlE cOMpanY
 “This is an image of four 
soldiers attached to the 

173rd Airborne, Battle 
Company, carrying the body 
of Sergeant Rougle through 

the Abas Ghar ridgeline,  
about an hour after we were 
ambushed by the Taliban,” 
explains Pulitzer Prize- 
winning photojournalist 
Lynsey Addario. “Three 
members of the Scout team 
were shot at almost point-blank 
range, and Rougle was killed. As 
a photographer who has covered 
war for 15 years, I still find it 
difficult to capture the drama  
of combat, and the toll of war.

“Along with a reporter, I had 
spent almost two months living 
with Battle Company. When 
we first arrived, it was pretty 
clear the soldiers were dubious 
about our presence there (we 
were two women), and doubted 
whether we’d be able to keep up 
with their rigorous patrols, but 
by the end of the embed, we  
had gained their trust.

“The embed culminated in 
a week-long Battalion-wide 
mission, called Operation 
Rock Avalanche, where we 
were airlifted into a den of 
the country’s insurgency, and 
went looking for Taliban and 
weapons. We walked for days 
through the mountains with 
our belongings on our back 
alongside the troops, slept in 
ditches, documenting first-hand 
what life was like for US troops 
along the frontline. But nothing 
symbolised the cost of war more 
than a life lost. 

“When Rougle was killed, I 
didn’t know whether I would 
have been permitted to 
photograph had I not spent so 
much time with the troops; the 
death of a soldier is arguably 
the most sensitive, emotional 
time for troops in battle. But 
as they approached, carrying 
Rougle’s body in a body bag, 
and I asked permission to 
photograph, they consented. We 
were all weeping. Being able to 
document that intimate moment 
was a privilege on many levels – 
most importantly, because I was 

23 October, 2007  Afghanistan  Nikon D2xs

Lynsey Addario
Photojournalist 
Lynsey Addario 
regularly shoots 

for a range of prestigious 
titles, including The New 
York Times, National 
Geographic and Time. She 
has covered many conflicts. 
Awards include the 
MacArthur Fellowship in 
2009 and the Pulitzer Prize 
in 2009 for International 
Reporting. Lynsey is 
speaking at the Photography 
Show on 23 March – see 
photographyshow.com
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geable to capture the brotherhood, 
and the tragic loss of life.”

The reaction
“I don’t know how the public 
responded to this image when it 
was first published. I think it has 
gained recognition over time. 
If I could take this shot again, 
I probably would have pushed 
more forward, directly to the 
location where the Scout team 
was ambushed. I was rattled, 
though, and when I came upon 
the first wounded soldier being 
tended to, I chose to stay with 
them, and accompany them to 
the medevac helicopter.

“In a delicate situation such as 
this, it is less about the camera 
than the approach. You need 
to ensure the settings are fixed 
for light/speed ahead of time so 
you can focus on the moment. 
Beyond this, it is important to 
be respectful, to understand 
that a camera is not always 
welcome, to ask permission, and 
to be cognisant of the fact that 
someone’s friend, brother, son, 
or husband has just lost his life.”  

Geoff Harris

http://www.photographyshow.com
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